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    If you're new to RailClone and not sure about where to begin, you've come to the right place! This introductory guide has been written to help you get started creating powerful parametric models in next to no time. Follow the chapters below to learn how to get the most out of RailClone.            
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    Congratulations on downloading RailClone, the artist-friendly procedural modelling and instancing plug-in for 3ds Max. RailClone has a unique approach to parametric modelling that is powerful, fast and easy-to-learn. To help you get started, we've written this Beginners Guide to introduce the core concepts and get you up and running with RailClone as quickly as possible. It is our intention that by the time you reach the end of this document, you will be ready to make RailClone an indispensable part of your your day-to-day workflow.            

        
        Using this guide

            
    We recommend working through this guide from start to finish. It has been structured to that each new section builds on the concepts learned in the last chapter. To help you get more from the guide, each new concept features the following sections.            

        
        Exercises

            
    The best way to learn RailClone is use it. we've included exercise throughout the guide to help you pick up the foundational skills required to use RailClone for many of the relevant day-to-day tasks you might encounter . We recommend making the effort to go through these exercises, but we're aware that time is precious, so the exercises have deliberately been kept short and simple.            

                
    You can download the source files for the exercise below. The .max files are in 2010 format with standard materials.            

                
    Getting Started Exercise Files            

        

    
        Relevant Tutorials

            
    At the end of each chapter you will find links to recommended tutorials. Follow these to learn more about each subject, see the principles put to use and learn more advanced skills            

        

    
        Links to documentation

            
    To find out more about a subject, each chapter provides links to the relevant areas of RailClone's online documentation. If you have a question, there's a good chance you'll find the answer there.            

        

    

    
        Requirements

            
    No special skills, renderer specific knowledge, programming experience, or additional software is required to use and learn RailClone. If you can find your way around 3DS Max then you're ready to go!            
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    In addition to this guide, we have many other channels available to help you learn our plugins, talk to other users, and get help when needed. Below are some of the resources you may find useful as you start working with RailClone. Click on the image to access the resource.            

        
        Documentation

            
                [image: images/download/attachments/16482333/1904266534.jpg]
                

                
    The RailClone User Guide provides comprehensive descriptions and commonly used procedures for every setting in RailClone. If you have a question, you'll often find the answer here.            

                
    To access the documentation from within the plugin:            

    	            
    Select the RailClone object.            

    
	            
    In the Modify panel, open the General rollout.            

    
	            
    Click on            

                [image: images/download/attachments/16482333/-1454927497.png]
                    
    to open the online help in your default web browser.            

    

            
    Alternatively if you need to read the documentation offline, we also have PDF and EPUB versions available.            

        
        Tooltips

            
    Many buttons in RailClone display additional information if you hover the mouse over them. In the style editor, watch out for this icon             [image: images/download/attachments/16482333/2134242956.png]
         which will reveal more information about the purpose of a node.            
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        Tutorials
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    We regularly release Tips and Tricks tutorials to help you learn new techniques for RailClone and stay up to date with recently introduced features. In particular we have 4 tutorials that may be helpful for new users. The Masonry Wall  tutorial introduces the basic concepts of RailClone and teaches you how to create a brick wall using a 1d array. Following that, the Curtain Wall tutorial (            [image: images/download/attachments/14778499/-1512376667.png]
        ) introduces 2d arrays using the example of a double curved faade. Having learned the basics, both 1D and 2D arrays are combined in the Seaside Promenade and Stadium tutorials that also introduce many of the most commonly used operators, and demonstrate RailClone's ability to handle huge amounts of geometry by automatically instancing objects.            

                
    You'll find these, plus more tips and and tricks videos in our tutorials section. Some are these are shown in the thumbnails below, but the section is often updated so check regularly!            
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Our forums are a great place to get you questions answered, share your experiences with other users, and learn new tips. I    
    
f you own the Pro version of RailClone, you'll get premium support on the restricted boards.     
Our technical support staff monitor the forums closely so you can be sure of a timely response.     
To access the Pro boards, use the username and password you received with your license. If you can't remember your login, just drop us a line requesting that we resend it.    
            

        

    
        Scenes
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    We periodically release complete scenes created using Forest Pack and RailClone. These can be useful learning aids, allowing you to reverse engineer many useful styles. Get them from our Downloads page along with the scene files for all the tutorials.            

        

    
        Helpdesk
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    If you have a question that is not answered in any of the channels above, you can contact our technical support staff directly. To do this please use this contact form.            

        
            Business Hours

        
            
    Our business hours are from 9 a.m. to 3 p.m. and 4 p.m. to 6 p.m. (GMT +1)            

        

    
    

    
        Newsletter and social media.
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    If you're a Pro user you'll be kept up to date with all iToo related news including product releases, updates, tutorials and more, via our regular newsletter. In addition all users are welcome to follow us on Facebook, Twitter, Vimeo, and YouTube.            
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    RailClone comes if two different flavours. The Lite version is completely free to download and use, even commercially, but includes some restrictions as outlined in the table below. The Pro version is completely unrestricted, including the full feature set, and also includes a much larger styles library and comes with RailClone Tools. This guide serves as a useful primer for RailClone, irrespective of whether you're a Lite or a Pro user.            

        
        Differences between Lite and Pro

    
        
                
            	
    Lite            
                	
    Pro            
        

    
            	
    Limited to a single generator            
                	
    Unlimited generators            
        

    
            	
    Limited to flat splines            
                	
    Includes 3 different adaptive height modes to deform geometry on the Z axis            
        

    
            	
    Limited to 3 segments            
                	
    Unlimited segments            
        

    
            	
    Cannot be converted to an editable mesh            
                	
    Can be converted to an editable mesh            
        

    
            	
    Reduced style library            
                	
    Full style library included            
        

    
            	
    Library cannot be customised            
                	
    Library is fully customisable            
        

    
            	
    RailClone Tools not included            
                	
    RailClone Tools included.            
        

        

            

            
                

                
    Aside from these restriction both versions are identical in appearance and behaviour. Throughout this guide, where an exercise, note or procedure is only relevant for Pro users you'll see             [image: images/download/attachments/16482347/-1512376667.png]
         displayed.            

        

        

    


    
        
            Key Concepts: Array Based Instancing

        


        

        
    
        

    

    
        What is RailClone?

            
    RailClone is designed to help artists create sophisticated reusable parametric models using an easy to understand node based editor. At the heart of RailClone are two array-based Generators. These use rules to combine, transform, deform, slice, bevel, UV map, and distribute meshes known as Segments. Once you understand how generators work, creating your own unique RailClone objects is simple and fun!            

                
    Compared to many other parametric modelling tools, RailClone works at a much higher level of abstraction. RailClone isn't a visual programming tool, it's a sophisticated array based modeller with tremendous Instancing power. There's no need to create complex algorithms or programmatically generate meshes from scratch, instead RailClone uses modular pieces of geometry created using standard modelling tools as its building blocks. These are assigned to different parts of an Array and manipulated based on the the instructions contained in rule-sets. We call the combination of rules, arrays and segments a Style.             

                
    For example, the image below illustrates a rope barrier style created with RailClone.            
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    This style is created using only two Segments:            
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    A post....            

                
                [image: images/download/attachments/16482350/-2015432390.png]
                    

                
    ...and a rope.            

                
    These two segments are organised into a one dimensional array by a Generator, which uses a simple rule-set. If we were to write out this rule-set in English it would read as follows:            

    	            
    Create a 1 dimensional array deformed along a Spline path.            

    
	            
    At the Start of the spline, add a post.            

    
	            
    At the End of the spline, add a post.            

    
	            
    If there is a Corner vertex, add a post.            

    
	            
    Along the length of the spline, add Evenly spaced posts every 1.2m.            

    
	            
    Between all these posts, add a rope and scale it so the it fits exactly between the posts.            

    

            
    In RailClone, using the node based Style Editor, the rule-set looks like this:            
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    As you can see this array has 5 parts: the start, end, corner, evenly and default. Each of these parts is represented by an Input on the generator's node. To add geometry to the array, it is only necessary to wire a Segment to an input.            

                
    This example contains the 3 essential ingredients to create a RailClone object, a Generator (rule-set), Base object (spline) and at least one Segment (geometry). In the node tree shown above, the Linear 1S node is a type of Generator which creates the array, the Spline node is a Base Object and determines the path, and the Rope and the Post nodes are Segments that add the geometry. Let's look at these 3 components in more detail.            

        

    
        Generators: RailClone's two array types

            
    To create parametric objects with RailClone you compile geometry using one and two dimensional arrays. Each of these two arrays is created using a different generator, and each has different inputs. The L1S generator is simplest of the two with 5 inputs. This generator is the foundation of RailClone's approach to modelling.            

                
    RailClone's second generator is designed to create 2d arrays and is more sophisticated with a total of 12 possible inputs. If you stack several L1S arrays on top of one another you get a 2d array and this, in essence, is how the A2S generator works. Because of this relationship between the two generators, understanding the L1S generator is the most important step in learning RailClone.            

        
        The one dimensional or L1S array

            
    As we've mentioned the L1S array has 5 inputs. Each of these relates to a position on the X Axis of the array and/or the position on the base spline. To create parametric objects with RailClone, it's essential to understand how these 5 elements interact. The following animated image and descriptions illustrate the inputs used by the L1S Generator and their position on a base spline.Though it looks simple, it's a deceptively powerful system that can generate a limitless number of different styles. 
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    Start: This input is used to position a segment at the start of the array.            

    
	            
    End: This input is used to position a segment at the end of the array.            

    
	            
    Corner: This input is used to add a segment at each of the intermediary vertices of the spline. You can set this so that it only creates a segment on certain types of vertex i.e. corner. bezier-corner, bezier, smooth, or if you prefer, all of these.            

    
	            
    X Evenly: This input is used to create evenly spaced segments along the spline. The distance between them is fully adjustable and there are several algorithms available to calculate the spacing.            

    
	            
    Default: This is used to fill in the remainder of the array and in the event that the other nodes have no inputs. If an input is left empty, the segment wired to default will be used in its place.            

    

            
    To see this in action, examine this image from our Masonry Wall tutorial. It illustrates the segments used by the style and the input slots to which they're attached.            
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        The two dimensional or A2S Array

            
    Using the A2S Generator, segments can be positioned and deformed in a two dimensional grid with separate target slots for top, bottom, sides, each corner and evenly spaced rows and columns. This powerful generator is great for walls, pavements, faades, roofs and many other advanced structures. The image and descriptions below illustrate the inputs used by the A2S Generator, and their position in the array.            
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    Left Bottom Corner: Use this input to position a segment in the bottom left hand corner the array.            

    
	            
    Right Bottom Corner.  Use this input to position a segment in the bottom right hand corner the array.            

    
	            
    Left Top Corner: Use this input to position a segment the the top left hand corner the array.            

    
	            
    Right Top Corner: Use this input to position a segment in the top right hand corner the array.            

    
	            
    Left Side: Use this input to add a column of segments on the left hand side of the array.            

    
	            
    Right Side: Use this input to add column of segments on the right hand side of the array.            

    
	            
    Inner Corner: Use this input to add a column of segments at each of the intermediary vertices of the construction spline.            

    
	            
    Bottom Side: Use this input to creates segments in the bottom row of the array            

    
	            
    Top Side: Use this input to creates segments in the top row of the array            

    
	            
    X Evenly: Use this input to creates evenly spaced columns of segment.            

    
	            
    Y Evenly: Use this input to create evenly spaced rows of segments.            

    
	            
    Default: Use this input to assign a segment that is used to fill in the remainder of the array and in the event that the other inputs are empty.            

    

            
    The following image is from our Curtain Wall tutorial and illustrates how the relationship between the segment's geometry and the input slots described above creates a working style. Note that although this generator has 12 input slots, it isn't necessary to use them all. In this example only the corners, sides, top, bottom, Y Evenly and default have been used. Inner Corner and X Evenly were not required to create this style. When an input is not used the generator is able to intelligently reconfigure itself to use only the inputs that are active.            
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        The inputs used for a curtain wall style            
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    Render of the curtain wall style             

        

    

    
        Segments

            
    Creating new styles with RailClone necessitates thinking about your models as repeatable parts of a jigsaw, that slot together into a 1D or 2D array. We call these jigsaw pieces Segments, they are the individual building-blocks, duplicated and combined by the generators, to create a final model. A segment could for example be a single complete object distributed along a path (for example, a lamp-post), or a modular set of parts that snap together to create a precise unified mesh (for example, a space frame).  The geometry used for Segments is typically very specific to each style, but the image below show 3 different RailClone objects from the Seaside Promenade tutorial with their respective segments.            
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        Base Objects

            
    To set the size of an array you have two options, either use scene units to specify the length and height, or use splines as paths for geometry to follow. These paths are referred to as Base Objects.  Depending on the type of generator used you can employ up to 3 splines. For example this Railway preset from the included library uses the spline marked in red to deform the track.            
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    When using A2S generators  (two dimensional arrays), two splines can be used, one for the X Axis and another for the Y.  In the curtain wall example below, the red spline governs the path while the yellow determines the height. Both splines can be curved to generate geometry that would be time consuming to create using other tools or techniques.            
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    In addition to defining the axes of a generator, the third type of spline base objects functions as a clipping area. These splines must be closed and RailClone uses Max's boolean functions to include or exclude geometry by slicing segments. This will be discussed in more detail in the Intermediate guide.            

        

    
        Operators

            
    Operators allow you to perform all kinds of modifications to segments. These nodes allow you to transform, mirror, combine, and sequence segments; randomise geometry, material IDs or UVW coordinates; combine segments to form a new composite object; create conditional rules and much more.            

        

    
        Parameters

            
    Finally, Parameters allow you to link the properties of generators, segments and operators to one-another or to numerical nodes. Use parameters to link different parts of a RailClone style together and make adjusting multiple objects from a single input a cinch. Mathematical relationships can be added between properties by using Arithmetic operators and for the more adventurous you can even write custom expressions.            

        

    
        Instancing

            
    RailClone shares the instancing power of Forest Pack Pro. It has been designed from the outset to create huge amounts of geometry using popular rendering engines. Any segment that is not deformed or sliced is instanced automatically, saving memory and improving render-times.This happens automatically behind the scenes, though as a general rule the more you minimise deformation and slicing, the more optimised your model will become.            

                
    For an example of instancing, take a look at the stadium scene (show below) from our 5 part tutorial series. This scene uses RailClone to create all the seating (and almost everything else). Each seat model has 14,018 polygons and the stands contain approximately 50,000 chairs. This gives us a total of 700,900,000 polygons, and that's before adding the crowds, flags, roof, and grass!            
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            The anatomy of a style - RailClone's approach to modelling
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    Before you start using the included library or modifying and creating your own styles, it's useful to take a few moments to get acquainted with the user interface. To explore the UI, first create a new RailClone object by following these steps:            

    	            
    Go to 3ds Max's Command > Create > Geometry  panel and change the category to iToo Software.            

                [image: images/download/attachments/16482364/923135189.png]
        
	            
    Click            

                [image: images/download/attachments/16482364/1415251877.png]
                    
    .            

    
	            
    Click and drag in the Top or Perspective viewport to create a new RailClone object.            

    
	            
    Switch to the Modify Panel to access the tools required to load a library preset or create new style.            

    

    
        RailClone's 3 UI Components

            
    The starting point when using RailClone is always the Modify panel. From here you can adjust many of the object's global settings, open the Library Browser to load and organise presets, and launch the Style Editor to modify existing styles and create new ones. Let's start by taking a look at the layout of the modify panel.            

        
        1 - Modify Panel

            
    In addition to the About rollout, RailClone's Modify panel UI consists of 5 rollouts, shown below.            
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        The General rollout

            
    The General rollout is used to adjust global plug-in settings and provides access to statistics, help files, and updates.            

    	            
    Random Seed Sets the seed value used when generating random properties in a style.            

    
	            
    Icon Size Adjusts the size of the icon used when no geometry is displayed. This is purely cosmetic and has no influence on rendered geometry.            

    
	            
    Check for updates. Checks your plug-in is up-to-date.            

    
	            
    Help Open the online documentation in your default browser.            

    
	            
    Stats Shows useful information about the current style, including build time, number of segments and error messages.            

    

            
                [image: images/download/attachments/16482364/-1780978274.png]
                    

        

    
        The Style rollout

            
    The Style rollout is used to load, design and control rule-sets used by the RailClone object to build a parametric model. As well as being able to edit many attributes common to all styles, in this rollout you can load presets using the built in Library Browser, or create and edit Styles using the Style Editor.            

    	            
    Preview Image Displays a preview image when a style is loaded from the Library.            

    
	            
    Style Name Click to open the Style Library. The button's text displays the name of the current style.            

    
	            
    Style Description Click to read a description of the currently style, including a list of the parameters and base objects used.            

    
	            
    Style Editor Click this button to open the Style Editor, used to create or modify styles.            

    
	            
    Copy Styles These 3 buttons are used to copy the current style to other RailClone objects or copy a style from another RailClone object            

    
	            
    Geometry This group contains editable parameters that are common for all styles.            
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        The Parameters rollout

            
    The Parameters rollout lists editable values used by the current style. Unlike the parameters found in the Style rollout, these settings are added by the creator of the rule-set and vary from style to style.  In order for a parameter to appear here, there must be an equivalent Numeric node present in the style editor.            

                
                [image: images/download/attachments/16482364/583921622.png]
                    

    	            
    Parameters List Contains the editable parameters used by the current style. To select a parameter, click its name.            

    
	            
    Parameter Value Used to edit the value of the selected parameter.            

    
	            
    Parameter Help Click to display a user created description of the selected parameter.            

    

            
                [image: images/download/attachments/16482364/624308018.png]
                    

        

    
        The Base Objects rollout

            
    The Base Objects rollout lists inputs that can be selected from the scene used to generate the current style. For example, a single L1S generator may require a single spline to define the path, a single A2S generator takes two splines, one to define each axis; and both optionally can use a clipping spline and a surface. As with the parameters rollout, in order for a base object to be listed,  there will be a corresponding node in the style editor.            
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    Base Objects List Contains all of the base objects used by the current style. Select a base object from this list to change its properties.             

    
	            
    Properties Used to select splines and surfaces from the scene to be used as base objects. Includes parameters to limit the RailClone object within a set distance along a spline.            
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        The Display rollout

            
    The Display rollout contains options to control the way geometry is previewed in the viewports and generated at render-time.            

    	            
    Viewport Controls the way in which the RailClone object displays in the viewports. For dense meshes, either box proxies or a points-cloud should be used.            

    
	            
    Build Click to rebuild the RailClone object. Only required if Auto is off.            

    
	            
    Render Used to control the instancing engine.            

    
	            
    Limits Used to set segment and face count thresholds to prevent crashes. If RailClone exceeds these values a warning is displayed and no geometry will be rendered.            

    
	            
    Debug Mode (V-Ray Only) Used to help identify instanced segments. Useful for debugging complex styles.            

    

    

    
        2 - Library Browser

            
        
The Library Browser allows you to load presets that ship with RailClone and easily organise and load your own styles.    
 To open the Library browser, click             [image: images/download/attachments/16482364/-1007284236.png]
         in the Style rollout (see above). The library Browser's UI is divided into 5 parts:            
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    Tree Navigator Used to locate, edit and select libraries. To navigate, simply use the mouse or keyboard to expand folders and select libraries as you would in Windows Explorer.            

    
	            
    Items Grid Shows the contents of the styles library selected from the Tree Navigator. To select a style, click on a thumbnail image.            

    
	            
    Options Bar Used to select a material library. Can be left on Automatic to detect the current renderer, or you can manually select a material library.            

    
	            
    Import Selected Click this button to load the selected preset.            

    
	            
    Toolbar Provides access to a number of tools to help quickly navigate and modify the library.            

    

    

    
        3 - Style Editor

            
    The style editor is at the heart of RailClone's workflow. This is the interface used to create the rulesets used to generate procedural geometry. To open the style editor, click on             [image: images/download/attachments/16482364/-121657476.png]
        from the Style rollout (see above).            

                
                [image: images/download/attachments/16482364/584994126.png]
                    

    	            
    Items List Contains node types available for use when designing a new style. To add a new item, simply drag it from the Item List to the Construction View.            

    
	            
    Construction View Used to create Style rule-sets by wiring together Generators, Segments, Operators, and Parameters. Once a node is created in the Construction View, its controls are accessible in the Properties Editor            

    
	            
    Properties Editor Allows you to view and edit the parameters of the selected node. The effects will be updated in real-time in the 3ds Max Viewport.            

    
	            
    Tool Bar Provides buttons for regularly used functions.            

    

    
        Nodes

            
    As you can see from the screenshot above, rule-sets are created by wiring together nodes, and though there are many different types, the interface for all of them is simple and consistent. The parts of a node are as follows:            

        

    

    

    
        

            
    1. Icon Indicates the type of node.
2. Input Sockets Used for attaching another node as an input.
3. Name. By default this will be the labelled as the type of node, but it can be changed in the properties editor.
4. Collapse/Expand sockets. Used to hide or unhide the inputs and outputs. Useful to tidy up complex styles.
5. Output Sockets. Used to Wire a node to other operators or a generator
6. Exported Parameter Exporting parameters allows you to control multiple nodes with a single input, and/or add a Numeric node to enable values to be edited from the modify panel.
7. Exported Attribute Exporting attributes allows you to export the size of a segment's geometry.
8. Change Order Up/Down Some nodes allow multiple inputs, when that's the case these arrows change the order in which the inputs are processed.            

                
                

        
            Documentation

        
            
    For more information please see the Style Editor, General, and Library Browser sections of the online documentation.            

        

    
            
                

                
                

        

        

    


    
        
            How to use the library

        


        

        
            
                [image: images/download/attachments/16482396/-604153027.png]
                    

                
    RailClone includes in excess of 350 predefined styles, allowing you to easily add many common objects to your scenes. The built in presets include roads, curbs, sidewalks, railway lines, bridges, street lights, ducting, trusses, curtain wall systems, theatre seating, railings, scaffold, walls and much much more. Using these styles is simple, often only needing you to create a new RailClone object and a single spline. To explain the process of using a preset, we can break it down into 5 short steps.            

                
                [image: images/download/attachments/16482396/1470769869.png]
                    

        
        Exercise: Loading a preset

    
        Step 1 - Create a spline Path

            
    As we saw in Chapter 3, RailClone uses splines to determine not only the size, but the paths for the two array based Generators. Geometry is automatically deformed to follow the path and, In most of the library presets that use them, vertices of the Corner or Bezier-Corner type will generate a corner segment.To illustrate this we'll create a spline:            

    	            
    Create a new spline as illustrated in the image below or download and open using_the_library_start.max.            

                [image: images/download/attachments/16482396/-449400351.png]
        
	            
    Note that the majority of vertex types are set to Corner with the exception of the one in the centre of the curved section, This vertex's type is set to Smooth.            

    

    

    
        Step 2 - Create A RailClone object

            
    Next, create a RailClone object just as you would any 3ds Max geometry:            

    	            
    Go to 3ds Max's Command > Create > Geometry panel and change the category to iToo Software.            

                [image: images/download/attachments/16482364/923135189.png]
        
	            
    Click            

                [image: images/download/attachments/16482364/1415251877.png]
                    
    .            

    
	            
    Click and drag in the Top or Perspective viewport to create a RailClone icon.            

    

    
            Why the Top or Perspective Viewport?

        
            
    RailClone uses its local coordinate system to determine the array's axes, so the orientation of the RC object is important. Here is how the local axes of the RC object looks:            

                
                [image: images/download/attachments/16482396/-1049368815.png]
                    

                
    1D Arrays are constructed along the X axis while 2D arrays use the X and Y axes. The axes of the source geometry will always be aligned with the RC objects local axes (we discuss this in more detail in the Intermediate Guide). For example, in most cases you would want a fence's verticals to align with the Z axis, so you should create the RailClone icon in the top or perspective viewport :            

                
                [image: images/download/attachments/16482396/-1048445320.png]
                    

                
    1 - In this example the RC object was created in the left viewport. This is incorrectly oriented for a fence style, though may be correct for other styles such as wall claddings that use a vertical alignment. 2  - In this example the RC object was created in the top viewport, the RC object is oriented correctly for this style.            

                
    If you find the alignment is incorrect you can simply rotate the RailClone object to the orientation you require and then reselect the base object(s).            

        

    
    

    
        Step 3 - Load a preset from the library

            
    You now have a Base Object and an empty RailClone object. The next step is to load a style. To open the Library Browser and load a preset follow these steps:            

    	            
    Make sure the RailClone object is still selected and open the Modify panel.            

    
	            
    Open the Style rollout. Click on the Open RailClone Library Browser button, this will currently say "none", but will display the name of the style once it has loaded.            

                [image: images/download/attachments/16482396/-392044365.png]
        
	            
    The library browser will open. Use the Tree Navigator on the left of the window to locate a library. In this example we'll use a Railings library which can be found by going to RailClone Library > Architecture> Interior.             

                [image: images/download/attachments/16482396/724715028.png]
        
	            
    When you click the library's name, the items grid will update to display thumbnail previews of the contents. To change the size of the previews you can use the            

                [image: images/download/attachments/16482396/-392259292.png]
                    
    zoom slider found in the Toolbar. Select Metal Handrail 2.            

                [image: images/download/attachments/16482396/724834194.png]
        
	            
    Ensure the the Materials > Using option is set to Automatic Selector. When this is active, RailClone auto-detects the active renderer and merges the most appropriate materials. If you'd prefer to manually specify which materials to merge, use the drop-down menu to select the correct renderer. The built in libraries include materials for Standard, Mental Ray, and V-Ray renderers.            

                [image: images/download/attachments/16482396/725638583.png]
        
	            
    Next click Import Selected, or double click on the thumbnail. The Library Browser will close and the Style roll-out is updated with the name and preview image of the preset.            

                [image: images/download/attachments/16482396/725817234.png]
        

    

    
        Step 4 - Add the spline as a Base Object

            
    You'll notice there is a red error message displayed in the style rollout. This is because we have loaded the rule-set for this style, but we haven't yet specified the path for it to follow. To do this:            

    	            
    Open the Base Objects rollout. Here you'll find an option to pick a spline from the scene. (This style only uses 1 spline but others may use more.)            

                [image: images/download/attachments/16482396/728409053.png]
        
	            
    Select the Spline Base Object and click on            

                [image: images/download/attachments/16482396/-1246775988.png]
                    
    , then select the spline in the scene created in step 1, above.            

    
	            
    The railing style now generates geometry along the spline. Note that a post is added at each vertex except the one in the middle of the curve.            

                [image: images/download/attachments/16482396/-356412366.png]
        

    

    
        Step 5 - Edit Parameters

            
    Many presets have additional editable parameters that are unique to the style. In this example the height of the railing and the number of wires are adjustable. Follow these steps for an example of how to edit these values:            

    	            
    With the RailClone object selected, open the Parameters rollout in the Modify panel.            

    
	            
    Select the parameter called Number of Wires.            

                [image: images/download/attachments/16482396/760326652.png]
        
	            
    Change the value from 4 to 6.            

    
	            
    Select the Railing Height parameter.            

                [image: images/download/attachments/16482396/2095408860.png]
        
	            
    Change the value to 1.5m.            

    

            
                

        
            Editing is non-linear

        
            
    Though we have presented this process as a sequence consisting of 5 steps, one of the great advantages of RailClone is that a style, its parameters, segments, and base objects can be edited at any time and in any order, and the object will update automatically. For example, you can easily edit the spline path, perhaps lengthening a section and adding a new corner, and the geometry is recalculated and updated in real-time. Also, for styles that share the same number of Base Objects, it's possible to replace the existing style with a new preset from the library, and it will be automatically be applied to the currently assigned spine, without needing to reselect it from the scene.            

        

    
    

    

    
        Exercise: Display Settings

            
    If you look closely at this style in the viewports you'll notice that the geometry does not match the thumbnail preview, in fact It appears to be created using much more primitive geometry. Don't fear! This not an error, but is because the original geometry has been replaced with simplified boxes using one of RailClone's two adaptive display modes. These are designed to keep viewport navigation as fast and interactive as possible, while allowing you to render scenes with huge polygon counts. RailClone automatically switches to this display mode when the face count of the object exceeds a set value, by default 100,000 faces.            

                
    If you render the view you'll see that despite the the representation in the viewports, the full geometry is always used at render-time, without any need for user-intervention.            

                
                [image: images/download/attachments/16482396/528290895.png]
                    

                
    The second adaptive display mode allows you to display the geometry as a point-cloud. This mode is useful if you need a more accurate representation of the geometry in the viewports, and especially useful while you're designing complex high-poly styles. To switch on Points-Cloud display mode, follow these steps:            

    	            
    With the RailClone object still selected, open the Display rollout.            

                [image: images/download/attachments/16482396/530078350.png]
        
	            
    Click on the Degrade to drop-down list, and select Points-Cloud.            

    
	            
    From this menu you can also change the face threshold value that the object must exceed in order to trigger a simplified display mode. To do this enter a new value on the Adaptive value box.            

    

            
    The railing will now be displayed in the viewport as a points-cloud, but if you render you will see that the full geometry is used at render-time, again without any need for user-intervention.            

                
                [image: images/download/attachments/16482396/2095305444.png]
                    

                
    It is also possible to set the display mode manually, irrespective of the number of faces. To do this, open the Display rollout and select one of these 3 options:            

                
                [image: images/download/attachments/16482396/-215827472.png]
                    

    	            
    Mesh Turns off the preview modes and displays the full mesh. Often useful when first creating a style but be careful using this mode on large objects as huge poly-counts can easily be created that slow down performance.            

    
	            
    Boxes Forces RailClone to display geometry as boxes.            

    
	            
    Points-Cloud Forces RailClone to display geometry as a points-cloud.            

    

    

    
        What to do if RailClone exceeds its limits.

            
    Occasionally, when creating a very large RailClone object, you may get a warning telling you that the maximum number of segments has been reached.            

                
                [image: images/download/attachments/16482396/-2085173122.png]
                    

                
    This is because RailClone imposes a segment and face count limit to prevent users from accidentally creating RC objects so large they risk crashing 3ds Max. This limit can be increased by going to the display rollout and adjusting the Segments and Faces values.            

                
                [image: images/download/attachments/16482396/-214755027.png]
                    

                
                

        
        
            
    When calculating the face count, instanced geometry is not taken into consideration.            

        

    
    

    
        Related Tutorials:

            
                [image: images/static.itoosoft.com/img/tutorials/1820354810.jpg]
            
building_a_masonry_wall
                

                
    Masonry Wall Tutorial            

                
    The first part of this tutorial includes a section on loading styles from the library browser that may provide a useful recap for this chapter.            

                
                

                
                [image: images/static.itoosoft.com/img/tutorials/13100974020.jpg]
            
create_a_seaside_promenade
                

                
    Seaside Promenade
            

                
    Part one of this tutorial explains how to load a metal railing preset from the library and apply it to a spline Base Object.            

        
            Documentation

        
            
    For more information please see the Customizing the Library, Display Settings, Parameters, Path Base Objects, and Surface Base Objects sections of the online documentation.            

        

    
            
                

        
        
            
                

                
                

        

    
    

        

    


    
        
            How to edit a RailClone style

        


        

        
            
                [image: images/download/attachments/16482422/-604093451.png]
                    

                
    The presets in the library can be easily modified and adapted to create your own styles. By adjusting the rule-sets and editing or even replacing the source geometry, the library presets are a springboard for creating your own styles and gaining a deeper understanding of how RailClone works.            

        
        Exercise: Using the Library to Learn RailClone

            
    Reverse engineering presets is a great way to understand how to construct new rule-sets and create source geometry for RailClone. We strongly recommend you take some time to examining the node-trees for a selection of presets to demystify how they work.            

                
    For example, let's look at a deceptively complex looking preset from the Stadium library:            

    	            
    Start a new scene and draw a spline approximately 12m in length.            

    
	            
    Create a new RailClone object, select and load the Architecture > Building Types > Stadium > Bleachers > Metallic Bleachers 3SR preset from the library. (            

                [image: images/download/attachments/16482347/-1512376667.png]
                    
    Lite users can select Metallic Bleachers 3. The style uses fewer segments but many of the same principles will apply)            

    

            
                [image: images/download/attachments/16482422/-878536818.png]
                    [image: images/download/thumbnails/16482422/285138019.png]
        
Top: Metallic Bleachers 3SR (Pro only) | Bottom: Metallic Bleachers 3 (Lite Users)            

    	            
    From the Base Objects rollout, click on Spline and select the path created in step 1. You'll now see a bleacher as shown below.            

                [image: images/download/attachments/16482422/1076759695.png]
        
	            
    At first glance this looks like a complex style. To look at how it works in detail, you can examine the rule-set. To do this, go the the Style rollout and click            

                [image: images/download/attachments/16482422/1077534383.png]
                    
    to open the Style Editor.            

    
	            
    The style editor will open showing the style's node-tree. You can see that actually this rule-set is quite straightforward.            

                [image: images/download/attachments/16482422/1078428045.png]
                    
    By examining this construction, we can learn a few things about this style and the way that RailClone uses these nodes to create a rule-set.            

    	            
    The preset uses a single Linear Generator. This generator creates a one dimensional array using a length measurement or a spline as a path.            

    
	            
    The preset uses a spline to determine the Path for the 1D Array. To use a spline you must wire a Path object to the generator's Spline input.            

    
	            
    The preset has segments attached to the Default input. As the name suggests, this geometry is used by default unless the rule-set specifies that geometry from one of the other inputs should be used instead (as we'll see next).            

    
	            
    The preset has a segment attached to the Start input. Geometry in the start input will be used once, at the beginning of the spline.            

    
	            
    The preset has segments attached to the End input. Geometry in the end input will be used once, at the end of the spline.            

    
	            
    The preset does not use the Corner or Evenly inputs. This preset is designed to work on straight or curved splines, not splines with hard turns.            

    
	            
    The preset uses a Sequence operator in the Default input. Operators allow you to manipulate segments, we'll discuss them in more detail in chapter 11. But by looking at the style you can deduce that the sequence operator used here is creating a repeating pattern in the array by repeating the segment in input 1 twice, followed by the segment in Input 2. To see how many times a segment is repeated by a sequence operator you click on the node and examine the Count values found in the PropertiesEditor.            

                [image: images/download/attachments/16482422/1965037941.png]
        
	            
    The preset uses a Compose operator in the End input. Compose operators allow you to combine segments, this is useful for adding multiple segments to an input ordinarily designed for just one, such as Start, End, Corner or Evenly.            

    
	            
    The style uses 5 Segments. Each segment node represents a piece of geometry added to and duplicated in the array. To fully understand how a rule-set builds a RC object, it's helpful to be able to see the pieces of geometry from which it is constructed. In library styles the geometry is no longer in the scene but stored inside the RailClone object itself. You can see this by clicking on a Segment node and going to the Properties, if the geometry is stored inside the RC object Embedded will be displayed in place of the object's name.            

                [image: images/download/attachments/16482422/-1439684906.png]
                    
    In the next sections we'll look at how to get that geometry back into the scene so it can be examined, edited and replaced.            

    



    
        Extracting Geometry

            
    Once geometry is assigned to a Segment it is possible to delete the original object and , as we've seen, the RailClone object stores a copy of the mesh internally. However, to edit geometry and adapt styles it may be necessary to extract this object back into the scene. To extract the geometry of the Bleachers style follow these steps.            

    	            
    In the Style editor, select one of the 5 Segment nodes.            

    
	            
    Click            

                [image: images/download/attachments/10092640/-865767358.png]
                    
    from the tool bar or go to Segments>Extract from the menu.            

    
	            
    The Segment's source object will be created in the scene at its original coordinates.            

    
	            
    Do the same for the remaining 4 segments.            

    

            
    You can now see the 5 segments that make up the style. Understanding how the geometry and the rule-set works together is key to mastering the RailClone workflow. In this example you can see that a railing starts the array. The default part of the array, between the start and then end, is made using a Sequence operator to create a repeating pattern of seating and steps (note the supporting legs on the left hand side of both segments). To finish the array we repeat the railing used at the start but before that we need another set of legs, these two components are combined using a Compose operator.            

                
                [image: images/download/attachments/16482422/173280560.png]
                    

                
    Working with RailClone is a little like creating the pieces of a jigsaw and then providing detailed instructions on how they all fit back together. Let's try another example.            

        

    
        Exercise: Disable Nodes to deduce their Function

            
    When analysing library styles, one of the most useful ways to work out what a node is contributing to the rule-set is to toggle it on and off by clicking the the small cross in the top right hand corner. This will disable the function of that node and in most cases the first input will pass through. We'll use this tip to work out how to construct a balance shelving style by reverse engineering the preset.
            [image: images/download/attachments/16482422/335471414.png]
                    

                
    In this illustration the Conditional Node (a) has been disabled. The transform node (b) passes through, ignoring the Conditional node as illustrated by the dotted arrow (c)            

    	            
    Start a new scene and draw a spline approximately 1m in length.            

    
	            
    Create a new RailClone object, select and load the Entourage and Props > Shelving and Storage > Balance Shelving 1 preset from the library.            

                [image: images/download/attachments/16482422/-878536941.png]
        
	            
    From the Base Objects rollout, click on Spline and select the path created in step 1. You'll now see shelving as shown below.            

                [image: images/download/attachments/16482422/316494205.png]
                    
    If you open the Parameters rollout you'll see two values you can edit to change the overall height, and the spacing between shelves.            

    
	            
    Go the the Style rollout and click            

                [image: images/download/attachments/16482422/1077534383.png]
                    
    to open the Style Editor and examine how this preset is made.            

    
	            
    As in the previous example there are a few things you can learn just by examining the nodes:            

                [image: images/download/attachments/16482422/316702712.png]
                    
                

    	            
    The preset uses a single A2S Generator. This generator creates a two dimensional array to create a shelf unit that has an adjustable height and width.            

    
	            
    The preset uses a spline to determine the Path for the X axis of the array. To select a spline you must wire Path objects to the generator's Spline inputs.            

    
	            
    The preset does not use a spline to determine the path for the Y axis. This means that the height must be set using the generator's Y Size property. You can find this by going to the Properties Panel. Note that the value is displayed in red, this means that this property has been Exported.            

                [image: images/download/attachments/16482422/1219221517.png]
        
	            
    The preset has an Exported Y Size property wired to a Numeric node. This allows you to adjust the distance between shelves from the Parameters rollout in the Modify panel. To export a parameter you right click on the node and pick a property from the Export Parameters menu.            

                [image: images/download/attachments/16482422/1221008947.png]
                    
    We'll explore this feature in more detail in     
 Next Steps with RailClone: A guide for intermediate users    
.

To work out what the remaining nodes do, try toggling them on and off to observe the results:            

    
	            
    Turning off the Segment node named Box 23 results in the sides of shelf disappearing. This is logical as the segment is attached to the Left and Right inputs.            

    
	            
    Turning off the Segment node named Box020 results in all the horizontal elements disappearing. Again this is logical, this segment is wired to the Top, Bottom and Y Evenly inputs.            

    
	            
    The preset has an Exported Y Evenly property wired to a Numeric node. This allows you to change the shelf spacing from the Parameters rollout in the Modify panel.            

    
	            
    Take a look at the two Transform operators. Turning off the topmost Transform operator straightens the left side of the shelf.            

                [image: images/download/attachments/16482422/-1658341564.gif]
                    
    You can therefore deduce that it is this operator is offsetting the segment. If you look at the Transform Operator's Properties > Transform > Fixed >Translation > X value, you can see that it is indeed being offset by 0.1m.            

                [image: images/download/attachments/16482422/1221932408.png]
        
	            
    Turning off the bottom Transform operator straighten the right side.The transform operator is also offsetting the segment, but this time using a negative value.            

                [image: images/download/attachments/16482422/1222975158.png]
        
	            
    + k. The two transform operators are wired to Conditional nodes. If you look closely at the wiring you'll notice that the Segment node is wired directly to the True input of the first Conditional node and the False input of the second, the Transform nodes are wired to False input of the first Conditional node and the True input of the second.  When you turn one of the Conditional nodes off, only the segment wired to the True input is used. To check out how the conditional operator works, open the properties panel and look for the activated check-box.            

                [image: images/download/attachments/16482422/1935933655.png]
                    
    The Y Counter check box is ticked. By examining the settings, You can see that this node returns the Segment wired to the True input when the Segment counter for the Y Axis is a multiple of 2. This creates the alternating pattern on the sides of the shelf unit.            

    



            
    By systematically going through the nodes and toggling them on and off you can get a pretty good understanding of how this rule-set works. In this section you've only examined two presets, but if you're new to RailClone, it is often helpful to analyse something similar from the library before creating a new style.            

        

    

    
        Exercise: Editing Library Presets

            
    Sometimes you want to use a preset from the library but it isn't quite right for the project, fortunately styles loaded from the library are fully editable. It may be that you just need to adjust a few settings, or you could use a preset as the basis for a completely new style. The following section examines some of the elements of a preset that are most frequently and usefully edited to adapt the style.            

        
        Adjust commonly used Generator Parameters.

    
        Rotate

            
        
    
The parameter rotates the geometry around the X Spline.     
To use it:    

    
    
            

                
        
    
     
    
            

    	            
    Create a new RailClone object, select and load the Industrial > Ducting > Rectangular Ducting preset from the library and add a spline as the  Base Object.            

                [image: images/download/attachments/16482422/-878566733.png]
        
	            
    Go the the Style rollout and click            

                [image: images/download/attachments/16482422/1077534383.png]
                    
    to open the Style Editor.            

    
	            
    Select the Generator and edit the Properties > Geometry > X Rotation value. Editing this value rotates the whole style around the spline.    
    
            [image: images/download/attachments/16482422/-1050400813.gif]
        
    
            

    

    

    
        Reverse

            
        
This parameter reverses the direction of the path. This has the same effect as applying a "Reverse" command to an editable spline. To use it:
    
            

    	            
    Create a new RailClone object, select and load the Civil Engineering > Street Lights > Street Light 3 Single preset from the library and add a spline as the Base Object.            

                [image: images/download/attachments/16482422/-878477270.png]
        
	            
    Go the the Style rollout and click            

                [image: images/download/attachments/16482422/1077534383.png]
                    
    to open the Style Editor.            

    
	            
    Select the Generator and toggle the Reverse check-box. The lights will flip to face the other side of the spline.            

                [image: images/download/attachments/16482422/-1468968004.png]
                    
                

    

    

    
        Offset Y/Z

            
        
Y Offset applies an offset perpendicular to the path's direction, Z Offset adjusts the position of the geometry on the RailClone Objects local Z axis. To use these settings:
    
            

    	            
        
Use the Street Light preset from the previous example and open the Generator's properties.     
            

    
	            
        
Edit the Y Offset value, the lights will offset perpendicular to the path.    
            

    
	            
        
Edit the Z Offset value, the lights will move up and down. 
            [image: images/download/attachments/16482422/-1019779949.gif]
        
            

    

    

    
        Mirror, Flip A, and Flip B

            
        
These parameters clone the RailClone geometry using the path as a mirror axis. This is particularly useful for presets such as sidewalks and street-lights where you might typically have a spline that defines the centre of the road and you require these styles on both sides. The Flip options allow you to flip the geometry where A is the original array and B is the copy created with the Mirror feature.To use this feature:
    
            

    	            
        
Continue with the Street Light preset from the previous example and open the Generator's properties.     
            

    
	            
    Click Mirror.            

    
	            
    Increase the Y Offset value. you will now have two parallel arrays. At the moment all the lights are facing in the same direction.            

    
	            
    Click Flip A to switch the lights on one side of the array so that both sets face towards one another.            

                [image: images/download/attachments/16482422/-1073910849.gif]
        

            
        

    
            

        

    

    
        Evenly Distance

            
        
Evenly spaced segments are placed at regular intervals along the spline. In some presets, the distance value between evenly segments has been exported and can be adjusted from the Parameters rollout, for styles missing this parameter you can adjust the spacing by following the steps outlined in the following example.

    
            

    	            
        
Download and open exercise_curtain_wall_adapt.max. This file contains the objects needed for the next 3 exercises.    
            

    
	            
    Create a new RailClone object, select and load the Architecture > Exterior > Facade > Curtain Wall > Curtain Wall Curve 01 preset from the library.            

                [image: images/download/attachments/16482347/-1512376667.png]
                    
                

                [image: images/download/attachments/16482422/2080153054.png]
        
	            
    From the Base Objects rollout, click on Spline and select the spline called Line001 from the scene . You'll now see a faade as shown below.            

                [image: images/download/attachments/16482422/2080212611.png]
        
	            
    Go the the Style rollout and click            

                [image: images/download/attachments/16482422/1077534383.png]
                    
    to open the Style Editor.            

    
	            
    Go to the Generator's Properties and switch to the Rules tab.            

    
	            
    At the bottom of this tab you'll see the Evenly group, adjust the Distance parameter to control the spacing between Evenly Segments.
            

                [image: images/download/attachments/16482422/2080391386.png]
        

    

    
        Extract and edit Geometry

            
        
     
RailClone segment's geometry is embedded in the object in a similar fashion to Max's compound objects. However as we've seen, these can be extracted allowing you to easily adapt existing styles. In this example we will edit the height of the geometry used in the curtain wall style from the previous example.    
 
    
            

    	            
    Open the Style Editor and select the Segment node wired to the Generator's Default input. Click             [image: images/download/attachments/16482422/-735450738.png]
     to extract the segment.            

    
	            
    Do the same for the remaining 3 Segments. You will now have these 5 mesh objects in the scene.            

                [image: images/download/attachments/16482422/-735391067.png]
        
	            
    Let's imagine that In the current style the wall is not tall enough and we need it to be larger. Once extracted, the geometry is instanced to the RailClone object, if you edit the extracted mesh the RC object will also update automatically.            

    
	            
    Select all 5 extracted wall meshes and add an Edit Poly modifier. Select the vertices at the top of the mesh and use the move tool to increase the height. As you can see, the style updates live in the viewports. Once you're happy with the changes , the geometry can be safely deleted and RailClone will continue to retain an updated copy internally.            

                [image: images/download/attachments/16482422/-809454626.gif]
                    
                

    

            
        
     
            

        

    
        Swap Geometry

            
    Once you understand how a style works you can use it as a template and add your own geometry.  In this example we'll keep the same faade preset, but swap the geometry to create a completely different style. To do this we'll use the four meshes included in exercise_curtain_wall_adapt.max.            

                
                [image: images/download/attachments/16482422/-1327340315.png]
                    

    	            
    Keep the style from the previous example and open the Style Editor.            

    
	            
    To swap geometry, select the Segment wired to the Default Input, go to the Properties panel and click the Pick Object button (            

                [image: images/download/attachments/16482422/-735577154.png]
                    
    ), then select the mesh in the scene called Default.             

    
	            
    Do the same for the other Segments. Select the segment wired to the Start input, go to the Properties panel and click the Pick Object button , then select the object in the scene called Start.            

    
	            
    Select the segment wired to the End input, go to the Properties panel, click the Pick Object button, and select the object in the scene called End.            

    
	            
    Finally, select the segment wired to the Evenly input, go to the Properties panel, click the Pick Object button, and select the object in the scene called Evenly.            

    

            
    By following this procedure, what started as a stock preset will have changed from this...            

                
                [image: images/download/attachments/16482422/-1326387096.png]
                    

                
    ... to this...            

                
                [image: images/download/attachments/16482422/-1326387039.png]
                    

                
    ...just by swapping the geometry.            

                
    Starting with library styles either as a learning aid or as a template for new geometry is a powerful way to get started with RailClone. In the next chapter we'll dive into the L1S generator and create a new style from scratch.            

        

    

    
        Related Tutorials

            
                [image: images/static.itoosoft.com/img/tutorials/1739088337.jpg]
            
stadium
                

                
    Stadium Tutorial Part 1
            

                
    In the first part of this tutorial we learn how to use some of the default library styles that are included with RailClone, looking at how they can be used out-of-the-box, or adapted to solve individual problems. In this tutorial you create the metal railings, concrete barriers and glass faades that run around the entire stadium            

                
                

                
                [image: images/static.itoosoft.com/img/tutorials/12247134150.jpg]
            
civil_view_interop.
                

                
    Using RailClone with Civil View
            

                
    In this tutorial we explore how to apply presets from the RailClone library to Base Objects imported from Civil 3D. Many of the styles are edited using Mirror, X/Y Offset, and Flip A/B.            

                
                

        
            Documentation

        
            
    For more information please see the Customizing the Library, 1D arrays - Generator L1S, 2D arrays - Generator A2S,  Segments and Exporting Parameters  sections of the online documentation.            

        

    
    

        

    


    
        
            Create your first 1D array

        


        

        
            
        
    
            [image: images/download/attachments/16744475/-602365632.png]
        
    
            

                
        
    
Having learned how to use and adapt the library, it's time to start creating your ownstyles. To do this it's important to have a good understanding of how base objects, segments and generators interact. In this section we'll learn how to use an L1S generator to create a low-poly background building.    
    
            

                
        
    
            [image: images/download/attachments/16744475/-141436027.png]
        
    
            

                
        
    
    
    
To get the assets required to follow this chapter, download and open l1s-exercise.max.    
    
    
    
            

        
        Creating geometry for an L1S Generator

            
        
    
The first thing to consider when creating a new RC style is how the individual pieces of geometry fit together. In Chapter 4 we examined the five parts of a one dimensional array, and when creating the meshes for segments it's important to think in terms of how they will fit into this system. You may find it is helpful to model a small part of the style as a single object and then break it apart using 3ds Max's Slice modifier, doing this will ensure that the resultant segments fit together correctly. Illustrated below are the pieces that you will use for the exercises in this chapter. The Walls and Balustrades were created using the Slice-modifier technique.      
    
    
    

    
    
            

        
        Balustrades

            
        
    
            [image: images/download/attachments/16744475/-141160596.png]
        
    
            

                
        
    
Balustrades model before slicing - yellow lines indicate slice planes
    
    
            

        

    
        

            
        
    
            [image: images/download/attachments/16744475/-976129807.png]
        
    
            

                
        
    
    
    
Balustrades model after slicing. 
    
    
    
    
            

        

    
        Walls

            
        
    
            [image: images/download/attachments/16744475/-170042114.png]
        
    
            

                
        
    
    
    
Walls after slicing.     
    
    
    
            

        

    
        Roof

            
        
    
            [image: images/download/attachments/16744475/-976100044.png]
        
    
            

                
        
    
The roof using only one segment
    
    
            

        

    
        Pivots

            
        
    
The geometry's pivots will be aligned with the coordinate system used by the RailClone object. In an L1S array, and when creating the RailClone object in a Perspective or Top viewport, the axes are oriented so that the X Axis follows the length of the spline, the Y Axis runs perpendicular to the spline, and the Z Axis is vertical, matching the world's Z axis and also the RailClone object's local orientation. 
    
    
            

                
        
    
            [image: images/download/attachments/16744475/-88626062.png]
        
    
            

                
        
    
    
    
In order for geometry to be correctly aligned in the array, it may occasionally be necessary to adjust the orientation of the local axis. To do this:    
    
    
    
            

    	            
        
    
    
    
Select the Geometry object.    
    
    
    
            

    
	            
        
    
    
    
Go to 3ds Max's Hierarchy Panel.    
    
    
    
            

    
	            
        
    
    
    
Click Affect Pivot Only.    
    
    
    
            

                [image: images/download/attachments/16744475/-141318793.png]
        
	            
        
    
    
    
Rotate the Gizmo to the correct orientation. 
    
    
    
    
            

    

            
        
    
    
    
As well as orientation, another consideration is the position of pivot points. In order for segments to snap together correctly, it's possible to align the segments on the base object using the local pivot point of the source geometry. This is particularly true on the Y and Z axis, and less so on the X where RailClone's automatic mode is often more useful. In the examples on this page we will use the pivot point to position the     
    
all the segments on the Y axis and ensure they snap together correctly, to make this possible all of the pivot points are aligned on the X and Y axes as illustrated in the image below.
            [image: images/download/attachments/16744475/-112561268.png]
        
    
            

        

    
        Material IDs and UVW Coordinates

            
        
    
By default RailClone retains the the UVW coordinates and Material IDs of the source geometry. It does not automatically create multi-sub object materials or reassign IDs. This means that when creating geometry it is important to ensure that the Material IDs would work as if the individual components were a single object with a single material (which can be a mult-sub), since this is how they will appear to RailClone. 
    
    
            

        

    

    
        Exercise:  Creating A Rule-Set

            
        
    
As you saw in Chapter 3, the L1S generator has 5 inputs: Start, End, Corner Evenly, and Default.     
    
            

                
        
    
            [image: images/download/attachments/16482350/-11132150220.gif]
        
    
            

                
        
    
In this section we'll create an example that uses of all of these. It's important to note that it isn't necessary to use all 5 inputs,  many styles may only require a selection of the available inputs. When an input is omitted the array is completed using Default segments. 
    
    
            

        
        Creating a RailClone Object

            
        
    
Once the geometry has been prepared, we're ready to create a new style. To do this we need to add a new empty RailClone object and open the Style editor:    
    
            

    	            
    Go to 3ds Max's Command > Create > Geometry  panel and change the category to iToo Software.            

                [image: images/download/attachments/16482364/923135189.png]
        
	            
    Click            

                [image: images/download/attachments/16482364/1415251877.png]
                    
    .            

    
	            
    Click and drag in the Top or Perspective viewport to create a RailClone icon.            

    
	            
    Open the Style rollout and click            

                [image: images/download/attachments/16744475/-112805923.png]
                    
    to open the Style Editor.
            [image: images/download/attachments/16744475/797983864.png]
                

    
	            
    The Style Editor will open.            

    

    
            Using the Style Editor

        
            
    Before creating your first style, take a few moments to learn how to interact with the style editor. As well as the essentials, you will learn a few lesser known commands that can make working with RailClone much faster.    To add a new node to the Construction view

            

                
                [image: images/download/attachments/10092634/-1897025961.gif]
                    

                
    Adding a new node            

    	            
    Identify the node type in the Items list on the right hand side of the style editor, select and drag it into the Construction View.            

    

    To rename a node

	            
    Select the node in the Construction View            

    
	            
    In the Properties Editor type a new value in the name field.            

    

    To connect nodes

            
    Connecting nodes            

    	            
    Click on the output of a node, drag the mouse (you'll see a wire following the mouse pointer) and release over the input of another node.            

    

    To connect multiple nodes

            
    Multiple nodes can be attached to Compose, Sequence, Random, and Selector operators. To do this:            

    	            
    Select the nodes you wish to attach.            

    
	            
    Drag any of the node's outputs to the operator's input.            

    

    To swap the connections for two nodes

            
                [image: images/download/attachments/10092634/-1257831170.gif]
                    

    	            
    Drag the output of a node 1 to the output of node 2. Their connections will swap.            

    

    To disconnect nodes

	            
    Click on the output slot of a node and drag to a empty area of the Construction View. Any nodes connected to the slot will be released.            

    

    To collapse and expand nodes

            
    Collapsing and expanding nodes            

    	            
    To collapse a node, click on the small upward facing arrow on the right of the title bar            

    
	            
    Once a node is collapsed, to expand it again click on the small downward facing arrow on the right of the title bar            

    

    To automatically select a nodes children

	            
    Hold down Alt and Click on any node to automatically select its children.            

        [bookmark: 16744475_g]
            
                

    

            
                

        

    
    

    
        Creating a Generator

            
        
    
Think of a generator as the brain of the style, it creates the rules that tell RailClone how to construct the array. A style needs at least one generator but is not limited to this, you can combine as many as necessary even mixing L1S and A2S generators to rapidly achieve sophisticated results. By the end of this example you'll create a total of 3 L1S generators; one for the faade, one for the balustrade, and one for the roof.     
    
            

                
        
    
To create a generator for the faade, follow these 2 steps:
    
    
            

    	            
        
    
With the Style Editor open, drag a L1S Generator from the Items List to the Construction View.
            [image: images/download/attachments/16744475/-112750180.png]
        
    
            

    
	            
        
    
As we're going to add 2 further generators, let's name this one for easy identification. Select the node, go to the Properties panel and enter Faade L1S in the Name field.
            [image: images/download/attachments/16744475/800664953.png]
        
    
    
    

    
    
            

    

    

    
        Adding a Base Object

            
        
    
Now that you have an array, you need to specify how large it should be. There are two ways to set the dimensions of an array: you can either specify a distance value in scene units, or use a spline. To set a value:    
    
            

    	            
        
    
Click on the Generator node.    
    
            

    
	            
        
    
Go to the Properties panel.    
    
            

    
	            
        
    
Enter a distance value for the Properties > Geometry > X Size parameter. 
            [image: images/download/attachments/16744475/-112753067.png]
    
    
    
            

    

            
        
    

Alternatively, as in this example, you can use a spline to determine the size and path of the array. In RailClone terminology we call a spline used in this way a  Base Object. When using dimensions the array is always straight, but when using a spline, the array can follow and deform along complex curves. To add a spline Base Object to the generator created above, follow these steps:    
    
            

    	            
        
    
Drag a Spline Object from the Items List to the Construction View. 
    
    
            

    
	            
        
    
Click and hold on the Output of the Spline node and drag a wire to the Spline Input of the generator.
            [image: images/download/attachments/16744475/801499102.png]
        
    
            

    
	            
        
    
We now need to tell RailClone which spline in the scene to use. You can select the spline in one of two ways:    
    
    
    

From inside the style Editor    
    
            

    	            
        
    
Select the Spline Node and go the the Properties Panel.     
    
            

    
	            
        
    
Click the Object Picker button
            [image: images/download/attachments/16744475/-426796974.png]
        
    
            

    
	            
        
    
Click the spline in the scene called Spline 01.    
    
            

    



            
        
    
From the Modify Panel    
    
            

                
    When an object node is created in the Construction view, a corresponding item is added to the Base Objects rollout in the Modify Panel. This allows you to apply the style to a spline without having to open the style editor. To do this:
            [image: images/download/attachments/16744475/-425128650.png]
                    

    		            
        
    
Open the Base Objects rollout in the Modify Panel.
    
    
            

    
	            
        
    
Select Spline from the Base Objects list    
    
            

    
	            
        
    
Click on the Spline picker button and select the spline called Spline 01 from the scene.    
    
            

    



    

    
        Adding Segments

            
        
    
With a generator path successfully created, the final ingredient is geometry. In RailClone terminology, an individual mesh object added to a style is called a Segment and they are created in much the same way as base objects. To create a segment you first add a Segment node to the construction view and and then assign an object from the scene. To add the first segment, follow this procedure:
    
    
            

                
        
    
     
    
            

    	            
    Create a new Segment Object (            

                [image: images/download/attachments/10092640/1565351274.png]
                    
    )by dragging from the Items List to the Construction View.            

    
	            
    Go to the Properties Editor and click on the Object picker.            

                [image: images/download/attachments/16744475/462374968.png]
        
	            
    Select the geometry you wish to use from the scene, in this case we'll pick Facade Start/End/Evenly.            

    

    

    
        The Start and End input

            
        
Now that we have a segment, we need to assign it to a part of the array. In this section we'll add the segment to the Start and End inputs. Wiring a segment to these inputs creates geometry at the start and end of the path, as defined by the spline's original vertex numbers.     
            

    	            
        
Click and hold on the Segment node's output socket, then drag a wire to the Generator's Start input socket. 
            [image: images/download/attachments/16744475/-1092459817.gif]
        
            

    
	            
        
Repeat the action to attach the Geometry node to the Generator's End input.    
            

    
	            
        
Click on the Geometry Node, go to the Properties panel and change the Alignment > Y to Pivot. As mentioned in the geometry section above, to ensure that the segments fit together correctly all the segments used in this style will use Alignment > Y = Pivot.
            [image: images/download/attachments/16744475/-2006141509.png]
    
    
            

    
	            
        
You will now have a segment at the start and end of the Spline:
    
            [image: images/download/attachments/16744475/-2034690495.png]
        

    
    

    
            

    

    
            Adding multiple segments to an input

        
            
    Sometimes you need to assemble several segments for each position, not only one piece. In this case, you can use a "Compose" operator, to join several elements in an unique segment. We examine this in more detail in Chapter 11.            

        

    
            
        
     
            

        

    
        The Corner input

            
        
    
To create corners, we wire a segment to the "Corner" connector on the generator's nod    
e. Corner geometry appears only on vertices of a specified type found on the path. By default only Corner or Bezier-corner vertices are used, but this can be changed from the Generator's properties. In this example we'll retain the default settings.     
            

    	            
    Create a new Segment Object (            

                [image: images/download/attachments/10092640/1565351274.png]
                    
    )by dragging from the Items List to the Construction View.            

    
	            
    Go to the Properties Editor and click on the Object picker.            

    
	            
    Pick Facade Corner from the scene.            

    
	            
        
Still in the new Segment node's Properties, change Alignment > Y to Pivot.     

    
            [image: images/download/attachments/16744475/-2006141509.png]
        
            

    
	            
        
Wire the Segment to the Generator's Corner input.     
    

            [image: images/download/attachments/16744475/-2006052166.png]
        
            

    

    

    
        Bevelling corners

            
        
By following the previous steps, the corners appear, but they look a little strange:
            [image: images/download/attachments/16744475/-2006022311.png]
        
    
     
    

This is because by default corners will try to deform to follow the path, so the geometry is attempting to bend around a 90 degree corner. Instead we want the corner to be bevelled. To do this make these changes:    
            

                
        
            [image: images/download/attachments/16744475/-2061279044.png]
        
            

    	            
        
Select the Generator and go to the Properties panel.    
            

    
	            
        
Click the Rules tab.    
            

    
	            
        
Activate the Bevel Corner checkbox. 
    
            

    
	            
        
The segments are now sliced on the corner. You can adjust this further using the BC Offset value which allows you to add an offset to the Corner segments. Positive values pull the segment towards the corner, and negative values move the segments away from the corner. For this example enter a value of 35% to ensure that the Corner segments bevels in the correct place. 
    
            

    
	            
        
    
You have now successfully added Start, End and Corner segments to the array:
    
    
            

                
        
            [image: images/download/attachments/16744475/1349104058.png]
        

    
     
            

    

    

    
        The Evenly input

            
        
This construction rule lets you to add regularly spaced segments along the path between Start, End and Corner segments. In this example you'll reuse the existing segment named Facade Start/End/Evenly.    
            

                
        
     
            

    	            
    Wire the segment named Facade Start/End/Evenly to the Generator's Evenly input.            

                [image: images/download/attachments/16744475/-2059342566.png]
        
	            
    To change the spacing between Evenly segments, go to the Generator's Properties (1). Click on the Rules tab (2) and edit the Evenly > Distance value (3). For this example enter a value of 700cm.            

                
        
            [image: images/download/attachments/16744475/-2059253231.png]
        
            

    
	            
        
    
You have now successfully added Start, End, Corner and Evenly segments to the array. There's only one more input left to add - Default.
    
    
            

                
        
            [image: images/download/attachments/16744475/1349104147.png]
        
            

    

    

    
        The Default input

            
        
The segment used in the default input fills in between the Start, End, Corner, and Evenly segments.     
To add a Default segment:            

    	            
    Create a new Segment Object (            

                [image: images/download/attachments/10092640/1565351274.png]
                    
    )by dragging from the Items List to the Construction View.            

    
	            
    Go to the Properties Editor and click on the Object picker.            

    
	            
    Pick Faade Default  from the scene.            

    
	            
        
Still in the new Segment node's Properties, change Alignment > Y to Pivot.     
            

    
	            
        
Wire the new segment to the Generator's Default input.    
            

    
	            
        
    
    
You have now successfully added start, end and corner and default segments to the array and completed the faade. In the next sections you add additional generators to create a balustrade and roof.     
    

            [image: images/download/attachments/16744475/1349133819.png]
                 [image: images/download/attachments/16744475/-1170736655.png]
    
    
            

    

    
            Default Modes

        
            
    Though in this example the default segments simply tile along the path, RailClone has 3 additional modes for calculating how to fill a section with Default geometry:    Tile (Default)

            

                
                [image: images/download/attachments/16744475/-2105244335.gif]
                    

                
    The default segment are replicated along the path, slicing the geometry if necessary.    Scale

            

                
                [image: images/download/attachments/16744475/109250890.gif]
                    

                
    The default segments are scaled along the X axis to fit the distance between the initial and final positions of the path section. A section is defined by the Start and End points of the spline unless an X-Evenly or corner segment is used to subdivide the path.    Adaptive.

            

                
                [image: images/download/attachments/16744475/-1306012042.gif]
                    

                
    Adaptive mode calculates the number of whole segments that would fit along a spline section then scales them all on the X axis to fill the available space. This mode generates complete segments, with no clipping at the start or end of a spline segment. When Adaptive mode is active the bevel settings are unavailable.            

                
    Count Mode.            

                
                [image: images/download/attachments/16744475/65298671.gif]
    
            

                
    Scales a fixed number of segments to fit between the start and end positions of a path section. A section is defined by the start and end points of the spline unless a X-Evenly or corner segment is used to divide the path. When Count mode is active the bevel settings are unavailable.            

        

    
    

    

    
        Exercise: Using multiple generators

            
    As styles become more sophisticated it is often much easier to use multiple generators. In this example we'll add a 2 more generators to the existing style, one for the roof and a third for the Balustrade.            

        
        Adding the Roof.

	            
    Make sure you continue with the existing Building style, and open the Style Editor.            

    
	            
    Add a second L1S Generator (            

                [image: images/download/attachments/16744475/-1169991912.png]
                    
    ) by dragging it from the Items List to the Construction View.            

    
	            
    Rename the generator Roof Generator.            

    
	            
    Wire the existing Spline node to the roof Generator's Spline input. By reusing the spline in this way, you can be sure that both generators follow the same path.            

                [image: images/download/attachments/16744475/-1948644850.png]
        
	            
    Create a new Segment Object (            

                [image: images/download/attachments/10092640/1565351274.png]
                    
    )by dragging from the Items List to the Construction View.            

    
	            
    Go to the Properties Editor and click on the Object picker.            

    
	            
    Pick the object named Roof from the scene.            

    
	            
        
Still in the new Segment node's Properties, change Alignment > Y to Pivot.     
            

    
	            
        
Wire the new segment to the roof Generator's Default input.    
            

    

            
        
You will now have a roof in the scene, but it's at the base of the building instead of above the existing faade.     
            

                
        
            [image: images/download/attachments/16744475/-1948793867.png]
        
            

                
        
To resolve this you can use the Generator's Z Offset parameter to move the roof into the correct position. To do this:    
            

    	            
        
Select the roof Generator.    
            

    
	            
        
Go to the Properties panel and enter a value of 1065cm for the Z Offset parameter.
            [image: images/download/attachments/16744475/-1948704521.png]
        
            

    
	            
        
The roof is now in the correct position.    
    
 In the next section we'll add the balustrade, using the same Z offset value to ensure its position matches the roof. 
            [image: images/download/attachments/16744475/-1948674707.png]
    
    
            

    

    

    
        Adding the Balustrade

	            
    Add a third L1S Generator (            

                [image: images/download/attachments/16744475/-1169991912.png]
                    
    ) by dragging it from the Items List to the Construction view.            

    
	            
    Rename the generator Balustrade Generator.            

    
	            
        
Go to the Properties panel and enter a value of 1065cm for the Z Offset parameter.
            [image: images/download/attachments/16744475/-284156458.png]
        
            

    
	            
    Wire the existing Spline node to the balustrade Generator's Spline input. All 3 generators are now sharing the same spline.            

                [image: images/download/attachments/16744475/-286212130.png]
        
	            
    Create a new Segment Object.            

    
	            
    Go to the Properties Editor and click on the Object picker.            

    
	            
    Pick the object named Balustrade Start/End from the scene.            

    
	            
        
Still in the new Segment node's Properties, change Alignment > Y to Pivot.    
            

    
	            
    To save time we can use this node as a template to quickly add the other geometry required. To do this. right click on the new Segment and select Clone Multiple.            

                [image: images/download/attachments/16744475/-285348131.png]
        
	            
    A Select Objects window opens. Pick Balustrade Default, Baluststrade Evenly, and Balustrade Corner then click Clone. RailClone will generate a new Segment node for each of the selected items.            

                [image: images/download/attachments/16744475/-285258823.png]
        
	            
        
Wire Balustrade Start/End to the balustrade Generator's Start input.    
            

    
	            
        
We want to reuse this segment in the End input, but it needs to be mirrored first. Instead of creating new geometry and adding an extra segment you can use a Mirror operator to flip the segment directly inside of RailClone. To do this, drag a new Mirror operator (            [image: images/download/attachments/16744475/-285139570.png]
    ) from the Items List to the Construction View. Wire Balustrade Start/End to the Mirror node's input. Wire the Mirror node's output to the Generator's End input.    
    
 (we will discuss operators in more detail in Chapters 10 and 11) 
            [image: images/download/attachments/16744475/-284394825.png]
    
    
            

    
	            
        
Wire Balustrade Default to the balustrade Generator's Default input.    
            

    
	            
        
Wire Balustrade Evenly to the balustrade Generator's Evenly input.    
            

    
	            
        
    
Wire Balustrade Corner to the balustrade Generator's Corner input. Like the faade example above, the cor    
    
ner settings now need to be adjusted.            

    
	            
    Click on the balustrade Generator and from the Properties panel, activate Rules > Corner > Bevel Corner and set the BC Offset value to 4%.            

                [image: images/download/attachments/16744475/-284186349.png]
        

            
    This completes the building style. The complete node tree should look like this:            

                
                [image: images/download/attachments/16744475/-283471394.png]
                    

                
    Once a style is created it's simple to reuse and re-purpose. Try cloning the object and swapping the base object by picking Spline 01 and Spline 02. RailClone deforms the geometry to follow the curves and corners of any path.            

                
                [image: images/download/attachments/16744475/-283322410.png]
                    

        

    

    
        Related Tutorials

            
                [image: images/static.itoosoft.com/img/tutorials/182035481.jpg]
                

                
    Masonry Wall
            

                
    The Masonry Wall tutorial is good accompaniment to this chapter. It is intended for new users of RailClone, and provides a thorough introduction to some of the most commonly used features. By completing this exercise you will be able to use the built in library, understand the style editor, and easily create new styles.            

                
                [image: images/static.itoosoft.com/img/tutorials/241647385.jpg]
                

                
    Power Lines
            

                
    This tutorial explains in more detail the Default modes and walks you through the steps necessary to create power lines.            

                
                [image: images/static.itoosoft.com/img/tutorials/17390883370.jpg]
                

                
    Stadium Tutorial Part 2,3, and 4
            

                
    The stadium tutorial uses a number of L1S arrays to create advertising hoarding, seating and the crowd. These expand on the fundamentals discussed here to introduce randomisation, controlling material IDs, exporting parameters and using many useful operators.            

                
                [image: images/static.itoosoft.com/img/tutorials/1310097402.jpg]
                

                
    Create a seaside promenade            

                
    In this tutorial we explain how to use RailClone to create your own 1D and 2D arrays to recreate a Seaside Promenade image. This tutorial builds on the foundations in this chapter and explores in detail how to use styles from the library, create new styles, use operators, edit padding and introduce 2d arrays.            

                
                

        
            Documentation

        
            
    For more information please see the 1D arrays - Generator L1S, Path Base Objects, Style Editorand Segments sections of the online documentation.            

        

    
    

        

    


    
        
            Create your first 2d array

        


        

        
            
        
    
            [image: images/download/attachments/16744528/-602335836.png]
        
    
            

                
        
    
The 2D Array , or A2S generator,  features 12 possible inputs, making it an incredibly powerful and versatile tool for creating parametrised objects including faades, floors, ceilings, pavement, tiles, structural steel, cladding and much much more. Before creating your first style, take a few minutes to get reacquainted with the different parts of the A2S Array. The exercise on this page makes use of all 12 inputs, but often you'll only need a selection of these to get the correct result.     
    
            

                
        
    
     
    
This generator can be confusing for new users, but once you've understood the L1S generator, the A2S generator becomes a lot easier. The best way to understand the nuances of the A2S generator is to think of it as a stack of L1S generators. Internally, each row is treated as an independent 1D array, each with it's own start, end, corner and evenly segments. The A2S array uses 4 types of row: one at the Bottom of the array, one at the Top, several spaced Evenly on the Y axis, and a Default row that fills in whatever is left between the other 3. Each of these rows independently behaves exactly like an L1S generator, but the inputs are renamed. The animated gif and table below demonstrate the relationship between a stack of L1S arrays and the input names as they appear in the A2S generator            

                
        
    

    
    
            

                
        
    
     
    
            

                
                [image: images/download/attachments/16744528/-1139659015.gif]
                    

                
        
    

    
    
            

                
        
    

    
    
            

        
        
                
            	
    L1S Row            
                	
    Start            
                	
    Corner            
                	
    Evenly            
                	
    Default            
                	
    End            
        

    
            	
        
Top Row    
            
                	
    Top Left Corner            
                	
    Inner Corner            
                	
    X Evenly            
                	
    Top side            
                	
    Top Right corner            
        

    
            	
        
Y Evenly Row    
            
                	
    Left side*            
                	
    Inner Corner            
                	
    X Evenly            
                	
    Y Evenly            
                	
    Right side*            
        

    
            	
        
Default Row    
            
                	
    Left side            
                	
    Inner Corner            
                	
    X Evenly            
                	
    Default            
                	
    Right side            
        

    
            	
        
Bottom Row    
            
                	
    Left Bottom corner            
                	
    Inner Corner            
                	
    X Evenly            
                	
    Bottom row            
                	
    Right Bottom Corner            
        

        

            

            
    * (or Y Evenly if extend to side is active)            

        
        Creating Geometry for an A2S Generator

            
        
    
At the beginning of the previous chapter we discussed the importance of planning your geometry to ensure it fits correctly into the different parts of the array. The same rules apply, and are even more important when creating geometry for the A2S array. To recap, the best way to understand the A2S generator is to think of each row as a separate L1S generators, each once stacked on top of another, but all still essentially independent.    
    
 This understanding is essential if you want to create geometry to populate an array that is intended to fit together perfectly without leaving any gaps.These are the 3 Golden rules for modelling for the A2S Generator.            

        
        Rule 1: Segments can be  any  X length

            
    As we've seen, each Row is a separate L1S generator and is calculated independently, so there's no problem at all with using segments with unequal sizes on the X axis. Adjacent segments in the same row will simply move along the array to accommodate any size of geometry. Rows above and below remain unaffected and no gaps appear.            

        

    
        Rule 2: To avoid gaps, Segments should be the  same  Y length

            
    Because the A2S array is a stack of L1S generators, if you use Segments with unequal sizes on the Y axis in a row, the overall height of that row is determined by the tallest segment. The row directly above will be positioned after the tallest segment and gaps will appear.            

                
                [image: images/download/attachments/16744528/-1326034688.png]
                    

                
    a. The corner segment has been scaled to twice it's normal width, adjacent segments in the same row adjust automatically an no gaps appear | b. The corner segment has been scaled to twice it's normal height, the row above moves to accommodate the largest size and gaps appear in the array.            

        

    
        Rule 3: Align the source geometry's pivots to the X and Y axes

            
    The 2d array is created along the X and Y axes of the RailClone object's local coordinate system, and segment's will be oriented to that their own axes align with this. It's very tempting, especially with vertical styles like faades and cladding, to align geometry incorrectly so that the vertical elements are on the Z axis. For example, the image below illustrates the segments used in the faade exercise on this page. The collection of segments marked A are incorrectly orientated so that there verticals align to the Z Axis. The group of segments marked B  are correctly oriented. Their segments are aligned to the X and Y axis, matching the axes used by RailClone to construct the array.            

                
                [image: images/download/attachments/16744528/-1383222340.png]
                    

                
        
    
     
    
            

        

    

    
        Exercise: Creating glazing using a 2D Array

            
                [image: images/download/attachments/16744528/1092825666.png]
                    

                
    In this exercise you'll create a new glazing style from scratch that uses all 12 inputs of the A2S generator. By doing this you should gain a good understanding of the A2S generator.            

        
        Creating a Generator

            
        
    
To create a generator for the Glazing , follow these steps:
    
    
            

    	            
    Open the file named A2S_generator.max. This scene contains all the geometry and paths required to recreate this style.            

    
	            
    Create a new RailClone object and name if rc_glazing.            

    
	            
    Go to the Modify panel, open the Style rollout and click on            

                [image: images/download/attachments/16744475/-112805923.png]
                    
    to open the Style Editor.            

    
	            
        
    
With the Style Editor open, drag a Array 2S Generator from the Items List to the Construction View.
            [image: images/download/attachments/16744528/-679209355.png]
        
    
            

    
	            
        
    
Open the Generator's properties and set the Rules > Default Segment > Mode type to Scale.    
    
            

                [image: images/download/attachments/16744528/208234717.png]
        

    

    
        Adding Base Objects

            
        
    
Now that you have an array, you need to specify how large it should be. To create a an A2S array you need to set a distance for the X and Y axes. There are two ways do this, you can either specify a distance value in scene units, or use a spline. In this example you'll use a spline or the X axis and use a distance for the Y axis:    
    
            

        
        Add a spline for X Axis

	            
        
    
Drag a Spline Object from the Items List to the Construction View. 
    
    
            

    
	            
        
    
Click and hold on the Output of the Spline node and drag a wire to the X Spline Input of the generator.
            [image: images/download/thumbnails/16744528/-679090097.png]
    
    
    
            

    
	            
        
    
We now need to tell RailClone which spline in the scene to use. You can select the spline in one of two ways:    
    
    
    

Either from inside the style Editor...    
    
            

    	            
        
    
Select the Spline node and go the the Properties Panel.     
    
            

    
	            
        
    
Click the Object Picker button
            [image: images/download/attachments/16744475/-426796974.png]
        
    
            

    
	            
        
    
Click the spline in the scene called Path Spline.    
    
            

    



            
        
    
     
    
            

                
        
    
...or from the Modify Panel    
    
            

                
        
    
     
    
            

    		            
        
    
Open the Base Objects rollout in the Modify Panel.    
    
            

    
	            
        
    
Select Spline from the Base Objects list    
    
            

    
	            
        
    
Click on the Spline picker button and select the spline called Spline 01 from the scene.    
    
            

    



    

    
        Set a distance for the Y axis

	            
        
    
In the Style Editor, click on the Generator node.    
    
            

    
	            
        
    
Go to the Properties panel.    
    
            

    
	            
        
    
Enter a distance value of 10m for the Properties > Geometry > Y Size parameter. 
            [image: images/download/attachments/16744528/-678285802.png]
    
    
    
            

    

    

    

    
        Importing Segments

            
    The Glazing style is constructed from seven different segments. Adding these one at a time is time-consuming, so to speed things up we'll automate the process using RailClone's Clone Multiple command.            

    	            
    Create a new Segment Object.            

    
	            
    Go to the Properties Editor and click on the Object picker.            

    
	            
    Pick the object named Default from the scene.            

    
	            
        
Still in the new Segment node's Properties, change Alignment > Z to Pivot. This is to ensure that the glass and the seals and glazing bars align correctly. 
            [image: images/download/attachments/16744528/-1268770623.png]
    
     
            

    
	            
    We can use this node as a template to add the other geometry object. These will inherit the Alignment properties set in the previous step. To do this. right click on the new Segment and select Clone Multiple.            

                [image: images/download/attachments/16744528/-677451681.png]
        
	            
    A Select Objects window opens. Pick Bottom, Corner, LB Corner, Left Side, X Evenly and Y Evenly and then click Clone, RailClone will generate a new Segment node for each of the selected items.            

                [image: images/download/thumbnails/16744528/-677421861.png]
        

    

    
        Adding the Corners

            
    Before we attach the segments to the generator, note that we have four corners but only one segment. In this section we'll demonstrate how you can re-purpose geometry by using the Mirror operator to flip the left bottom segment to create the missing corners.            

    	            
    Wire the Segment name L B Corner to the LB Corner input of the generator.            

    
	            
    Create a new Mirror operator. Wire the L B Corner segment to the Mirror operator's input,  and then wire the Mirror operator's output to the RB Corner input of the generator. The mirror operator has flipped the segment on the X Axis.            

    
	            
    Next we'll create the top corners. Create a second Mirror operator and open the Properties panel. Change the Axis to Y.            

                [image: images/download/attachments/16744528/-676349322.png]
        
	            
    Wire the L B Corner Segment to the new Mirror operator, then wire the Mirror operator to the LT Corner input of the generator. The mirror operator has flipped the segment on the Y Axis.            

    
	            
    Create a third Mirror operator and open the Properties panel. Change the Axis to X and Y.            

                [image: images/download/attachments/16744528/-1979667999.png]
        
	            
    Wire the L B Corner Segment to the third Mirror operator, then wire the Mirror operator to the RT Corner input of the generator. The mirror operator has flipped the segment on the X and Y Axis, completing the corners. At this point your Node tree should look like this            

                [image: images/download/attachments/16744528/-1979666084.png]
        

    

    
        Adding the Sides

            
    Now we'll add a frame to the Top, Bottom left and Right of the glazing. Once again you'll use the mirror operator to re-use segments.            

                
                

    	            
    Wire the Segment named Left to the Left input of the generator.            

    
	            
    Create a new Mirror operator. Wire the Left segment to the Mirror operator and then wire the Mirror operator to the Right input of the generator.            

    
	            
    Wire the Segment named Bottom to the Bottom input of the generator.            

    
	            
    Create another Mirror operator and open the Properties panel. Change the Axis to Y.            

                [image: images/download/attachments/16744528/-676349322.png]
        
	            
    Wire the Bottom segment to the new Mirror operator, then wire the Mirror operator to the Top input of the generator. At this point your Node tree should look like this            

                [image: images/download/attachments/16744528/208383699.png]
                    
    You will have a frame running around the exterior of the array. In the next step we'll start to fill in the centre.            

                [image: images/download/attachments/16744528/208353908.png]
        

    

    
        Adding Evenly spaced segment on the X Axis

            
    Segments added to the X Evenly input are regularly positioned along the X axis of the array. Follow next few steps to use this to add vertical separators to the glazing style.            

    	            
    Wire the Segment named X Evenly to the X Evenly input of the generator. You'll see regularly space vertical appear in the array.            

    
	            
    To control the spacing between Evenly segments, select the Generator and go to Properties > Rules > X Evenly and enter a Distance value of 1m.            

                [image: images/download/attachments/16744528/209277460.png]
        
	            
    Ensure that Extend to Side is activated. This will ensure the the Evenly segments go to the edges of the array.            

                [image: images/download/attachments/16744528/1319897206.jpg]
        

    
            Extend to Side

        
            
    When the Extend to Side check-box is enabled for any of the X Evenly, Y Evenly or Inner Corner inputs, The geometry is extended the sides of the array cutting through any segments being used in the Left, Right, Top or Bottom inputs.            

                
                [image: images/download/attachments/16744528/209128541.png]
                    

        

    
    

    
        Adding Inner Corners

            
    Inner Corners in an A2S generator behave exactly like the Corner input of the L1S Generator. Both of these add geometry only on vertices of a specified type found on the path.  By default only Corner or Bezier-Corner vertices are used, but this can be changed in the Generator's properties.To add corners to our Glass Wall style:            

    	            
    Wire the Segment named Corner to the Corner input of the generator.            

    
	            
    Open the Generator's properties and ensure that Rules X > Corner > Extend to Side is activated. This will ensure the the corner segments go to the edges of the array.            

    
	            
    Turn on Bevel Corner and set the BC Offset value to 5%.            

                [image: images/download/attachments/16744528/210320118.png]
        

    
            BC Offset

        
            
    Bevel Corner Offset allows you to adjust the offset of the Corner segments. The distance is measured as a percentage of the length of the corner segment. positive values pull the segment towards the corner, negative values will move the segments away from the corner.            

        

    
    

    
        Creating Evenly spaced segments on the Y Axis

            
    Segments added to the Y Evenly input are regularly spaced along the Y axis of the array. Follow the next few steps to use this to add horizontal separators to the glazing style.            

    	            
    Wire the Segment named Y Evenly to the Y Evenly input of the generator. You'll see regularly space horizontal bars appear in the array.            

    
	            
    To control the spacing between Y Evenly segments, go to the Generator's Properties and enter a Y Evenly > Distance value of 2.5m.            

                [image: images/download/attachments/16744528/209277460.png]
        
	            
    Ensure that Extend to Side is unchecked. In this case we want to prevent the the Y Evenly segments from extending to the sides of the array.            

                [image: images/download/attachments/16744528/211184058.png]
        

    

    
        Adding Default segments

            
    Finally, we'll fill in the remaining gaps with the default segment.            

    	            
    Wire the Segment named Default to the Default input of the generator. You've now used all 12 inputs of the A2S generator to create an adjustable glazing style try experimenting with the Evenly distances to get different results. The final node tree should resemble the image below            

                [image: images/download/attachments/16744528/211899132.png]
        

    

    
        Adjusting Padding

            
    You may have noticed If you look closely at the style you'll that there are some unwanted gaps between the horizontal and vertical elements.            

                
                [image: images/download/attachments/16744528/211988382.png]
                    

                
    These gaps are caused by the rubber seal which extends beyond the metal frame. To correct this we need to add some padding values to the Vertical elements. For a more detailed explanation of padding, please see the chapter called How to align, overlap and transform geometry            

    	            
    Select the Left Segment and open the Properties. Enter a value of -0.007m for the Left Padding and Right Padding parameters.            

                [image: images/download/attachments/16744528/212107636.png]
        
	            
    Repeat this procedure for the X Evenly, L B Corner and Corner segments. The gaps will now be removed.            

    

    

    
        Rotate the Array

            
    This completes the style though it is currently flat on the ground plane. For a glazing style we need to rotate the entire mesh so that it is vertical. To do this:            

    	            
    Select the Generator and open the Properties.            

    
	            
    Enter a value of 90 degrees for the General > X Rotation parameter.            

                [image: images/download/attachments/16744528/-1211417586.png]
        
	            
    You can now try reshaping the spline to get different shapes of glazed wall.            

                [image: images/download/attachments/16744528/1095827888.png]
        

    

    

    
        Related Tutorials

            
                [image: images/static.itoosoft.com/img/tutorials/4687289340.jpg]
            
create_a_curtain_wall_building
                

                
    Create a curtain wall building            

                
    A further example of using the A2S array to create a curtain wall. In this example we do things slightly differently and use a Spline for both axes of the array, making it possible to create double-curved faades.            

                
                

                
                [image: images/static.itoosoft.com/img/tutorials/17390883370.jpg]
                

                
    Stadium Tutorial Part 5
            

                
    In the final part of the stadium tutorial we demonstrate how to use an A2S generator to create the roof. You'll learn how to create the style and also export attributes so that you can adjust the depth of the roof and spacing of the supports from the Modify panel            

                
                [image: images/static.itoosoft.com/img/tutorials/1310097402.jpg]
                

                
    Create a seaside promenade            

                
    In the last 2 parts of this tutorial we explain how to use the A2s generator to create a paving style and a huge sea wall using RailClone's formidable instancing power to create the geometry from individual bricks!            

                
                

        
            Documentation

        
            
    For more information please see the 2D arrays - Generator A2S section of the online documentation.            

        

    
            
                

                
                

                
                

                
                

        

        

    


    
        
            Techniques to deform geometry

        


        

        
            
                [image: images/download/attachments/16744559/-602306045.png]
                    

                
    One of the most powerful features of RailClone is the ability to deform geometry to follow a path. Segments can be set to follow the curvature of a spline on the X and Y axes, with a host of additional settings to control how geometry is deformed on the Z axis. In this chapter we'll explore the many modes available, starting with turning Bend Off.  Deforming geometry isn't always desirable, sometimes you want to ensure it retains its original shape. Take the traffic Barrier style illustrated below for example. In the top image the segment has bend turned on, as a result each segment is smoothly deformed to follow the base spline. It looks good, but this isn't how these barriers work in real-life. Instead we need the barrier segments to follow the spline without deforming, as in the bottom image.            

                
                [image: images/download/attachments/16744559/1153603536.png]
                    

                
                

        
        Exercise: Turning off Bend

            
    New Segments have the bend option enabled by default. In the majority of cases this is the correct behaviour, but to demonstrate how to turn Bend off, In this exercise you'll correct the barrier style used in the illustration above. Open the file called bend_slice.max and follow these steps:            

    	            
    Select rc_barrier_plastic, go to the Style rollout and click            

                [image: images/download/attachments/16744559/-1018095190.png]
                    
    to open the Style Editor.            

    
	            
    For each of the 3 Segments, go to Properties > Deform > Deform and turn off Bend.
            

                [image: images/download/attachments/16744559/-1017410058.png]
        
	            
    The Barrier will now follow the path correctly.            

    

    

    
        Exercise: Turning off Slice.

            
    Next to Bend in the interface, there's an option to Slice the segment. When this is turned off, RailClone cuts off the part of the last segment that falls outside of the path. In most cases this is the correct behaviour, but occasionally you'll want to turn this option off too. If you look at the the barrier style again, you'll see that the final Segment in the array is being sliced. In this instance, turning slice off gives us a much better result, though it's important to note that this does result in the segment extending beyond the end of the spline.            

                
                [image: images/download/attachments/16744559/481430964.png]
                

                
    To turn off Slice:            

    	            
    Make sure that rc_barrier_plastic is selected with the Style Editor is open.            

    
	            
    For each of the 3 Segments, go to Properties > Deform > Deform and turn off Slice.
            [image: images/download/attachments/16744559/-1016516266.png]
                

    
	            
    The Barrier style is now correct.            

    

            
                

        
            What to do if deformation is not smooth

        
            
    If the deformation of segments is jagged, this is often because the interpolation value of the spline being used as a base object is too low. Instead of editing the spline, RailClone provides a feature to improve smoothing by automatically adding additional interpolation steps. To use this feature open the Style rollout and increase the Curve Steps value until you get smoother results.            

        

    
    
            Optimising

        
            
    Segments which have been deformed or sliced are no longer instances and contribute to the overall polygon count. To create optimal renders disable Bend and Slice for all segments that don't need it.            

        

    
    

    
        Deforming on the Z Axis

            
    RailClone provides 3 additional options to to control how segments deform on the Z axis: Adaptive, Vertical and Stepped. To understand these modes in more detail, try the following exercise:            

        
        Exercise: Testing X Deform modes

            
    To illustrate how the modes work, open the file named z_deform_modes.max. This file contains a simplified style with a single segment. The geometry, shown below,  has been designed to make it clear how the 3 different modes affect the deformation.
            [image: images/download/attachments/16744559/-1015414003.png]
                    

                
    The yellow arrow helps to illustrate how the current deformation mode affects the vertical elements of the geometry, the red arrows illustrate how the current deformation mode affects the horizontal elements at the top and bottom of the geometry, and the Blue arrow illustrate how the deformation mode affects the horizontal elements in the middle of the geometry.            

    	            
    To test the modes. select the RailClone object called rc_z_modes, go to the Style rollout and click            

                [image: images/download/attachments/16744559/-1018095190.png]
                    
    to open the Style Editor.             

    
	            
    Select the segment and and go Properties > Deform > Deform.            

    
	            
    Follow the steps below to activate each of the modes. After each one, scrub the timeline.  The base spline is animated so you can see how the deformation reacts to the changing shape of the path.            

    

    
        Adaptative

            
    In this mode , the segment's verticals (yellow arrows) are aligned perpendicular to the path; while the horizontal elements (red and blue arrows) follow the path.            

                
                [image: images/download/attachments/16744559/-1180149300.gif]
                    

                
    To enable Adaptive deformation mode:            

    	            
    Change the Deform mode to Adaptive.            

    

    

    
        Vertical

            
    In this mode, the vertical elements (yellow arrows) remain upright, but the horizontal elements (blue and red arrows) are deformed on the Z axis to match the elevation of the path.            

                
                [image: images/download/attachments/16744559/-314152756.gif]
                    

                
    To enable Vertical deformation mode:            

    	            
    Change the Deform mode to Vertical.            

    

    

    
        Stepped

            
    In this mode, no deformations are applied in the Z axis, and the segment preserves its vertical alignment.            

                
                [image: images/download/attachments/16744559/-228901213.gif]
                    

                
    To enable Stepped deformation mode:            

    	            
    Change the Deform mode to Stepped.            

    

            
    In addition to these 3 modes, there are 2 additional hybrid modes that combine the Vertical and Stepped deformation algorithms.            

        

    
        Vertical mode with Flat Top/Flat Bottom

            
    In this mode the top and/or the bottom of a geometry is stepped (red arrows) while the areas in between follows the spline (blue arrows). The Top and Bottom values define the distance (on the Z axis) that the effect is applied, measured from the top or the bottom of the geometry.            

                
                [image: images/download/attachments/16744559/385318395.gif]
                    

                
    To enable Flat Top or Flat Bottom deformation mode:            

    	            
    Change the Deform mode to Vertical.            

    
	            
    Enter a distance in for the Flat Bottom value and/or enter a distance for the Flat Top value. In the example scene, a value of 0.8m works well.            

    

    

    
        stepped mode with Vertical Top/Bottom

            
    In this mode the top or bottom of a segment (red arrows) deform and follow the spline, leaving the middle area (blue arrows) stepped. The Top and Bottom values define the distance (on the Z axis) that the effect is applied, measured from the top or the bottom of the geometry.            

                
                [image: images/download/attachments/16744559/-1756001644.gif]
                    

                
    To enable Vertical Top or Vertical Bottom deformation mode:            

    	            
    Change the Deform mode to Vertical.            

    
	            
    Enter a distance in for the Vertical Bottom value and/or enter a distance for the Vertical Top value.            

    

    

    

    

    
        Related Tutorials

            
                [image: images/static.itoosoft.com/img/tutorials/-2209899620.jpg]
                

                
    Creating Stairs
            

                
    This tutorial looks at the different ways segments can be deformed on the Z-Axis. After explaining the deformation modes we explore how to put them to good use to create a straight and spiral staircase.            

                
                

        
            Documentation

        
            
    For more information please see the Segments section of the online documentation.            

        

    
            
                

                
                

                
                

        

        

    


    
        
            How to align, overlap and transform geometry

        


        

        
            
                [image: images/download/attachments/16744573/-989263439.png]
                    

                
    In this section we'll look at how to adjust the padding, alignment, and transform settings of a segment. This can be useful where you wish to reuse a segment multiple times but with different properties, add randomisation to the transforms, or adjust the spacing between adjacent segments.            

        
        Transforming Segments

    
        Fixed Transforms

            
    Once a segment is added to RailClone it's possible edit its rotation, translation and scale values from the Properties Panel. To access these options:            

    	            
    Select a Segment node (            

                [image: images/download/attachments/16744573/567309147.png]
                    
    ).            

    
	            
    Go to the Properties Panel.            

    
	            
    Go to the Transform tab. In the Fixed group (a) you'll see there are parameters that enable you to translate, rotate and scale the segment's geometry. Underneath this, the Random group (b) allows you to randomising these properties with in a range. You can try out these parameters by following the exercise in the next section.            

                [image: images/download/attachments/16744573/406654967.png]
        

    

    
        Exercise: Randomising Transforms

            
    In this section you'll learn how to randomise the position, rotation and scale of segments using roof slates as an example. To follow this procedure, download and open slate_tiles.max.            

    	            
    With slate_tiles.max open, select the RailClone object called rc_slates. The slate geometry is quite high poly so In the viewports this RC object is using Box display mode to help maintain viewport speed. As you can see the slate pattern currently has no variation.            

                [image: images/download/attachments/16744573/408650871.png]
        
	            
    we  can start adding some irregularity to this by randomising the tile's position.  Open the Style Editor and select the Segment node called Slate_002. Go to the Properties panel select the Transform tab and turn on Translation in the Random group. Each axis can be randomised independently by entering a Minimum and Maximum value, measured in scene units. In this example we'll enter a value of -10mm for the Translation > Y Min value, and a Y Max value of 25mm.            

                [image: images/download/thumbnails/16744573/596007153.png]
        
	            
    To randomise Rotation, activate Transform > Random > Rotation and enter Minimum value of -2 and Maximum value of 2 degrees the X and Y axes.            

                [image: images/download/thumbnails/16744573/573417281.png]
        
	            
    To randomise Scale, activate Transform > Random > Scale and enter Minimum value of 90 and a Maximum value of 120 for the X,Y and Z axes.            

                [image: images/download/thumbnails/16744573/1292281688.png]
        
	            
    For this style these changes in transform settings should affect the position of adjacent segments. To do this make sure that Transform Affects Size is left On. If you would like to use the size of the original segment before transforms, turn this setting off. The image below illustrates the render before and after randomisation.            

    

            
                [image: images/download/attachments/16744573/109519257.jpg]
        Top: no transform randomisation | Bottom:  with transform randomisation (exaggerated)            

                
    
            

        

    
        The Transform Operator

            
    Instead of adjusting the transform values from the Segment node's properties, it is also possible to use a Transform operator to access the same settings.This can be useful if you want to change multiple segments that are attached to a Sequence, Compose, Randomise, Selector, or Conditional operator. Using the Transform operator can save you from having to enter the same information multiple times and makes updating your styles much quicker and easier. The basic procedure for using the Transform operator is as follows:            
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    Wire a node to the Transform operators input.            

    
	            
    In the Transform nodes properties, activate any settings you wish to use by clicking on the appropriate check-box. This will override the values set in the Segments own properties.            

    
	            
    Connect the Transform operator's output to a generator or another operators input.            

    

    

    

    
        Segment Padding

            
    Each segment has a length and height extracted from the bounding box of the source geometry. This dimension is used to control how the segment will be positioned alongside others in the array. For some geometry this may produce undesirable results, as the bounding box will always be determined by the largest part of the mesh. For example, load the segment_padding.max exercise file. In this scene is a relatively simple pipe preset that uses bolted collars for the corner and evenly inputs. If you look closely at the style you'll notice there are some unwanted gaps:            
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    Unwanted gaps in the Pipe style            

                
    This is cause by the bolts, as they define the size of the bounding box, pushing the pipes away from the connector and causing a gap:            

                
                

                
                [image: images/download/attachments/16744573/-2114258398.png]
                    

                
    The 3 segments used in the Pipe style and their bounding boxes (in yellow). Note how the bolts will prevent the pipes from properly connecting to the collar.             

                
    Fortunately RailClone includes a Padding parameter to compensate for this kind of geometry. This feature allows you to modify the default size, increasing or decreasing the distance between the segment and others to the left, right, top and bottom sides. To see how it works, let's prevent some leaks and correct this style so that the pipes meets the collar correctly.            

        
        Exercise: Editing Segment Padding.

	            
    Open segment_padding.max  and select rc_pipes.            

    
	            
    Open the Style Editor and select the Segment node named pipe_cap1.            

    
	            
    Go to the Properties Panel and enter a value of -2cm for the Left and Right padding. The gap between the collar and the pipe will close up.            

                [image: images/download/attachments/16744573/624599162.png]
        

    

    

    
        Generator Padding

            
    Generators can also use padding values to offset the entire array. These are used to add offsets to the left, right, top and bottom of A2S generators, or the start and end of L1S generators. All calculations, such as evenly spacing, are based on the new lengths of the array after the offset has been applied. This is particularly useful for situations where you need multiple generators to jigsaw together, as we'll see in the following example of a window inside a surround.            

        
        Exercise: Editing Generator Padding

	            
    Open the file named generator_padding.max.            

    
	            
    Select the object called rc_window. At the moment only the surround is displayed.            

                [image: images/download/attachments/15696396/2083003958.png]
        
	            
    To see the window, open the style editor and and find the generator called Window. This generator has been disabled. To enable it, click on the check-box found in generator's top right hand corner.            

                [image: images/download/attachments/16744573/-1226575914.png]
        
	            
    This style has one generator to create the surround and another for the window, Both generators use the same length values to determine their size on the X and Y Axes. Because of this the window on the frame overlap.            

                [image: images/download/attachments/16744573/-1225860927.png]
        
	            
    To prevent the window from overlapping the outer surround, padding is added to the top, bottom, left and right of the generator. To do this click on the Window generator and go to the Properties Panel. Select the Limits tab and enter a value of 193mm for the Left and Right padding, 145mm for the Top padding, and 90mm for the Bottom padding.            

                [image: images/download/attachments/16744573/-1225741795.png]
        
	            
    The window now sits neatly inside the surround. Close the Style Editor and adjust the size from the Parameters rollout, you'll notice that the offset remains constant irrespective of the size of the surround. Also of note, this style uses Evenly Count mode to ensure that the amount of vertical and horizontal elements remains the same as the window is resized.            
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        Related Tutorials

            
                [image: images/static.itoosoft.com/img/tutorials/12239619820.jpg]
                

                
    Random Books Tutorial            

                
    This tutorial explains how to use the Random Transform feature to create books of different sizes and introduce some chaos to their distribution. In this tutorial you will also learn how to use the Randomise operator to randomly select geometry from a number of segments.            

                
                [image: images/static.itoosoft.com/img/tutorials/182035481.jpg]
                

                
    Masonry Wall
            

                
    The Masonry Wall tutorial makes good use of padding values to compensate for the overhang of the cap to the top of the pillars. This tutorial is intended for new users of RailClone, and provides a thorough introduction to some of the most commonly used features. By completing this exercise you will be able to use the built in library, understand the style editor, and easily create new styles.            
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    Parquet Floor Tutorial            

                
    This tutorial explains how to model parquet floors from individual planks. The 2D array generator is used throughout and provides an excellent way to create a wide variety of floor patterns using only a single enclosed spline to define the boundary. The planks are made to fit together correctly and make 3 different patterns by editing their padding values. Also of note is the Floor library that ships with RailClone. You can study these styles to learn more ways to create floors.            

                
                [image: images/static.itoosoft.com/img/tutorials/17390883370.jpg]
                

                
    Stadium Tutorial Part 2,3, and 4
            

                
    The stadium tutorial uses a number of L1S arrays to create advertising hoarding, seating and the crowd. Padding, alignment and transform randomisation is used throughout to create the seats, crowds, and flags.            
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    Create a seaside promenade            

                
    Parts 2 and 3 of this tutorial use Padding values extensively to ensure that the segments fit together correctly.            

                
                

        
            Documentation

        
            
    For more information please see the Segments, 2D arrays - Generator A2Sand 1D arrays - Generator L1S sections of the online documentation.            

        

    
    

        

    


    
        
            How to combine, select and sequence geometry
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    Once segments have been added to a style, operators allow you to apply all kinds of modifications. For example you can use them to mirror a segment, combine multiple segments to create a new composite object, create patterns, randomise geometry or material IDs, and much more. In this introductory guide we will focus on operators that enable you to sequence, select, and combine segments, if you would like to see the full range of operators, including instruction for use, check out the full documentation.            

        
        Operators that select segments

            
    Let's start by looking at two operators that allow you to select from a number of segments. The most literal version of this is the Selector operator. This allows you to choose from a list of segments using a numerical index. This index can be adjusted manually from inside operators properties or it can be wired to a numerical node to be edited from the modify panel without requiring you to open the style editor. The operator also has an alternate mode the derives the index number from the material ID assigned to a spline segment.            

                
    Secondly we'll look at the Randomise operator, this returns a random Segment from the list of inputs. Each segment has a presence value that determines the probability of it being selected.            

                
    To explore this and the next few operators let's create a brick wall style. The final geometry looks like this:            
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    This style is constructed using these segments:            

                
                [image: images/download/attachments/16744593/-514773738.png]
                    

                
                

                
    To get started, open the file name operators_1.max. To make things easier there's already a RailClone object in the scene and all the segments have been added for you. To ensure the pieces fit together correctly, padding values have been added to the Wall Default, Wall Start, and Wall Pier segments. If you need to review padding, please see Chapter 11. To add operators and create the rest of the style, follow these steps:            

        
        Exercise: Create and randomise the wall

	            
    Select the RailClone object called rc_wall.            

    
	            
    Go to the Style rollout and click            

                [image: images/download/attachments/16744593/-513075652.png]
                    
    to open the Style Editor.  As well as all the segments you'll find two generators that share a spline. The top generator is used to create the main wall and the second generator adds the capping. As mentioned previously, it is often easier to break the style across multiple generators.            

                [image: images/download/attachments/16744593/-512926699.png]
        
	            
    Let's start with the wall, create a new Randomise operator and wire it to the Wall and Pillars Generator's default input. We'll use this to add some variation to the wall geometry.            

    
	            
    Wire the segment named Wall Default to the Randomise operator's first input.            

    
	            
    There isn't actually any additional geometry for the wall's default input, so we'll create variation by using mirrored clones of the existing brick segment. To do this, create a new Mirror operator by dragging from the Items list to the Construction View.            

        
            Mirror Operator

        
            
    This operator makes a mirror copy of a segment's geometry using any combination of the X,Y, or Z axes as a mirror plane.            

        

    

	            
    Wire the Wall Default segment to the Mirror operator's input,  then wire the Mirror operator to the second input of the Randomise operator.            

    
	            
    Click on the Mirror operator, go to the Properties panel and change the Mirror plane from X to Y.            

                [image: images/download/attachments/16744593/-512062729.png]
        
	            
    We can now Copy and Paste this operator to create 2 more variations. To do this, right click on the node and select Copy, then right click again and select Paste.            

    
	            
    Select the new Mirror operator, Change the mirror plane from Y to Z and wire the output to the third input of the Randomise operator.            

    
	            
    Copy and paste the Mirror operator a final time and change the axis to Y and  Z. Wire this mirror node to fourth input of the Randomise operator. The node tree should look like this:            

                [image: images/download/attachments/16744593/-511168943.png]
        

    

    
        Exercise: Allow the user to select the cap type

            
    In this section we'll use the Selector operator to create a style that gives the use the choice of two caps for the wall. Carry on from the previous exercise and follow these steps:            

    	            
    Drag a new Selector operator from the Items list to the Construction View.            

    
	            
    Wire the segment called Wall Capping 01 to the Selector operator's first input.            

    
	            
    Wire the Segment called Wall Capping 02 to the Selector operator's second input.            

    
	            
    Wire the Selector operator to the Cap generator's Default input. The node tree should look like this:            

                [image: images/download/attachments/16744593/-1971581562.png]
        
	            
    To switch between the cap types, click on the Selector node and go to the Properties panel. From here you can change the Index to select from the two cap types.            

                [image: images/download/attachments/16744593/-996296771.png]
        
	            
    Though this works, it's not ideal to have to open the Style editor to change the Index value. To make it possible to change the value from the Modify panel, you can export the Index value and attach a Numeric node. To do this, Right click on the Selector node and choose Export Parameters > Index            

                [image: images/download/attachments/16744593/-996207432.png]
        
	            
    Create a new Numeric node from the Items List and wire it to the newly exported Index input on the Selector node.            

                [image: images/download/attachments/16744593/-1971796447.png]
        
	            
    Finally, click on the Index node and go to the Properties Panel. Turn on limits and enter a Minimum  value of 1 and a Maximum value of 2. This is to ensure that you can only pick one of the 2 attached cap segments.            

    

            
    You now have a wall with randomised segments for the default section and a choice of two cap types. To finish the style we need to add the piers and the start and ends of the walls.            

        

    

    
        The Compose operator

            
    The Compose operator enables you to build a new geometry object by attaching several segments together. When combined the segments are distributed side-by-side along the X Axis. At first sight, the Compose operator is functionally similar to the Sequence operator that we'll examine in the next section, but the Compose operator will enable you to wire multiple segments to an input that normally would only accept a single segment such as the Start, End Corner and Evenly inputs of the L1S array, or the Corners, Inner Corner, Sides and X Evenly inputs of the A2S array.            

        
        Exercise: Using the Compose operator

            
    In our wall example the Compose operator will be used to combine a brick pier and the pieces required to terminate the walls. The image below illustrates these segments in the order they will need to appear for the Corner and Evenly inputs. For the start and end inputs only two of the 3 segments are required.            
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    To add a brick pier at the Start:            

    	            
    Create a new Compose operator by dragging it from the Items List to the Construction View.            

    
	            
    Wire the Wall Pier segment to the Compose Operator's first input.            

    
	            
    Wire the Wall Start segment to the Compose Operator's second input. (Remember the segment values have already been added to ensure the segments dovetail together correctly)            

    
	            
    Wire the Compose operator to the Wall and Pillars Generator's Start input.            

    

            
    To add a brick pier at the End:            

    	            
    Create a second Compose operator by dragging it from the Items List to the Construction View.            

    
	            
    Wire the Wall End segment to the Compose Operators first input.            

    
	            
    Wire the Wall Pier segment to the Compose Operators second input. Note that this is the reverse order of the Compose used for the start input            

    
	            
    Wire this Compose operator to the Wall and Pillars Generator's End input.            

    

            
    To add a pier at regular intervals and Corners:            

    	            
    Create a third Compose operator by dragging it from the Items List to the Construction View.            

    
	            
    Wire the Wall End segment to the Compose Operators first input.            

    
	            
    Wire the Wall Pier segment to the Compose Operators second input.            

    
	            
    Wire the Wall Start segment to the Compose Operators third input.            

    
	            
    Wire this Compose operator to the Wall and Pillars Generator's Evenly and Corner inputs. The finished node tree will look like this:            

                [image: images/download/attachments/16744593/-1971713803.png]
        

            
    If you look at the caps now, you'll notice that they go through the brick pillars. This is because they run to the end of the spline, whereas the low brick wall is offset by the pillars. We can add an Empty segment with a fixed size to the Caps generator to compensate for the size of the pillars and push the capping sections away from the ends, corners and evenly segments in the style. In addition, in this section instead of entering the size of the pier manually, we'll export the X Size attribute of the Pier segment and use this value to automatically create the correct spacing. To do this:            

        
        
            
    An empty or null segment contains no geometry of its own but can be very useful for adding spaces to the array.            

        

    
	            
    Wire the Null segment to the Cap generator's Start, End, Corner, and Evenly inputs.            

    
	            
    Right click on the Null segment and select Export Parameters > Fixed Size > Fixed Size > X
            [image: images/download/attachments/16744593/-993407047.png]
                

    
	            
    Right Click on the Wall Pier segment and select Export Attributes > Size > X            

                [image: images/download/attachments/16744593/-993377188.png]
        
	            
    Wire the Wall Pier Segment's X Size output to the Null segment's X Fixed Size input.            
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    The final node tree looks like this ...            
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    ...which creates this style:            
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        The Sequence operator

            
    The Sequence operator creates patterns of segments by cycling through the list of inputs, starting at the top of the list and working downwards. Each segment can be repeated using a simple counter, when the counter reaches its limit, RailClone moves on to the next item in the list. When the sequence reaches the end of the list, it starts again from the beginning. Unlike the compose operator, a sequence can increment on either the X or Y axis and a sequence can be reset at either the start of each spline or the start of a new section.            

        
        
            
    In RailClone a section is defined as a length of path found between two segments of the Start, End, Corner, or Evenly type            

        

    
            
    To illustrate this operator we'll recreate the pattern found on a piano Keyboard. This style uses the six segments illustrated below. To save time these have already been added to a RailClone style and padding values have been added to ensure that the keys fit together correctly.            
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        Exercise: Using the Sequence operator to create a piano keyboard

	            
    Open the file named sequence_piano_start.max and select the RailClone object from the scene called rc_piano.            

    
	            
    Go to the Style rollout and click            

                [image: images/download/attachments/16744593/-513075652.png]
                    
    to open the Style Editor. As you can see the segments for all the keys have already been added to the style.            

    
	            
    To create the pattern, add a new Sequence operator by dragging it from the Items list to the Construction View.            

    
	            
    Wire the Sequence operator to the Generator's Default input.            

    
	            
    Wire the key Segments to the Sequence operator in the following order (from the top-down)            

    	            
    C/F            

    
	            
    Flat/Sharp            

    
	            
    D            

    
	            
    Flat/Sharp            

    
	            
    E/B            

    
	            
    C/F            

    
	            
    Flat/Sharp            

    
	            
    G            

    
	            
    Flat/Sharp            

    
	            
    A            

    
	            
    Flat/Sharp            

    
	            
    E/B            

    


	            
    The final node tree will look like this:            

                [image: images/download/attachments/16744593/-1942892919.png]
        

            
    That's it! - This sequence operator creates the repeating 12 note pattern found on a piano. The sequence operator is ideal for creating regular and repeating patterns on the X or Y axis.            
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        Related Tutorials

            
                [image: images/static.itoosoft.com/img/tutorials/12239619820.jpg]
                

                
    Random Books Tutorial            

                
    This tutorial explains how to use the Randomise operators to select from 11 book segments.            
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    Parquet Floor Tutorial            

                
    The chevron and herringbone patterns both use Compose operators to create their patterns. Follow these tutorials to see another way to use the Compose operator.            

                
                [image: images/static.itoosoft.com/img/tutorials/17390883370.jpg]
                

                
    Stadium Tutorial Part 5
            

                
    Part 5 of the Stadium tutorial uses Randomise and Mirror to create an audience with flags.            
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    Create a seaside promenade
For a similar usage of the Compose operator as seen in the Brick wall example on this page, check out the balustrade example explained in the Seaside Promenade tutorial.            

        
            Documentation

        
            
    For more information please see the Operators and Exporting Parameters sections of the online documentation.            

        

    
            
                

                
                

        

        

    


    
        
            Next steps
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    Congratulations! You've reached the end of Getting Started with RailClone. If you followed this guide and completed the exercises, you should now have a good understanding of the principles that underpin RailClone's approach to procedural modelling, You'll be able to to load and adapt presets from the library, create your own 1d and 2d arrays, and use operators to modify segments.            

                
    To continue to get the most out of RailClone, we have a number of additional resources to help you develop your skills further.            

        
        Tutorials

            
    We release regular tutorials that range from explanations of basic concepts, to advanced topics and demos of possible applications for RailClone. We've suggested relevant tutorials throughout the guide but to see the full list, check out the tutorials page. Come back regularly, we're adding new content all the time!            

        

    
        Intermediate guide

            
    We'll shortly be releasing the Intermediate Guide to RailClone. Once you've completed the Getting Started guide, this is intended as the next step. We'll build on the foundation you've learned here and introduce topics such as modelling tips for RailClone, wiring parameters, dealing with material ids, using surfaces, clipping splines, spacing modes, creating conditional relationships and much more. This will be followed by an Advanced Guide that's focused on writing Arithmetic Expressions.            

        

    
        Documentation

            
    For a thorough explanation of all of RailClone's features, including procedures for many common operations, take a look at the Documentation.            

        

    
        Gallery

            
    Get inspiration from some of the excellent work submitted to our gallery, and if you create an outstanding image or animation with RailClone (or Forest Pack) we'd love to see it. We're always on the look out for high quality material to feature on our gallery     
and     
social media    
, so if you have work you think meets the brief, please send your renders to     
submission@itoosoft.com    
, or upload them to our     
forum    
. Well share them on our networks with full credit and links to your website.     
            

                
        
We hope you enjoy using RailClone and wish you the very best with your work. If you have any feedback, queries or suggestions please let us know.
    
            

                
        

    
            

        

        

    


    
        
            Styles

        


        

        
            
        [bookmark: 10092632_Styles-top]
            

        
        Overview

            
    RailClone objects create geometry based on a series of construction rules called Styles. RailClone Pro comes with an expanding library of over 280 styles including fences, railings, barriers, theatre seating, facades and much more.            

                
    Existing styles can be modified, and new styles created from scratch using the Style Editor. In addition, styles can be easily copied between RailClone objects for re-use.            

                
    To generate a renderable mesh, Styles may need several inputs. As a minimum, a single spline is required to create a path for the geometry, but more complex styles may require multiple items to be selected. In RailClone these are called Base Objects and the options to select and control them can be found in the rollout of the same name.            

                
    Some Styles may also have values editable directly from within 3DS Max, eliminating the need to open the style editor to make changes. These settings can be found under the Parameters Rollout.            

        

    
        Procedures

    
        To use a predefined style

	            
    Create a new RailClone object by going to the Create Panel>Geometry>iToo Software and selecting RailClone. Click and drag in the viewport, a "RC" icon will appear to denote a new blank RailClone object.            

    
	            
    Go to the Modify Panel. To choose a preset go to the Style rollout and click on the box marked "None" to open the Library Browser.            

                [image: images/download/attachments/10092632/105170267.jpg]
        
	            
    Select a style and either double click, right click and select Use Item(s) or press the button marked Import Selected.            

    
	            
    In the Base Objects rollout identify the spline in the scene you wish to use as a path by selecting the Base Object and clicking a spline from the scene. You should now have a finished RailClone object.            
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        To use a custom style

	            
    Create a new RailClone object as above.            

    
	            
    Go to the Modify Panel. In the Style rollout click on the Open Style Editor button            

                [image: images/www.itoosoft.com/img/railclone2/ref/-373453464.png]
            
Open Style Editor button
                
    .            

    
	            
    In the Style editor create a new Style. As a minimum you will require a Linear 1S Generator, a Segment and a Spline object to create a working style(see image). Find out more about creating styles in the Style Editor reference and tutorials pages.            

                [image: images/download/attachments/10092632/-1001465222.png]
        
	            
    Close the Style Editor, Go to the Base Objects rollout, highlight and pick a spline in the scene you wish to use as a path.            

    

    

    
        To select the base objects used by the current style

	            
    With a RailClone object selected, Right click in the viewport and click Select RailClone Base Object.            

                [image: images/download/attachments/10092632/896345376.png]
                    
                

    
	            
    If a style only uses a single base object it will automatically be selected. If it uses multiple base objects, a dialog will open allowing you to choose the one to select.            

                [image: images/download/attachments/10092632/896434746.png]
                    
                

    

    

    
        To select a segment used by the current style

	            
    With a RailClone object selected, Right click in the viewport and click Select RailClone Segment.            

                [image: images/download/attachments/10092632/896494364.png]
                    
                

    
	            
    If a style only uses a single segment it will automatically be selected. If it uses multiple segments, a dialog will open allowing you to choose the one to select.            

                [image: images/download/attachments/10092632/896494421.png]
                    
                

    

    

    
        To smooth a jagged deformation

	            
    Sometimes you will find that the interpolation value of the spline being used as a base object is too low, causing the deformation of segments to look jagged. RailClone has a feature that enables the smoothing of splines by adding additional interpolation steps.            

                [image: images/download/attachments/10092632/412691890.png]
                    
                

        
        
            
    Max has a limit of 100 interpolation steps but RailClone allows much higher values. This can be useful for smoothing splines that are physically very large in the scene but generate geometry that is seen close-up in the renders, for example an animation tracking along a road.info            

        

    

	            
    In the Style setting increase the Curve Steps value until you get the desired results.            

    
	            
    If nothing changes you may need to convert the spline from a line to a curve, this is often the case with certain spline primitives such as the Helix. Select the spline in the viewport and add an Edit Spline Modifier.            

    
	            
    Go the the spline sub object level, Ctrl+A to select all, right click on the spline and change the type to Curve. The spline should now smooth in RailClone using the Curve Steps parameter as expected.            

    

    

    
        To copy a style from an existing RailClone object

	            
    Select the RailClone object you wish to copy to.            

    
	            
    From the Style menu press the Copy Style From button            

                [image: images/download/attachments/10092632/234875134.png]
                    
    .            

    
	            
    In the vieport click on the RailClone object with the style you wish to copy.            

    

    

    
        To copy a style to an existing RailClone Object


	            
    Select the RailClone object with the style to be copied.            

    
	            
    From the Style rollout press the Copy Style To button            

                [image: images/download/attachments/10092632/1014768847.png]
                    
    .            

    
	            
    Select the target RailClone object.            

    

            
    Alternatively if want to copy the style to more than one RailClone Object:            

    	            
    From the Style rollout press the Copy To Multiple button            

                [image: images/download/attachments/10092632/-1520273793.png]
                    
    .            

    
	            
    A selection window will open, select the RailClone objects you wish to apply the style to.            

    
	            
    Press the Copy To button.            

    

    

    

    
        Interface

            
                [image: images/download/attachments/10092632/1445707963.png]
                    

        
        Style operations

            
                [image: images/download/attachments/10092632/-373453464.png]
         Opens the Style Editor. Use it to define the segments and construction rules of a RailClone Style.            

                
                [image: images/download/attachments/10092632/1014768847.png]
         Copy the current style to another RailClone object.            

                
                [image: images/download/attachments/10092632/-1520273793.png]
         Copy the current style to multiple RailClone objects, selecting them by name from a list.            

                
                [image: images/download/attachments/10092632/234875134.png]
         Get the style from another RailClone object by picking it from the scene.            

        

    
        Geometry

            
    The Geometry section contains a set of general parameters that affect the segments and base objects of the current RailClone style. These settings are independant of the Style used and are not affected if it is modified or a new one loaded.            

        
        Global Scale

            
    Scale the full object by the specified value.            

        

    
        Curve Steps

            
    By default RailClone uses the Steps value of the splines used as reference. Use this parameter to modify the path's smoothness. It accepts values greater than 100, which is the limit in Max splines.            

        

    
        Surface Interp.

            
    This value can be adjusted to improve deformation when using a surface, especially when using very large splines. The value defines the distance between vertices created to conform the spline to the surface,  decreasing this value will improve the accuracy of deformation. (Default = 5cm)            

        

    
        Simple Y Offset

            
    Standard Y-Offset uses a sophisticated algorithm to compute Y-Offset paths, but in some cases does not generate the expected result. Simple Y-Offset provides an alternative algorithm that may resolve these problems. Enable this mode if you get distorted geometry when using standard Y-Offset.            

        

    
        Vertex Weld

            
    Welds all vertices that fall within the threshold setting. It works like the Max weld feature, but is considerably faster because it is only applied between adjacent segments. This feature is not compatible with the VRay/Mental Ray shader.            

        

    
        Free Object

            
    When enabled, RailClone ignores the spline's position but is still deformed by its shape. This mode allow you to move the RailClone geometry freely in the scene, or to create instanced objects without needing to clone and relocate multiple copies of the base spline.            

        

    
        Operate On

            
    Specifies whether to perform the geometric operations: using the triangular faces or the polygonal facets. Change this mode if you get geometry artifacts, for example in the sliced segments.            

        

    

    

        

    


    
        
            General Settings

        


        

        
            
        [bookmark: 10092626_GeneralSettings-top]
            

        
        Overview

            
    The parameters in this rollout control the global settings for the plugin and provide access to the help files and updates.            

        

    
        Procedures

    
        To see information and debug a RailClone object:

	            
    Go to the General rollout and press the Show Object Statistics button (            

                [image: images/download/attachments/10092626/740381856.png]
                    
    )            

    
	            
    A dialog box will appear with details of the number of segments, build time and speed, viewport display mode, and any error messages that are preventing the object from building correctly.            

                [image: images/download/attachments/10092626/-334325249.png]
        

    

    

    
        Interface

            
                [image: images/download/attachments/10092626/-16640396.png]
                    

        
        Random Seed

            
    Railclone has a number of parameters that can be randomised. When these are activated this number is used to initialise a pseudorandom number generator. Changing this value will give you different results, useful if you want to reuse a RailClone object in the same scene but with variations.            

                
                [image: images/download/attachments/10092626/-1717106552.jpg]
                    

                
    In this image the same RailClone object is used for both facades but a different Random Seed value creates variations in the lit rooms.            

        

    
        Icon Size

            
    This property determines the size of the icon displayed in the viewport in the event that RailClone cannot create geometry. When creating a new RailClone object clicking and dragging in the viewport sets this property. Use this value to adjust after creation.            

        

    
        Help

            
    Launches your default web browser and opens the RailClone help reference on the iToo Software website.            

        

    
        Update

            
    Manually activates a check to verify that RailClone is up-to-date and downloads the newer version if necessary. This process is also carried out automatically once per week.            

        

    
        Show Object Statistics

            
    Opens a modal window displaying information about the RailClone object. This can be left open while adjustments are made to the style or base objects. The following data will be displayed:            

                
    Segments: The number of segments.
Build Time: The time taken to build the geometry measured in milliseconds.
Build Speed: The number of segments that can be generated per second.
Display Mode: The mode used to display the RailClone geometry in the viewports.
Error Message: Displays an error message in the event that the object cannot be built.            

        

    

        

    


    
        
            Style Editor

        


        

        
            
        [bookmark: 10092634_StyleEditor-top]
            

        
        Overview

            
                [image: images/download/attachments/10092634/241067205.png]
                    

                
    RailClone is designed to help artists create sophisticated reusable parametric models using an easy-to-understand node based editor. RailClone combines, deforms and distributes meshes known as Segments along one or more Base Reference splines according to construction rules defined using Generators and Operators. The interplay of these three parts is called a Style and is created using the Style Editor.            

                
                

                
                

                
                

        

    
        The Style Editor Interface

            
                [image: images/download/attachments/10092634/606918370.png]
                    

                
    The Style Editor window is divided into 5 sections:            

        
        1. The Menu Bar

            
    Most of the functions found in the Menu Bar are accessed more easily from the tool bar or right-click menu, but a few features, such as the ability to save and restore scene views, and the Style Editor Preferences are only found here.            

        

    
        2. The Tool Bar

            
    The Tool Bar provides buttons for regularly used functions. Float the tool bar by clicking and dragging in the hatched area to the left.
            [image: images/download/attachments/10092634/-883550531.png]
                    

        

    
        3. The Properties Editor

            
    The Properties Editor allows you to view and alter the parameters of the selected node. The effects will be updated in real-time in the 3DS Max viewport.            

        

    
        4. The Items Panel

            
    The Items Panel lists the node types available for use when designing a new style. To add a new item, simply drag it from the item list to the Construction View.            

        

    
        5. The Construction View

            
    The Construction View is used to create Style rule sets by wiring together generators, objects, operators, and parameters. Once a node is created in the construction view, its variables are accessible in the Property Editor            

        

    

    
        Nodes

            
    Styles are created by wiring together different nodes. In order to function, a style must contain at least one Generator, Segment and Base Object, but many more types are available. Though many nodes have sophisticated parameters, the interface in the Construction View is simple and consistent.
            [image: images/download/attachments/10092634/701167684.png]
                    

                
    The components that can be found on a node are as follows:            

                
    1. Icon indicating the type of node.
2. Input sockets.
3. Node name. This can be changed in the properties editor.
4. Collapse or expand sockets.
5. Output sockets.
6. Change order up/down. Some nodes allow multiple inputs, if that's the case these arrows change the order in which the inputs are processed.            

        

    
        Procedures

    
        To add a new node to the Construction view

            
                [image: images/download/attachments/10092634/-1897025961.gif]
                    

                
    Adding a new node            

    	            
    Identify the node type in the Items list on the right hand side of the style editor, select and drag it into the Construction View.            

    

    

    
        To rename a node

	            
    Select the node in the Construction View            

    
	            
    In the Properties Editor type a new value in the name field.            

    

    

    
        To connect nodes

            
    Connecting nodes            

                
    Either            

    	            
    Click on the input socket of a node, drag the mouse (you'll see a wire following the mouse pointer) and release over the output node of another            

    

            
    Or            

    	            
    Click on the output socket of a node, drag the mouse and release over the input node of another.            

    

    
        
            
    A single output slot can be connected to multiple inputs.            

        

    
            
                

        

    
        To connect multiple nodes

            
    Multiple nodes can be attached to Compose, Sequence, Random, and Selector operators. To do this:            

    	            
    Select the nodes you wish to attach.            

    
	            
    Drag any of the nodes outputs to the operator's input.            

    

    

    
        To disconnect nodes

	            
    Click on the output slot of a node and drag to a empty area of the Construction View. Any nodes connected to the slot will be released.            

    

    

    
        To collapse and expand nodes

            
    Collapsing and expanding nodes            

                
    Either            

    	            
    To collapse a node, click on the small upward facing arrow on the right of the title bar            

    
	            
    Once a node is collapsed, to expand it again click on the small downward facing arrow on the right of the title bar            

    

            
    Or            

    	            
    Use the keyboard shortcut CTRL+X to expand and CTRL+L to collapse            

    

            
    Or            

    	            
    Click on the Expand(            

                [image: images/download/attachments/10092634/1080315577.png]
                    
    ) or Collapse(            

                [image: images/download/attachments/10092634/108201996.png]
                    
    ) node buttons from the toolbar.            

    

    

    
        To automatically select a nodes children

	            
    Hold down Alt+Click on any node to automatically select its children.            

    

    

    
        To swap the connections for two nodes

            
                [image: images/download/attachments/10092634/-1257831170.gif]
                    

    	            
    Drag the output of a node 1 to the output of node 2. Their connections will swap.            

    

            
                

        

    
        To export a node's parameters

            
    Exposing property slots            

                
    Any numerical parameter can be exposed as an input slot and wired to Parameter Nodes.            

    	            
    Right click on the node, select node>Export> and choose the parameter to be exposed.            

    
	            
    The exposed property will be added to the bottom of the list of input slots.            

    

    

    
        To clear all exported parameters

	            
    Right click on the node and select Export Parameters > Clear All.            

    

    

    
        To export a node's attributes

            
                [image: images/download/attachments/10092634/-1767863663.png]
                    

                
                

                
    The size of a segment can be exported from any node. To do this:            

    	            
    Right click on a node, select Export Attribute and choose the parameter to be exported.            

    
	            
    The exposed attributes will be added to the bottom of the list of output slots.            

    

    

    
        To clear all exported Attributes

	            
    Right click on the node and select Export Attributes> Clear All.            

    

            
                

        

    
        To change the order of input slots

            
    Changing input order            

    	            
    Click on the name of the input slot you wish to move            

    
	            
    Click on the up or down arrows to the right of the slot name to change the order            

    

            
    This is possible on the Sequence, Randomize, Sequence, and Arithmetic nodes only            

                
                

        

    
        To copy nodes

	            
    Click on Copy             [image: images/download/attachments/10092634/1131780948.png]
     from the tool bar or right click the selection and pick Copy.            

    
	            
    Paste the node by clicking Paste             [image: images/download/attachments/10092634/737062548.png]
     on the tool bar or right-click anywhere in the Construction View and select Paste.            

    

    

    
        To Undo and Redo the previous action

	            
    Click Undo             [image: images/download/attachments/10092634/1132315843.png]
     from the toolbar or right-click and select Undo.            

    
	            
    Click Redo             [image: images/download/attachments/10092634/1132217821.png]
     from the toolbar or right-click and select Redo.            

    

    

    
        To update a Segment from the source geometry

            
    Do one of the following.            

    	            
    Click Reload Segments            

                [image: images/download/attachments/10092634/1434841528.png]
                    
    from the tool bar.            

    
	            
    Go to Menu>Segments>Reload.            

    

    

    
        To extract a Segment from Railclone

	            
    Select the segment node you wish to extract.            

    
	            
    Click the Extract Segment To A New Object             [image: images/download/attachments/10092634/-865767358.png]
     button from the tool bar or go to Segments>Extract from the menu.            

    
	            
    The segment will be created in the scene at its original coordinates.            

    

    

    
        To disable nodes

            
    Either            

    	            
    Toggle on and off by clicking on the small black cross in the top right hand corner of any node.            

    

            
    Or            

    	            
    Turn on and off the selected node using the Enable button (            

                [image: images/download/attachments/10092634/1070634402.png]
                    
    ) or Disable button (            

                [image: images/download/attachments/10092634/2110830249.png]
                    
    ) from the toolbar.            

    

    

    
        To add a description to a style

	            
    From the Style dropdown menu at the top of the style editor, click            

                [image: images/download/attachments/10092634/-1470942416.png]
                    
    top open the Style Description window.            

    
	            
    Enter a description, normally this will contain information for new users about how to use the style. You can also see a list of all the base object and parameters used.            

                [image: images/download/attachments/10092634/1638557210.png]
        
	            
    Click OK.            

    

            
    
            

        
            To set the description using MaxScript

        
            
    The style description can also be set using Maxscript. This can be useful where you need to create a description for multiple, similar styles.            

                
    To set the style description for a single selected object use:            

    

$.railclone.setStyleDesc("my style")




            
    To set the style description for multiple selected objects use:            

    

for obj in selection do (obj.railclone.setStyleDesc("my style") )




            
    To access the style description use:            

    

 $.railclone.getStyleDesc() 




    

    
            
    
            

                
                

        

    
        To view a style's description

	            
    In the modify panel, open the Style rollout and click            

                [image: images/download/attachments/10092634/-1471161089.png]
        
	            
    A dialog opens containing the style's description, including the base objects and parameters used.            

                [image: images/download/attachments/10092634/1638795630.png]
        

    

    

    
        Style Editor Preferences

            
    This menu allow you to control the default behaviour of the style editor, to open it go to Options>Preferences.            

                
    Rename Segments When Reloaded. When on a segments name will be overwritten with the mesh name when using the reload function. If off, a segments name is retained when using reload, useful if you've manually renamed your nodes.            

                
    Limit Zoom to. Allows you to set the maximum level of zoom possible when navigating the construction view.            

        

    
        Toolbar Reference

            
                [image: images/download/attachments/10092634/11323158430.png]
        Undo the previous step.            

                
                [image: images/download/attachments/10092634/11322178210.png]
         Redo the previous undo operation.            

                
                [image: images/download/attachments/10092634/11317809480.png]
         Copy the selected node or nodes to the clipboard.            

                
                [image: images/download/attachments/10092634/737062548.png]
     Paste the contents of the clipboard to the Construction View.            

                
                [image: images/download/attachments/10092634/1034024394.png]
         Delete the selected nodes.            

                
    The following options are used when there is a Segment node selected:            

                
                [image: images/download/attachments/10092634/1080315577.png]
         Expand the selected node (CTRL+X).            

                
                [image: images/download/attachments/10092634/108201996.png]
         Collapse the selected node (CTRL+L).            

                
                [image: images/download/attachments/10092634/10706344020.png]
     Enable the selected node (CTRL+E).            

                
                [image: images/download/attachments/10092634/21108302490.png]
     Disable the selected node CTRL+D).            

                
                [image: images/download/attachments/10092634/1434841528.png]
         Update all segments from the source objects. It works like applying the replace button for each segment with its object. If the source object was deleted from the scene this has no effect.            

                
                [image: images/download/attachments/10092634/-8657673580.png]
         Create a new object in the scene by extracting the geometry from the selected Segment. Use this option if you have deleted the source object of a Segment and want to restore it. The object is created at its original coordinates. RailClone uses it as the new source object, discarding references to the old one.            

        

    
        Types of Node

            
    RailClone includes several classes of nodes:            

        
        Generators

            
    Are the responsible for generating the geometry, according to a list of Segments, Base Objects and construction rules. An unique RailClone object can use multiple generators, allowing the creation of complex parametric objects.            

                
    Each type of generator is specialized in one task, for example linear or array objects. Click to see the description of each one of them: Linear 1S,Array A2S.            

        

    
        Objects

            
    This category includes elements which reference other objects in the Max scene. There are two categories: Segments and Base Objects.            

        
        Segment

            
    Segments are the basic mesh pieces used by RailClone to generate the object. See Segments reference for more information.            

        

    
        Base Object Spline

            
    A base object is any external object used as reference to distribute the segments, but that is not part of the geometry of RailClone. For example to define the path of a fence, we use a Spline.            

                
    Unlike other nodes, the properties of a base object are not defined in the Style Editor, but in the Path Base Objects rollout. For each base object in the style editor, there is a corresponding item in this list.
            [image: images/download/attachments/10092634/-1634202209.png]
                    

                
    Currently, Splines are the only type of base object included in RailClone, but other elements will be added in the future.            

        

    

    
        Parameters

            
    Parameters can be wired to exposed properties in other nodes. There are two types:            

    	            
    Constant is a single value that can be edited only from within the Style Editor.            

    
	            
    Numeric is adjustable both from within the Style Editor and also the parameters rollout in the Max Plugin.            

    

            
    See the Parameter reference for more information and procedures.            

        

    
        Operators

            
    Operators are used to modify the behaviour and properties of Segments. See Operators reference for details.            

        

    
        Others

            
    Includes other types of nodes that don't fit in the above categories:            

                
                [image: images/download/attachments/10092634/1021612352.png]
                    

        
        Note

            
    Use it to add a generic text note in the style editor. Text can be edited in the Properties panel.            

        

    

    

        

    


    
        
            1D arrays - Generator L1S

        


        

        
            
        [bookmark: 10092636_id-1Darrays-GeneratorL1S-top]
            

        
        Overview

            
                [image: images/download/attachments/10092636/-1738885240.png]
                    

                
    Generator L1S is one of two types of Generator included with RailClone. Generators use a set of construction rules that determine how to build the object. You can define which segments to use for each part of a spline, For L1S these options include: default, start/end, corners and evenly spaced. The segments are assigned by connecting a Segment node to the respective input in the generator's node.            

                
    Each type of generator is specialized in one task. L1S is used to create linear structures along a path, defined by a single Spline base object. It uses the following base objects, segments and rules.            

                
                [image: images/download/attachments/10092636/1351390774.png]
                    

    	            
    Spline (Optional): Uses a Spline input to identify the object in the scene to be used as the construction path. Alternatively, create an array without a spline by entering a value in the General > Geometry > X Size property.            

    
	            
    Clipping Area (Optional): Uses a single closed spline to cut through the RailClone object. Clipping splines can be set to include or exclude geometry.            

    
	            
    Surface (Optional): Uses a mesh object as a surface. When a Surface object is attached to segments will conform to the surface by projecting them along the RailClone object's Z Axis.            

    

            
    At least one of the following inputs must be used in order for the L1S generator to create geometry. The diagram at the top of this page demonstrates a typical style that uses all of these inputs.            

    	            
    Default: Used as the base mesh in the event that the other nodes have no inputs. If one of the following inputs is left empty, the segment wired to the default input will be used.            

    
	            
    Start: Creates a segment at the start of the path, as defined by the spline's original vertex numbers.            

    
	            
    Corner: Creates a segment at each of the intermediary vertices of the construction spline. Can be set to only create a segment on certain types of vertex i.e. corner. bezier-corner, bezier, smooth, or on all of these.            

    
	            
    Evenly: Creates evenly spaced segments along the contruction path.            

    
	            
    End: Create a segment at the end of the path as defined by the spline's original vertex numbers..            

    

    

    
        Procedures

    
        To create a basic L1S generator

            
    A L1S generator requires a spline to be used as the path and at least one mesh to construct the object. This procedure assumes these have been created in the scene.            

    	            
    Create a new RailClone object by going to Create>Geometry>Itoo Softwate>RailClone Pro and drag out a new RailClone object in the viewport.            

    
	            
    With the new RailClone object selected, go to the Style rollout and click on the Open Style Editor button            

                [image: images/download/attachments/10092636/-373453464.png]
        
	            
    Drag a new L1S Generator (            

                [image: images/download/attachments/10092636/509609346.png]
                    
    ) from the Items list to the Construction View            

    
	            
    The X axis of an L1S generator can be defined using a simple numerical dimension or by using any spline as a path. To use a dimension enter a value in the Geometry>X Size parameter, alternatively to use a spline, drag a new Spline Node (            

                [image: images/download/attachments/10092636/-1687591275.png]
                    
    ) to the Construction View and wire to the spline input of the L1S Generator
            [image: images/download/attachments/10092636/1307277869.png]
    
            

    
	            
    A new spline input will appear in the Base Objects rollout of the Max Plugin. Highlight this and from the properties section click on the spline name (will be None by default) and pick a spline from the scene. By default, all new base objects will be named spline. In the case of complex style with multiple inputs it is sensible to rename the nodes from the properties panel in the style editor, these names will be reflected in the Base Objects rollout.            

                [image: images/download/attachments/10092636/-949445996.png]
        
	            
    In the style editor create a new Segment Node (            

                [image: images/download/attachments/10092636/1338105673.png]
                    
    ) for each of the input slots you plan to use, remember that segment nodes can be wired to multiple inputs            

    
	            
    Wire the Segment Node output to the relevant L1S Node input. Below is an example that uses the same segment for multiple inputs.            

                [image: images/download/attachments/10092636/-1660937299.png]
        
	            
    For each Segment Node, go to Properties and select the Object to be used from the scene            

                [image: images/download/attachments/10092636/-115114105.png]
        
	            
    Adjust the Segmentsettings for each node to achieve the desired result            

    
	            
    Adjust the Generator's rules as appropriate, changes will be visible in real-time in the viewports. See the reference below for more information about the relevant settings.            

    

    

    
        Use a spline as a clipping area

            
    In RailClone it is possible to use an enclosed spline as a clipping area. This procedure assumes you already have a style and need to add this functionality.
            [image: images/download/attachments/10092636/1528070132.png]
                    

                
    A rectangular spline being used as a clipping area.            

    	            
    From the Style rollout open the Style Editor            

                [image: images/download/attachments/10092636/-373453464.png]
        
	            
    Add a new Spline Node (            

                [image: images/download/attachments/10092636/-1687591275.png]
                    
    )            

    
	            
    Wire the new Spline Node to the Clipping input node of an L1S generator            

                [image: images/download/attachments/10092636/239182333.png]
        
	            
    With the L1S Generator selected go to the Properties Editor and and set the Clipping Mode to include or exclude as desired.            

                [image: images/download/attachments/10092636/-1175282219.png]
        
	            
    Close the Style editor. Go to the Base Objects rollout in the 3DS Max plugin, select the clipping item from the list and choose the spline from the scene.            

    

    

    
        To add a surface to an L1S Array:

	            
    Drag a new Surface object to the construction View            

    
	            
    Wire the Surfaces output to the Surface input of an L1S Generator.            

                [image: images/download/attachments/11599892/1123462879.png]
        
	            
    From the Base Objects rollout, select the surface from the list then click the surface picker button and select a mesh object from the scene.            

                [image: images/download/attachments/11599892/1123465765.png]
                    
                

    

    

    
        To distribute evenly spaced segments based on distance.

	            
    Attach a new Segment Node to the Evenly slot of an L1S Generator            

    
	            
    In the Properties View, choose the segment you wish to distribute evenly by clicking the blank Object slot and picking from the scene.            

                [image: images/download/attachments/10092636/-115114105.png]
        
	            
    Select the L1S Generator go to Properties>Rules>Evenly and set the mode to  Distance            

    
	            
    Set the Distance value to determine the space between segments.            

                [image: images/download/attachments/10092636/1016629977.png]
                    
                

    
	            
    Change the Adjust to End setting to control the minimum length the remaining space at the end of a path can be before a new segment is added. This property is measured as a percentage of the Distance setting.            

    
	            
    Turn on Justify if you require the first space at the beginning and last space at the end of the path to be equal.            

    
	            
    Turn on Adaptive mode if you wish to equalise the spacing between all the evenly segments.            

    
	            
    If you are using Mirror to create two paths, turn on Sync Offset to maintain the same number of evenly spaced segments in both paths.            

    

    

    
        To distribute evenly spaced segments based on a fixed number of divisions.

	            
    Attach a new Segment Node to the Evenly slot of an L1S Generator            

    
	            
    In the Properties View, choose the segment you wish to distribute evenly by clicking the blank Object slot and picking from the scene.            

                [image: images/download/attachments/10092636/-115114105.png]
        
	            
    Select the L1S Generator go to Properties>Rules>Evenly and set the mode to Count.            

    
	            
    Set the Count value to determine the number of evenly spaced divisions to place along the spline.            

                [image: images/download/attachments/10092636/-1629773471.png]
                    
                

    

    

    
        To prevent clipping of segments at the start or end of the path

            
    It is possible to automatically scale segments so that they fill a path with only whole segments, avoiding clipping at the start or end. Assuming you already have a segment in the default input:            

    	            
    From the Generators properties, go to Rules>Default and set the mode to Adaptive.            

    
	            
    Set the Adaptive Percentage to control the minimum length of remaining space before a new segment is added (see the section below for a more detailed explanation).            

    

    

    
        To align a corner segment to the path

	            
    Open the Style Editor            

    
	            
    Select the L1S Generator you wish to apply this rule to.            

    
	            
    Go to Properties>Rules>Corner and turn on Align to Path.            

    
	            
    Alternatively, turn this property off to align the corner with the preceding segment.            

                [image: images/download/attachments/10092636/193213157.png]
                    
    The pillar on the right demonstrates Align to Path on, the left image shows the rule switched off            

    

    

    
        To create mirrored and offset geometry

	            
    Either adapt an existing RailClone style or Create a new L1S generator as described above            

    
	            
    In the Style Editor, select the L1S Generator you wish to mirror            

    
	            
    Go to Properties>General>Geometry and turn on Mirror            

    
	            
    Use the Y Offset value to displace the geometry either side of the path.            

    
	            
    To flip the mirrored copy, turn on Flip B            

    
	            
    To flip the original copy, turn on Flip A            

    
	            
    If the style uses Evenly segments that do not correctly align, go to Properties>Rules>Evenly and turn on Sync Offset
            [image: images/download/attachments/10092636/-127606527.png]
                

                
    In this example mirror is used to position lamp posts either side of a street. In the top example Sync Offset is on, in the bottom example it is off            

    

    

    
        To create a style that places an object only on vertices of a designated type

	            
    Either adapt an existing RailClone style or Create a new L1S generator as described above.            

    
	            
    Open the Style Editor and attach a Segment Node to the Corner input of the L1S Generator            

    
	            
    In the L1S Generator go to Properties>Rules>Corner, choose the Vertex Type or types you wish to apply the segment to from the drop down list.            

                [image: images/download/attachments/10092636/-499961383.png]
        

    

    
        To create a style that uses several different corner objects based on vertex type

	            
    Either adapt an existing RailClone style or Create a new L1S generator as described above.            

    
	            
    Go to Properties>Rules>Corner>Vertex Type and set it to All            

    
	            
    For each different vertex type you wish to target, create a new Conditional Node with a segment wired to the True input slot            

                [image: images/download/attachments/10092636/107034524.png]
        
	            
    For each Conditional node, set the Properties>Vertex>Type to On and choose the Vertex Type from the drop down list.            

                [image: images/download/attachments/10092636/1926353072.png]
        
	            
    Wire the conditional nodes together in series, each Conditional node's output is wired to the False input of the following.            

                [image: images/download/attachments/10092636/-71183260.png]
        
	            
    Wire the final Conditional node to the L1S Generator's Corner input            

    

    

    
        To set a generator to use only spline segments with a designated material ID

	            
    With the L1S generator selected, go to Properties>Limits and turn on Material Id.            

    
	            
    Designate a Material ID Value. From the drop down list identify whether a segment is used by being either equal, lesser, greater, on not equal to this value.            

    
	            
    To change the Material ID of a spline segment add an Edit Spline modifier, select a segment and go to Surface Properties>Material>Set ID
            [image: images/download/attachments/10092636/1983192236.png]
    
            

    
	            
    If you see no effect, check the Generator's Rules>Defaul>Mode is set to Tile or Scale. Adaptive mode does not support Limit by Material ID.            

    

    

    

    
        Interface

    
        Spline

            
                [image: images/download/attachments/10092636/2093839349.png]
        This node defines the construction path along which segments are distributed. Though the node is created in the style editor, the spline object is selected from the Max plugin. This is to enable the easy reuse of a style without the need to repeatedly open the style editor. When assembling segments, RailClone aligns the X axis of each segment with this spline.            

                
    Changing the spline settings has an effect on all the segments attached to the generator, the spline settings are found under the General section in the Properties Editor.            

        
        X Size

            
    Allows you to build the RailClone object without the need to use a spline as a path. The X Size parameter defines the length of the X Axis in scene units.            

        

    
        Reverse

            
    Reverses the direction of the path. This has the same effect as applying a "Reverse" command to an editable spline.            

        

    
        Flatten Stepped

            
    Enable this option to automatically flatten the path in the positions where RailClone uses segments in Stepped mode. This feature is used to fix alignment issues that may appear with railings and sloped paths as demonstrated in the diagram below.
            [image: images/download/attachments/10092636/1176449476.png]
                    

        

    
        Mirror

            
    Creates a copy of the geometry at the opposite side of the path. Use it in combination with the "Y Offset" parameter to move the geometry an equal distance on the either side of the path on the Y axis.            

        

    
        Flip A/B

            
    Flips the RailClone geometry using the path as a mirror axis. A is the original object, and B is the copy created with the Mirror feature.
            [image: images/download/attachments/10092636/-345309116.png]
                    

                
    Double guardrail using Mirror, Offset Y and Flip B            

        

    
        Y Offset

            
    Applies the specified offset perpendicular to the path's direction.            

        

    
        Simple Y Offset

            
    Standard Y-Offset uses a sophisticated algorithm to compute Y-Offset paths, but in some cases does not generate the expected result. Simple Y-Offset provides an alternative algorithm that may resolve these problems. Enable this mode if you get distorted geometry when using standard Y-Offset.            

        

    
        Z Offset

            
    Translates the geometry the specified distance in the Z axis.            

        

    
        X Rotation

            
    Rotates the segments along the direction of the spline. This parameter has the same effect that Style->Geometry->Rotation, but only affects segments attached to the individual generator. This is useful when creating styles that use multiple generators. In this situation both values are added to get the total X rotation.            

        

    

    
        Clipping Area

            
    Uses a closed spline as a boundary region, using it to clip the geometry of the object. RailClone clipping is much more efficient that a 3DS Max boolean operation, and optimizes the instanced geometry when using the VRay/Mental Ray geometric shader.            

        
        Mode

            
    Defines the clipping mode: Include preserves the geometry inside the area, and Exclude removes the geometry inside the area.            

        

    
        Projection

            
    Clipping works in 2D, projecting the spline along the axis defined by this parameter (X,Y or Z in the local coordinates of the RailClone object).            

        

    

    
        Default

            
                [image: images/download/attachments/10092636/1550388294.png]
         If there are no other applicable rules, RailClone uses this segment by default. There are two operation modes: Tile and Scale.            

        
        Tile

            
    The segment is replicated along the path. RailClone applies the deformation parameters defined in the Segment properties, such as slicing the segment automatically to fit the path's length or applying the padding distances.            

        

    
        Scale

            
    In this mode, the default segments are scaled along the X axis to fit the distance between the initial and final positions of the path section. A section is defined by the start and end points of the spline unless a X-Evenly or corner segment is used to subdivide the path. When scale mode is active the bevel settings are greyed out.            

        

    
        Adaptive.

            
    Adaptive mode calculates the number of whole segments that would fit along a spline segment then scales them on the X axis to fill the available space. This mode generates complete segments, with no clipping at the start or end of a spline segment.            

                
    Adaptive Percentage: This value specifies the minimum length of remaining space (expressed as a percentage of the segments original size on the X axis), at which a new segment can be added. For example if a segments X-dimension is 1m and the spline length is 4.25m, the segment will fit into the distance 4 times (4 x 1m = 4m). The remaining space is 0.25m, therefore a new segment will be added if the Adaptive Percentage is set at or below 25%.            

                
    Count Mode: Scales a fixed number of segments to fit between the start and end positions of a path section. A section is defined by the start and end points of the spline unless a X-Evenly or corner segment is used to divide the path.            

                
    Count Parameter: Defines the number of segments to scale along the path when Count Mode is enabled.            

                
                

        
        
            
    It is possible to not assign a default segment. You can use this, for instance, to place objects evenly spaced along a spline (see "Evenly" section below), without any other segments between them.            

        

    
    

    

    
        Start

            
    Lets you to specify a segment for the start of the path.            

        
        
            
    Sometimes you would need to assemble several segments for each position, not only one piece. In this case, you can use a "Compose"operator, to join several elements in an unique segment.            

        

    
    

    
        End

            
    Works like the "Start" rule, but applied to end of the spline.            

        

    
        Corner

            
                [image: images/download/attachments/10092636/-1084713820.png]
                    

                
    This construction rule is applied on specified vertices of the path, to create corners and bevels. To create corners, you must assign a segment to the "Corner" connector on the generator's node, however to use the bevel features, no segment should be used.            

        
        Vertex Type

            
    It is possible to only add corner segments to vertices of a specified type. Thus parameter defines which vertex types will be used from the following values: "Corner or Bezier-Corner", "Corner", "Bezier-Corner", "Bezier", "Smooth" or All.            

        

    
        Align to Path

            
    Enable this option to create smooth transitions of the corner segment along the path's trajectory. When off, RailClone aligns the corner with the last segment of the spline.            

                
                [image: images/download/attachments/10092636/-458765202.png]
                    

        

    
        Fillet Radius

            
    Adjusts the path to create a rounded corner. The numeric parameter defines the radius of the fillet arc.            

                
                [image: images/download/attachments/10092636/-458765201.png]
                    

        

    
        Bevel Mode

            
    Creates beveled edges in the corners, slicing the geometry of the Default segment. If Bevel is disabled, RailClone bends the geometry of theDefault segment along the corner.            

                
    There are four Bevel modes available, which define the displacement of the segments before and after a bevel's edge.            

    	            
    Reset: Each segment is placed at its default position (defined by the Alignment and Padding values), without applying any displacement.            

    
	            
    Extend: Extends the geometry of the segments along the bevel, giving an appearance of continuity.            

    
	            
    Symmetric: Creates symmetrical geometries at both sides of the bevel's edge.            

    

    

    
        

    

    
        Offset

            
    Applies a global displacement to all segments along the spline. The value is defined as a percentage of the segment's size (from 0% to 100%).            

        

    
        Bevel Corner

            
    When active, bevels the segment attached to the corner input, slicing the geometry. If Bevel Corner is disabled, RailClone bends the geometry of the Corner segment around the corner.            

                
    The alignment of the geometry in relation to the Corner depends on the number of segments used in the Inner Corner input. The examples below explain how using a single, odd or even number of segments affects the alignment.            

        
        Segments used in this example:

            
    In the following examples these segments are used in the corner input. Where multiple segments are used, they are wired to a compose operator.            

                
                [image: images/download/attachments/10092636/1401643144.png]
                    

        

    
        Using a single corner segment

            
    When using a single segment in the corner input, the geometry is duplicated and a segment is placed on either side of the vertex. The position is adjusted to ensure that the full length, measured on the outside face and along the X axis, is maintained irrespective of the angle of the corner.            

                
                

                
                

                [image: images/download/attachments/10092636/-1529317265.png]
            

    
        Using an even number of corner segments

            
    Duplicates the segment immeditately before the center then places other segments on left/right depending on order in the compose operator. Using an even number of segments always creates an asymmetic composition.            

                [image: images/download/attachments/10092636/-645448047.png]
            

    
        Using an uneven number of corner segments

            
    Duplicates the center segment then places other segments on left/right depending on their order in the compose operator. Using an odd number of segments always creates a symmetrical composition.            

                
                

                
                [image: images/download/attachments/10092636/-644584047.png]
                    

        

    

    
        Bevel Corner Offset

            
    Allows you to adjust the offset of the Corner segments. Distance is measured as a percentage of the length of the corner segment. positive values pull the segment towards the corner, negative values will move the segments away from the corner. If a negative value is sufficiently large a gap will appear. The example below illustrates the effect of increasing the Offset value, bringing together and slicing the corner segments.            

                
                [image: images/download/attachments/10092636/242979147.png]
                    

                
                

        
        
            
    - The Bevel feature works better on straight lines and wide corner angles. You will get incorrect results on narrow angles or curved paths.
- In closed splines, it's not possible to adjust the segment displacement in the last corner, because it depends on the path's length.
- Bevel is not compatible with the Default segment in Scale mode.            

        

    
    

    

    
        Evenly

            
                [image: images/download/attachments/10092636/1442013909.png]
                    

                
    This construction rule lets you to add evenly spaced segments along the path. As always, you must assign a Segment to the respective connector in the generator's node.            

        
        Distance

            
    Defines the distance between the evenly segments, specified in scene units by the Distance parameter.            

        

    
        Count

            
    Defines a set number of evenly segments, specified by the value of the Count parameter.            

        

    
        Adjust to End (Distance Mode Only)

            
    This value specifies the minimum length (as a percentage of the distance parameter), at which a new even segment can be added.            

                
    For instance: using a value of 40% and Distance = 2m, RailClone adds new segments only if the length from the last evenly segment to the end is greater than 0.8m.            

        

    
        Justify (Distance Mode Only)

            
    When activated the first and last segment are equal, creating a symmetrical distribution.            

                
                [image: images/download/attachments/10092636/1504647388.png]
                    

        

    
        Adaptive (Distance Mode Only)

            
    Adaptive mode is used to ensure the spacing between Evenly segments is identical. This mode calculates the number of times the full Evenly distance can be distributed along the path then divides that number by the paths length to generate a new equalised spacing.            

        

    
        Reverse (Distance Mode Only)

            
    If Justify or Adaptive mode are both off, the space between evenly segments will be measured at precise intervals from the start of the array. Use the reverse option to start the evenly measurements from the end of the array.            

                
                [image: images/download/attachments/10092636/-2123657031.png]
                    

        

    
        Sync Offset

            
    When an Offset Y displacement is used, by default RaiClone computes the positions of the even segments on the offset path, using the Distance parameter. This may be a problem in mirrored objects over curved paths, because the segments are not aligned on both sides. With "Sync Offset" enabled, the plugin uses the base path (without Offset Y applied) to place the evenly segments, and then translates the positions to the offset path, solving this issue.            

                
                [image: images/download/attachments/10092636/-1962956299.png]
                    

                
                

        

    

    
        Limits

            
                [image: images/download/attachments/10092636/1444099279.png]
                    

                
    Sometimes it is necessary to combine several generators in an unique RailClone object, applying each one of them to certain parts of the spline. These limits are defined here.            

        
        Material ID

            
    Applies the generator only to the spline's segments with the material ID specified. To define a material ID in a spline, use Editable Spline->Sub-object Segment->Surface Properties->Material.            

        

    
        Padding

            
    Adds an offset to the Start and End of the generator. All calculations, such as evenly spacing, are based on the new length of the array after the offset has been applied.            

        
            Limit by Material ID not working

        
            
    Occasionally when using the Limit by Material ID option of a generator to restrict geometry to a particular section of a spine, it is generated incorrectly. This is often caused by using Adaptive mode, found in the splines Interpolation roll-out, which can scramble the material IDs. If this issue occurs, simply turn off Adaptive mode to restore the correct behaviour.            
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            2D arrays - Generator A2S
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        Overview
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    A facade created using the A2S Generator            

                
    The A2S generator is one of two types of Generator included with RailClone. A2S creates a 2D array based on dimensions provided numerically, or by using splines as paths. When the latter is used complex double curved geometry is possible.            

                
    Generators use a set of construction rules that determine how segments are combined to build parametric objects. The interplay of generators, segments, base objects and rules is called a style. Because RailClone is fully procedural, simply changing the base objects or parameters will update every component referenced in the current style. The video below demonstrates a simple facade that uses an A2S generator controlled by two splines.            

                
    The A2S generator has a number of possible input segments. These are listed below with a short explanation. Click on a name to read the full reference.            

    	            
    X Spline: Uses a Spline input to identify the object in the scene used to determine the X axis of the array.            

    
	            
    Y Spline:Uses a Spline input to identify the object in the scene used to determine the Y axis of the array.            

    
	            
    Clipping Area: Uses a single closed spline to cut through the RailClone object. Clipping splines can be set to include or exclude geometry.            

    

            
    It is possible to generate an A2S style without splines using the X and Y size properties of the generator. However, at least one of the following inputs must be used in order for the A2S generator to create geometry. The diagram below demonstrates how these segments are used to construct the facade in the example at the top of this page.            

                
                [image: images/download/attachments/10092638/1461427694.png]
                    

                
    This diagram explains the different node slots used to create the facade above.            

    	            
    Default: Used as the base mesh in the event that the other nodes have no inputs. If one of the following inputs is left empty, the segment wired to the default input will be used.            

    
	            
    Left Side:Creates segments along the Y axis on the left side of the 2D array.            

    
	            
    Right Side: Creates segments along the X axis on the right side of the 2D array            

    
	            
    Top Side: Creates segments along the X axis at the top of the 2D array            

    
	            
    Bottom Side: Creates segments along the X axis at the top of the 2D array            

    
	            
    Inner Corner: Creates a column of segments at each of the intermediary vertices of the construction spline. Can be set to only create a segment on certain types of vertex i.e. corner. bezier-corner, bezier, smooth, or on all of these.            

    
	            
    Left Top, Right Top, Left Bottom and Right Bottom Corners:Allows you to position a segment in each of the four corners of a 2d array.            

    
	            
    X Evenly: Creates evenly spaced columns.            

    
	            
    Y Evenly: Creates evenly spaced rows.            

    

    

    
        Procedures

            
                

        
        To create a new A2S Generator

	            
    Create a new RailClone object by going to Create>Geometry>Itoo Software>RailClone Pro and dragging out a RailClone object in the viewport.            

    
	            
    With the new RailClone object selected, go to the Style rollout and click on the Open Style Editor button (            

                [image: images/download/attachments/10092638/-373453464.png]
                    
    )            

    
	            
    Drag a new A2S Generator (            

                [image: images/download/attachments/10092638/244910387.png]
                    
    )into the construction view            

    
	            
    Though it is possible to use the A2S generator without base objects, in this example we will use two splines to define the X and Y path of the 2D array            

    
	            
    Drag two Spline objects into the construction view and wire them to the X Spline and Y Spline input slots of the A2S node.            

                [image: images/download/attachments/10092638/1884778745.png]
        
	            
    Rename each spline node so that its purpose is clear in the Base Objects rollout, if necessary add a description that will be used as a custom tooltip.            

                [image: images/download/attachments/10092638/1100153022.png]
        
	            
    In 3DS Max Create two new editable splines, one to define the path for the width of the array, and another for the height.            

    
	            
    Go to the Base Objects rollout of the RailClone object. Click on each item in the list and select one of the splines you just created.            

                [image: images/download/attachments/10092638/483548548.png]
        

            
    Once you've defined the array dimensions it's time to add some segments as described in the following procedures.            

        

    
        To add sides, corners, and default segments

            
    It is possible to add separate segments for the top, bottom, left and right sides as well as each of the corners. As few or many of these inputs can be used, there is no requirement for every input slot to be occupied. In the event that a slot is empty the default segment will used if one has been connected.            

    	            
    With the RailClone object selected, open the Style Editor (            

                [image: images/download/attachments/10092638/-373453464.png]
                    
    ) from the Styles rollout.            

    
	            
    From the Items List Drag a new Segment object (            

                [image: images/download/attachments/10092638/1565351274.png]
                    
    )for each input you wish to use to the construction view. In this example we'll use the Default and Bottom slots so we'll need two nodes.            

    
	            
    Connect each segment node to a corresponding input as in the image below.            

                [image: images/download/attachments/10092638/1614689308.png]
        
	            
    For each segment, go to the properties editor, click on the object selector and pick your geometry from the scene.            

                [image: images/download/attachments/10092638/1785675744.png]
        
	            
    Adjust padding, alignment, deformation and transforms as required. See the Segments reference for more information.            

    

    

    
        To prevent clipping of segments at the start or end of the path

            
    It is possible to automatically scale segments so that they fill a path with only whole segments, avoiding clipping at the start or end. Assuming you already have a segment in the default input:            

    	            
    From the Generators properties, go to Rules>Default and set the mode to Adaptive.            

    
	            
    Set the Adaptive Percentage to control the minimum length of remaining space before a new segment is added (see the section below for a more detailed explanation).            

    

    

    
        

    

    
        To distribute evenly spaced segments on the X/Y axis based on distance.

	            
    With a RailClone object selected, open the Style Editor (            

                [image: images/download/attachments/10092638/-373453464.png]
                    
    ) from the Style rollout.            

    
	            
    Create a new A2S Generator (            

                [image: images/download/attachments/10092638/244910387.png]
                    
    ) as described above.            

    
	            
    Drag a new Segment object to the construction view for each unique geometry item you wish to use.            

    
	            
    Wire the new segments to either of the X Evenly or Y Evenly nodes.            

                [image: images/download/attachments/10092638/-1501811175.png]
        
	            
    Select the A2S generator node and go to Properties>Rules>X Evenly/Y Evenly. Set the Mode to Distance and use the Distance parameter to adjust the spacing between the rows or columns. (marked 1 on the following image)            

    
	            
    Enter the Adjust to End parameter (marked 2 on the image). This value determines the threshold at which a new row or column is added in the start and end spaces based on a percentage of the Distance, entered in the previous step. For example, if the Distance is 10 metres and the Adjust to End percentage is 50%, a new row of segments will be added only when the final space is greater than 5 metres.            

                [image: images/download/attachments/10092638/1423636066.png]
        
	            
    If you would like to equalise the first and last space of the evenly distributed segments, turn on Justify.            

    
	            
    Turn on Adaptive mode if you wish to equalise the spacing between all the evenly segments.            

    
	            
    If you would like the evenly spaced segments to continue to the edges of the array interrupting the sides, top or bottom, turn on the Extend To Side option.            

    

    

    
        To distribute evenly spaced segments on the X/Y axis based on a fixed number of divisions.

	            
    With a RailClone object selected, open the Style Editor (            

                [image: images/download/attachments/10092638/-373453464.png]
                    
    ) from the Style rollout.            

    
	            
    Create a new A2S Generator (            

                [image: images/download/attachments/10092638/244910387.png]
                    
    ) as described above.            

    
	            
    Drag a new Segment object to the construction view for each unique geometry item you wish to use.            

    
	            
    Wire the new segments to either of the X Evenly or Y Evenly nodes.            

                [image: images/download/attachments/10092638/-1501811175.png]
        
	            
    Select the A2S generator node and go to Properties>Rules>X Evenly/Y Evenly. Set the Mode to Count and set  the Count parameter to determine the number of evenly spaced divisions to place along the spline.            

                [image: images/download/attachments/10092638/1443145942.png]
                    
                

    
	            
    If you would like the evenly spaced segments to continue to the edges of the array, interrupting the sides, top or bottom, turn on the Extend To Side option.            

    

    

    
        To create an A2S array without the need for splines

	            
    Create a new RailClone object and open the Style Editor (            

                [image: images/download/attachments/10092638/-373453464.png]
                    
    ).            

    
	            
    Drag a new A2S Generator (            

                [image: images/download/attachments/10092638/244910387.png]
                    
    ) from the items list to the construction view.            

    
	            
    Do not create spline nodes, there is no need if you are creating a simple flat 2D Array.            

    
	            
    Drag a new segment node from the Items List to the Construction View for each input you wish to use as described above.            

    
	            
    To create the array, select the A2S generator node and go to Properties>General>Geometry>X Size to set the width.            

    
	            
    Next Go to Properties>Geometry>Y Size to the height.            

                [image: images/download/attachments/10092638/1267840625.png]
        
	            
    The array will be created on the XY plane of the world axis. Since it is not bound to any spline, if you need to rotate it simply use the Select and Rotate tool in the usual fashion.            

    

    

    
        Use a spline as a clipping area

	            
    From the Style rollout open the Style Editor (            

                [image: images/download/attachments/10092638/-373453464.png]
                    
    )            

    
	            
    Add a new Spline node (            

                [image: images/download/attachments/10092638/-1687591275.png]
                    
    )            

    
	            
    Wire the new Spline node to the Clipping input node of an A2S generator            

                [image: images/download/attachments/10092638/239182333.png]
        
	            
    With the A2S Generator selected go to the Properties Editor and and set the Clipping Mode to Include or Exclude as desired.            
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    Close the Style editor. Go to the Base Objects rollout in the 3DS Max plugin, select the clipping item from the list and choose the spline from the scene.            

    

    

    
        

    

    

    
        Interface

    
        X/Y Spline

            
    Defines the X and Y dimension and shape of the array. It is possible use the A2S generator without splines at all, in that case RailClone builds the array along the local X/Y axies, and the dimensions are defined by the X/Y Size parameters.            

        
        
            
    It is not necessary to align the Y spline in 3D space. Just create it on any XY plane, RailClone gets the origin and extent of the spline automatically, using the local X/Y vertex positions. Z is ignored.            
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    Vault parametric structure defined by X/Y splines            

                
    
            

        

    
        Geometry

    
        X/Y Size

            
    Defines the size of the array when there are no X/Y Splines assigned (see above).            

        

    
        Y Mode

            
    The A2S generator can work in two different modes: Aligned and Free.            

                
    In Aligned mode, all segments along the Y path are scaled to maintain the same alignment as on X. Alternatively, free mode creates independent rows on Y, so each segment keeps its original size.            

                
    Each mode uses a different algorithm, so this parameter may generate very different results for the same Generator. When using Free mode you cannot use a Y Spline, the extent in this direction must be explicitly defined by the Y Size parameter.            
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        Y Offset

            
    Moves the RailClone object the specified value perpendicularly to the path's direction.            

        

    
        Simple Y Offset

            
    Standard Y-Offset uses a sophisticated algorithm to compute Y-Offset paths, but in some cases does not generate the expected result. Simple Y-Offset provides an alternative algorithm that may resolve these problems. Enable this mode if you get distorted geometry when using standard Y-Offset.            

        

    
        Z Offset

            
    Displaces the geometry the specified value on the Z axis.            

        

    
        X Rotation

            
    Rotates the segments along the direction of the X spline. This parameter has the same effect that Style->Geometry->Rotation, but can be controlled intependantly for each to the generator. This is particularly useful if you are using multple generators in a single style. When using local and global rotations, both values are added to get the total X rotation.            

        

    
        Slope

            
    Rotates the array around the X Spline but does not affect the segments themselves, creating a stepped appearance. Angles are limited between 0 and 70 degrees.            
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        Clipping Area

            
    Uses a closed spline as a boundary region, using it to clip the geometry of the object. RailClone clipping is much more efficient that a 3DS Max boolean operation, and optimizes the instanced geometry when using the VRay/Mental Ray geometric shader.            

        
        Mode

            
    Defines the clipping mode: Include preserves the geometry inside the area, and Exclude removes the geometry inside the area.            

        

    
        Projection

            
    Clipping works in 2D, projecting the spline along the axis defined by this parameter (X,Y or Z in the local coordinates of the RailClone object).            
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    Clipping area            
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        Default

            
    If there are no other applicable rules, RailClone uses this segment by default. There are two operation modes: Tile and Scale.            

        
        Tile

            
    The segment is replicated along the X and Y path. RailClone applies the deformation parameters defined in the Segment properties, such as slicing the segment automatically to fit the path's length or applying the padding distances.            

        

    
        Scale

            
    In this mode, the default segments are scaled along the X axis to fit the distance between the initial and final positions of the path section. A section is defined by the start and end points of the spline unless a X-Evenly or corner segment is used to subdivide the path. When scale mode is active the bevel settings are greyed out.            

        

    
        Adaptive.

            
    Adaptive mode calculates the number of whole segments that would fit along a spline segment then scales them on the X axis to fill the available space. This mode generates complete segments, with no clipping at the start or end of a spline segment.            

                
    Adaptive Percentage: This value specifies the minimum length of remaining space (expressed as a percentage of the segments original size on the X axis), at which a new segment can be added. For example if a segments X-dimension is 1m and the spline length is 4.25m, the segment will fit into the distance 4 times (4 x 1m = 4m). The remaining space is 0.25m, therefore a new segment will be added if the Adaptive Percentage is set at or below 25%.            

                
    Count Mode: Scales a fixed number of segments to fit between the start and end positions of a path section. A section is defined by the start and end points of the spline unless a X-Evenly or corner segment is used to divide the path.            

                
    Count Parameter: Defines the number of segments to scale along the path when Count Mode is enabled.            

                
                

        
        
            
    At present Adaptive mode only functions on the X axis, the Y axis will be clipped as though the mode is set to Tile            

        

    
            
                

        

    

    
        Inner Corners

            
    Defines the segments to be used on the intermediary vertices of the base spline.            

        
        X Corner

            
    This construction rule is used to create a column of segments on specified vertices of the X path.            

        

    
        Vertex Type

            
    Describes the type of vertices that will use this rule from the following values: "Corner or Bezier-Corner", "Corner", "Bezier-Corner", "Bezier", "Smooth" or All.            

        

    
        Align to Path

            
    Enable this option to create smooth transitions of the corner segment along the path's trajectory. When off, RailClone aligns the corner with the last segment of the spline.            

        

    
        Extend to Side

            
    When on the corner segments will extend to the full height of the array, cutting through any segments that are in the Top and Bottom inputs. When off the Top and Bottom rows are continuous.            
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        Fillet Radius

            
    Adjusts the path to create a rounded corner. The numeric parameter defines the radius of the fillet arc.            

        

    
        Bevel Mode

            
    There are four Bevel modes available, which determine the displacement of the Default segments before and after a bevel's edge.            

    	            
    Reset: Each segment is placed at its default position (defined by the Alignment and Padding values), without applying any displacement.            

    
	            
    Extend: Extends the geometry of the segments along the bevel, giving an appearance of continuity.            

    
	            
    Symmetric: Creates symmetrical geometries at both sides of the bevel's edge.            

    

            
                [image: images/download/attachments/10092638/2079944950.png]
                    

                
    Symmetric Bevel            

        

    
        Offset

            
    Applies a global displacement to all segments along the X path. The value is defined as a percentage of the segment's size (from 0% to 100%).            

                
    - The Bevel feature works better on straight lines and wide corner angles. You would get incorrect results on narrow angles or curved paths.
- When using closed splines, it's not possible to adjust the segment displacement for the last corner, because it is dependent on the path's length.
- Bevel is not compatible with the Default segment in Scale mode.            

        

    
        Bevel Corner

            
    When active, bevels the segment attached to the corner input, slicing the geometry. If Bevel Corner is disabled, RailClone bends the geometry of the Corner segment around the corner.            

                
    The alignment of the geometry in relation to the Corner depends on the number of segments used in the Inner Corner input. The examples below explain how using a single, odd or even number of segments affects the alignment.            

        
        Segments used in this example:

            
    In the following examples these segments are used in the corner input. Where multiple segments are used, they are wired to a compose operator.            
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        Using a single corner segment

            
    When using a single segment in the corner input, the geometry is duplicated and a segment is placed on either side of the vertex. The position is adjusted to ensure that the full length, measured on the outside face and along the X axis, is maintained irrespective of the angle of the corner.            
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        Using an even number of corner segments

            
    Duplicates the segment immeditately before the center then places other segments on left/right depending on order in the compose operator. Using an even number of segments always creates an asymmetic composition.            
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        Using an uneven number of corner segments

            
    Duplicates the center segment then places other segments on left/right depending on their order in the compose operator. Using an odd number of segments always creates a symmetrical composition.            
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        Bevel Corner Offset

            
    Allows you to adjust the offset of the Corner segments. Distance is measured as a percentage of the length of the corner segment. positive values pull the segment towards the corner, negative values will move the segments away from the corner. If a negative value is sufficiently large a gap will appear. The example below illustrates the effect of increasing the Offset value, bringing together and slicing the corner segments.            
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    - The Bevel feature works better on straight lines and wide corner angles. You will get incorrect results on narrow angles or curved paths.
- In closed splines, it's not possible to adjust the segment displacement in the last corner, because it depends on the path's length.
- Bevel is not compatible with the Default segment in Scale mode.            

        

    
    

    

    
        Evenly

    

    
        X/Y Evenly

            
    This construction rule lets you to add evenly spaced segments along the X and Y paths.            

        
        Distance

            
    Defines the distance between the evenly segments, specified in scene units by the Distance parameter.            

        

    
        Count

            
    Defines a set number of evenly segments, specified by the value of the Count parameter.            

        

    
        Adjust to End

            
    This value specifies the minimum length (as a percentage of the Distance parameter), at which a new evenly spaced segment can be added.            

                
    For instance: using a value of 40% and a Distance of 2m, RailClone only adds new segments if the length from the last even segment to the end of the spline is greater than 0.8m.            

        

    
        Justify

            
    Centers the evenly spaced segments on the path, making the first and last spaces equal.            

        

    
        Adaptive

            
    Adaptive mode is used to ensure the spacing between Evenly segments is identical. This mode calculates the number of times the full Evenly distance can be distributed along the path then divides that number by the paths length to generate a new equalised spacing.            

        

    
        Reverse

            
    If Justify or Adaptive mode are both off, the space between evenly segments will be measured at precise intervals from the start of the array. Use the reverse option to start the evenly measurements from the end of the array.            
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        Extend to Side

            
    When enabled, extends the evenly segments to the sides of the array cutting through any segments being used in the Sides, Top or Bottom inputs.            
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    Array using Left/Right sides and X/Y Evenlies (green piece). Extend parameter is X:off, Y:on            

        

    

    
        Left/Right/Top/ Bottom Sides

            
    Defines the segment for each one of the sides of the array structure. This rule has no adjustable parameters, just connect the side segment to the input in the generator's node.            

        

    
        LT/RT/LB/RB Corners

            
    Defines the segments to be used at the corners of the 2D array. The abbreviations stand for Left Top, Right Top, Left Botton and Right Bottom corners respectively.            

        

    
        Limits

            
                [image: images/download/attachments/10092638/1444992982.png]
        Sometimes it is necessary to combine several generators in an single RailClone object, applying each one of them to different parts of the same spline. This is achievable using Limits which are defined here.            

        
        Material ID

            
    Only applies the generator to the spline's segments with the material ID specificied. To define a material ID in a spline, use Editable Spline>Sub-object Segment>Surface Properties>Material.            

                
                

        

    
        Padding

            
    Adds an offset to the left, right, top and bottom of the generator. All calculations, such as evenly spacing, are based on the new lengths of the array after the offset has been applied.            

                
                

        
            Limit by Material ID not working

        
            
    Occasionally when using the Limit by Material ID option of a generator to restrict geometry to a particular section of a spine, it is generated incorrectly. This is often caused by using Adaptive mode, found in the splines Interpolation roll-out, which can scramble the material IDs. If this issue occurs, simply turn off Adaptive mode to restore the correct behaviour.            
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            Segments

        


        

        
            
        [bookmark: 10092640_Segments-top]
            

        
        Overview

            
    Segments are the basic pieces of geometry that are assembled to build a RailClone object. You can assign any object from the scene that has polygonal geometry (a mesh) as a Segment. Once assigned, the segment's geometry becomes part of the RailClone object and you can handle it at the sub-object level (when its node is selected in the Style editor). The original geometry can be deleted once assigned because RailClone stores an internal reference to its mesh.It works in a similar way to 3DS Max's compound objects (such as Boolean), working in "Instance" mode.            

                
    The segment node allows you to control the following parameters, click on a heading for the related reference material or follow the procedures for instructions on how achieve specific results.            

    	            
    Padding. Allows you to adjust the default size used to calculate the position of adjacent segments            

    
	            
    Fixed Size: Allows you to specify a size for the segment in scene units. Works in two modes. In Calculation Mode the segment's geometry remains unchanged and dimensions affect only the positioning of adjacent segments. Or Scale mode where the segment's geometry is rescaled.            

    
	            
    Alignment. Controls how the segment is aligned to base objects.            

    
	            
    Deformation. Controls how a segment bends along the base object path and the vertical distortion to create vertically aligned, stepped and adaptive effects.            

    
	            
    Mapping. Provides the ability to use box mapping across a number of adjacent segments, creating seamless, unbroken textures.            

    
	            
    Transforms. Set either fixed or randomised rotate, transform, and scale parameters for segments.            

    

    

    
        Procedures

    
        To add geometry

	            
    Create a new Segment Object (            

                [image: images/download/attachments/10092640/1565351274.png]
                    
    )by dragging from the Items List to the Construction View.            

    
	            
    Go to the Properties Editor and click on the Object picker.            
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    Select the geometry you wish to use from the scene.            

    
	            
    Wire the Segment node to an appropriate Operator or Generator input            

    

    

    
        To add multiple segments

	            
    Create a new Segment Object (            

                [image: images/download/attachments/10092640/1565351274.png]
                    
    )by dragging from the Items List to the Construction View and add geometry as described in the previous procedure. Enter the general, deform, or transform settings required for all segments before going any further. This node will be used as the the template for other segments added using this technique.            

    
	            
    Right Click on the new Segment and select Clone Multiple.            
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    A Select Objects window opens. Pick the objects in the scene you wish to add to the RailClone style and click Clone, RailClone will generate a new Segment node for each of the selected items            
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        To update geometry

            
    When editing segment geometry referenced in a RailClone object, certain operations do not automatically update. This is because some actions, such as converting to an editable poly or mesh, create new geometry in place of the source object. If this happens the RailClone object will use the original mesh and further changes will not be automatically updated, this is normal and 3DS Max's compound objects work in the same way.            

    	            
    In this situation, to update the geometry reference with the new source object, use the Reload button (            

                [image: images/download/attachments/10092640/1434841528.png]
                    
    ) in the Style editor.            

    
	            
    You do not need to do this for each segment node. The refresh button will operate on all Segment nodes in the current Style.            

    

    

    
        To delete source geometry

            
    Once geometry has been added to the style via a segment node, the original source mesh can be safely deleted. Though it is not necessary to do so, this may make the sharing and archiving of styles simpler.            

    	            
    Add geometry to the style as described above.            

    
	            
    Select and delete the original source geometry.            

    
	            
    Segments that have had their source geometry deleted will display "--embedded--" in place of the object name.            

    
	            
    To re-extract geometry from a RailClone object, see the next procedure.            

    

    

    
        To extract segment geometry into the scene for editing

            
    Once a segment is assigned it is possible to delete the original geometry as the RailClone object stores a copy of the mesh internally. However, on occasions it may be necessary to extract this Geometry back into the scene.            

    	            
    Select the segment node you wish to extract.            

    
	            
    Click the Extract Segment To A New Object button (            

                [image: images/download/attachments/10092640/-865767358.png]
                    
    ) from the tool bar or go to Segments>Extract from the menu.            

    
	            
    The Segment will be created in the scene at its original coordinates.            

    

    

    
        To overlap or add spaces between Segments

            
    Segments calculate a default size based on the dimensions of the source geometry's bounding box. The padding values allow you to overlap or add spaces between adjacent objects by adjusting this size.            

    	            
    To change the alignment of an object to the left or right of the current segment, adjust the Padding>Left or Right values. A negative number will overlap the adjacent segments, a positive will create a space between them.            

    
	            
    If you are using an A2S generator, use the Padding>Top or Bottom values to adjust the spacing above and below the current segment. As before, a positive value will create a space and a negative will create an overlap. See the padding reference below for a more detailed explanation.            
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        To rescale geometry to a specific size.

            
    There are two ways to resize a segments. Either use the scale factor in the Transform properties, or enter a specified measurement in scene units in the Fixed Size settings            

    	            
    Select a Segment and open the properties panel.            

    
	            
    From the General > Fixed Size properties, enter a value in the Z, Y, or Z inputs boxes.            
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    Turn On Scale Segment.            

    
	            
    To export the values, right click on the node and select Export > Fixed Scale > X/Y/Z.            

    
	            
    Wire a new Numerical node to the exported property, set the mode to scene units. You can now adjust the size of the segment from the properties rollout in the modify panel.            

    

            
                

        

    
        To bend segments to follow the spline paths

	            
    Ensure that source geometry has a sufficiently dense mesh for smooth deformation. For 1LS you will may need horizontal subdivisions, for an A2S you may need both horizontal and vertical subdivisions if both splines are curved.            

    
	            
    Go to Segment Properties>Deform>Deform and turn on Bend.            
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        To create stepped segments

	            
    Select a segment you wish to set to stepped.            

    
	            
    Go to Properties>Deform>Deform> and change the mode to Stepped. No vertical deformation will be applied to this segment when used with an L1S generator.            
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    If you would like the segment width to remain the same as the source geometry when measured on the horizontal axis, ensure Slope Fixingremains on. If this option is switched off then the width will be measured along the angle defined by the path spline.            

    

    

    
        To create segments with upright verticals

	            
    Select the segment you wish to vertically deform            

    
	            
    Go to Properties>Deform>Deform> and change the mode to Vertical. The segments will now deform so that the horizontals follow the path but the verticals remain upright.            

    
	            
    Enter a value into the Flat Top or Flat Bottom parameter boxes to maintain a stepped appearance for a part of the segment mesh. The value defines an area of influence, represented as a distance in world units from the top or bottom of the segment's height.            
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        To randomise translation, rotation or scale

	            
    Segments can be transformed directly from within the Style Editor by going to Transform>Fixed and then adjusting the values for eitherTranslation, Rotation or Scale.            
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    To randomise a Segment's position go to Transform>Random and turn on Translation. Each axis can be randomised independently by entering a Minimum and Maximum value, measured in scene units.            
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    To randomise rotation, activate Transform>Random>Rotation and enter Minimum and Maximum values in degrees for each axis you wish to randomise.            

    
	            
    To Randomise Scale, activate Transform>Random>Scale and enter Minimum and Maximum percentages for the axis you wish to randomise.            

    
	            
    If you would like that transform setting to affect the height and width used to calculate the packing of adjacent segments, leave Transform Affects Size on. If you would like to retain the size of the original segment before transforms, switch this setting off.            

    

    

    
        To prepare geometry for use as segments

            
    Though segments can be rotated and scaled from within RailClone, properly prepared geometry can save time. In particular, attention should be paid to the local axis. RailClone uses this to determine the alignment in relation to the Base Objects. The X axis of the geometry will be aligned with the path direction while the Y runs perpendicular.            

    	            
    If a segment is to be bent along a path, ensure the geometry has a sufficiently high mesh density to allow for smooth deformation.            

    
	            
    If adjacent segment geometry is to appear seamless, ensure it has the same smoothing group allocated.            

    
	            
    Rotate and scale your segment geometry the way you wish it to appear in finished RailClone object, in relation to the world axes.            

    
	            
    Go to Hierachy>Adjust Pivot>Affect Pivot Only and then press Align to World.            

    
	            
    If necessary, adjust the location of the pivot. point.            

    
	            
    Go to Utilities>Reset XForm>Reset Selected.            

    
	            
    UVW map the object if necessary, alternatively simple box mapping can be applied automatically from with RailClone.            

    

    

    
        To Add Box Mapping to segments

            
    Using regular repeating segments can result in obvious tiling of the textures. To help resolve this it is possible to turn on box mapping that uvw maps across several adjacent segments according a size set in the segment's Deform>Mapping settings.            

    	            
    Select the Segment you wish to map and go to Properties>Deform>Mapping.            

    
	            
    Turn on Box Mapping.            

    
	            
    Either set the size of the box map using the Length, Width and Height settings, or if you are using materials with real world map size settings, simply turn this option On.            

    
	            
    Use the Rotation parameter to align the map correctly on the segment.            

    
	            
    Set the UVW channel to target, using the Map Channel spinner.            

    

    

    

    
        Interface

    
        Object

            
    Displays the name of the geometry object in the scene associated to the Segment. To assign, click this box then pick from the Max scene.            

                
    Once the geometry has been assigned the original source mesh can be deleted from the scene. RailClone stores a copy of the geometry locally, in a similar fashion to 3DS Max's compound objects working in instance mode (such as Pro-Boolean). If the original object has been deleted the word "--embedded--" will display in place of the original object name.            

        

    
        Padding

            
    Each segment has a defined length and height, which controls how it will be assembled with other segments along the paths. By default, this length is determined by the size of the bounding box of the source geometry. The Padding parameters allow you to modify the default size, increasing or decreasing the distance with other segments to the left, right, top and bottom sides.            

                
    Top and Bottom paddings are applicable only to the array generators, as 2D arrays - Generator A2S.            

                
                [image: images/download/attachments/10092640/-105197426.png]
                    

                
    Applying a negative right padding to the Post segment makes it shorter, and fixes the separation created by the top piece            

        
        
	            
    The effective size of a segment on X is: geometry size + padding left + padding right, where padding values can be positive or negative.            

    
	            
    Padding doesn't modify the position of the segment on the path by itself (as the Local Transform->Translation parameters does), but how the surrounding segments (horizontally and vertically) must be adjusted.            

    

    

    
    

    
        

    

    
        Fixed Size

            
    Use these values to override the dimensions for the segment. Turning on Scale Segment will re-size the segment to match the dimensions. This property can be exported, simplifying the process of parameterising the sizes of segments,            

        

    
        Alignment

            
    These parameters help you to align the segment on the underlying path. Alignment can be defined for each axis, from the following values:            

                
    X: Automatic, Pivot, Left, Center, Right            

                
    Y/Z: Automatic, Pivot, Bottom, Center, Top            

                
    The Automatic mode, uses the best alignment mode depending of the Segment's position: for example, "Left" for Start pieces, "Right" for End and so. This is the default mode, and should work well for most of situations, usually it is not necessary to change it. See table and illustrations below for an explanation of the values used when alignment is set to automatic. Depending on the generator type and input slot to which a segment is connected, the automatic alignment is as follows:            

        
        L1S

    
        
                
            	
    X:            
                	
    Start=Left,  Default=Left, Corner=Center, Evenly=Center, End=Right            
        

    
            	
    Y:            
                	
    All Segments=Center            
        

    
            	
    Z:            
                	
    All Segments=Bottom            
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    Default alignment for L1S Generator when set to Automatic            

        

    
        A2S

    
        
                
            	
    X:            
                	
    Start=Left,  Default=Left, Corner=Center, Evenly=Center, End=Right            
        

    
            	
    Y:            
                	
    Bottom Side=Bottom, Default=Bottom, Evenly=Center, Top Side=Top            
        

    
            	
    Z:            
                	
    All Segments=Bottom            
        

        

            

            
                [image: images/download/attachments/10092640/1498667793.png]
                    

                
    Default alignment for A2S Generator when set to Automatic            

        
        
            
    RailClone uses the local coordinates of the segment object. The same geometry would generate different results, depending of the rotation of its local pivot. It's a good habit to apply "Adjust Pivot->Align to World" and "Utilities->Reset XForm" before assigning an object as Segment.            

        

    
            
                

        

    

    
        Deform

            
    These parameters define how RailClone must deform the segments to follow the trajectory of the path.            

        
        Bend

            
    If enabled, the segment is bent along the path. If not, RailClone places the segment on its position in the path without applying any horizontal deformation.            

                
                [image: images/download/attachments/10092640/1593825930.png]
                    

                
    Applying bend on curved walls.            

        
        
            
    When working on curved paths, besides enabling the Bend feature, be sure your segments have enough horizontal subdivisions to get a smooth result. RailClone does not subdivide the segments automatically.            

        

    
    

    
        Slice

            
    Allows RailClone to slice the segment if it doesn't fit in the path. This feature is especially useful when creating objects such as railings or walls.            

                
                [image: images/download/attachments/10092640/-1637991763.png]
                    

        

    
        Nest

            
    A legacy feature used to support RailClone 1.x styles. If a Railclone object is used as a segment within another, this feature allows paramaters to be randomised each time a the item is used. In most situations an A2S generator will achieve equivalent results without the need to nest multiple RailClone objects.            

        

    

    
        Z Axis

            
    One of the most advanced features of RailClone is the ability to build complex structures such as railings or walls along sloped paths. The following options define the behavior of the segments in these cases.            

        
        Adaptative

            
    The segment is aligned to follow the tangent of the path.            

        

    
        Vertical

            
    The geometry stays vertical, but the vertices are moved in the Z axis to match the elevation of the path.            

        

    
        Stepped

            
    No deformations are applied in the Z axis, and the segment preserves its vertical alignment.            

                
                [image: images/download/attachments/10092640/-1447293372.png]
                    

                
    Usually, in complex structures such as railings, you need to use different Z Axis options for each type of segment. In the following example, the handrail is built using three segments: post (stepped), joint (stepped) and picket (vertical).            

                
                [image: images/download/attachments/10092640/-1447293371.png]
                    

        

    
        Slope fixing

            
    This parameter adds a correction to the segment's size to compensate for the inclination of the path. It is used only for Vertical and Stepped modes, and it's enabled by default.            

                
                [image: images/download/attachments/10092640/-1212770969.png]
                    

        

    
        Flat Top/Flat Bottom

            
    Working in Vertical mode, these parameters allow you to flatten the top or of the bottom of a geometry. The values define the maximum distance (in Z axis) that the effect is applied, starting from the top or the bottom of the geometry. This feature is especially useful for railing posts, and works as a combination of Vertical and Stepped modes in the same segment.            

                
                [image: images/download/attachments/10092640/1385344191.png]
                    

                
    Flat Bottom used in a vertical post of a handrail structure            

        

    
        Vertical Top/Bottom

            
    When using Stepped mode, these parameters enable the top or bottom of a segment to deform and follow the spline, leaving the area middle area stepped. The two values define the distance (on the Z axis) to which the effect is applied, starting from the top or the bottom of the geometry. The illustration below demonstrates the differences between Vertical Top/Bottom and Flat Top/Bottom.            

                
                [image: images/download/attachments/10092640/390397957.png]
                    

                
                

                
        [bookmark: 10092640_mapping]
            

        

    

    
        Mapping

            
    Generates UV coordinates of type "Box" to the the segment. Instead of using the default UV coordinates of the the individual segment, this mapping is seamlessly tiled along the full length of the RailClone object.            

                
                [image: images/download/attachments/10092640/-576254784.png]
                    

                
    Apply Box Mapping: Turns on RailClones automatic box mapping mode
Real-World Map Size: Turn on to use with materials set to use Real-World Map Size for tiling.
Length, Width, Height: Sets the dimensions of the box map.
Rotation: Rotates the UVW mapping, equivalent to rotating the texture on the W axis.
Map Channel: Enter a map channel to apply the box mapping, to map multiple channels enter them as a list separated with spaces.            

        
        
            
    This feature is available only in V-Ray, when Display->Use Geometry Shader is enabled. See Best Rendering Practices for more information about the rendering modes.            

        

    
    

    
        Fixed Transform

            
    Applies the specified transformations of translation, rotation and scale to the segment.            

                
    This behaves differently from version 1.x. In RailClone 2.x the alignment options are applied AFTER the fixed transform. This behaviour is more natural, but would generate significant differences when using objects created with previous versions.            

        

    
        Random Transform

            
    Lets you to apply random translation, rotation and scale transformations. They are applied in the local coordinates of the segment.            

        
        Transform affects Size

            
    When enabled, RailClone consideres the random transformation to compute the size of the resulting segment. If disabled, the size is fixed (based on the original geometry without random transforms).            

                
                [image: images/download/attachments/10092640/2143499107.png]
                    

                
    A roof using tiles with random rotation and scale. Tiles are misaligned if Affects Size is on            

        
        
            
    RailClone uses an approximation algorithm, to get the size of a random transformed segment. The result would be less precise, compared with the same transformation applied as "Fixed". For example, between using a Fixed Z rotation of 90, or Random rotation of 90 to 90.            

        

    
    

    

    

        

    


    
        
            Exporting Parameters

        


        

        
            
        [bookmark: 10092644_ExportingParameters-top]
            

        
        Overview

            
    Parameters allow you to wire an input node to any numerical value of a generator, object or operator. This enables you to wire together properties, including those on different nodes, with the potential to build complex procedural relationships by using the Arithmetic node type.            

                
    There are two types of Parameter node available. The constant node that can only be modified by opening the style editor, and the Numeric node that is adjusted from the Parameters rollout. Using the latter you can create easily modifiable styles that do not require you to open the style editor to make adjustments.            

        

    
        Procedures

    
        To add a Numeric parameter to a node property:

	            
    Right click on a Generator, Object, or Operator node. From the menu select Export and pick the parameter you wish to control. A new slot will be added at the bottom on the input list.            

                [image: images/download/attachments/10092644/-2137859614.png]
        
	            
    Add a new Parameter>Numeric node to the construction view by dragging from the list on the right            

                [image: images/download/attachments/10092644/313919932.jpg]
        
	            
    Define the type of value, either Integer, Float, Percentage of Scene units.            

    
	            
    If necessary, turn on the limits and set the Minimum and Maximum values            

    
	            
    Wire the output of the Numeric Node the the newly exposed parameter slot of the target value.            

    
	            
    Adjust the new value from the Parameters rollout in the RailClone object.            

                [image: images/download/attachments/10092644/76731334.jpg]
        

    

    
        To add a Constant parameter to a multiple node properties:

	            
    Expose multiple properties by right clicking on nodes, going to export, then choosing properties to create new input slots on the node. Do this for any properties you wish to control for generator, segment, and operator nodes.            

    
	            
    Create a new constant parameter by dragging it to the construction view from the items list on the right.            

    
	            
    From the properties editor, set the constant type. Options are Integer, Float, Percentage or Scene Units.            

    
	            
    Set the constant Value.            

    
	            
    Wire the constant output to inputs by clicking and dragging with the mouse.            

    

            
    Note that the Constant parameter type can only be modified from within the style editor. If you wish to wire a numeric node to multiple inputs, follow the same steps but using this node in place of the constant.            

        

    
        Using constant and parameter nodes in simple artithmetic operations:

	            
    Right click on a generator, object, or operator node. From the menu select Export and pick the parameter or parameters you wish to control. A new slot will be added at the bottom of the input list for each selected.            

    
	            
    Drag a new Numerical node from the items list to the construction view and set the Type, Value and Limits as described above            

    
	            
    Drag a new Constant node from the items list to the construction view. Set the Type and enter a value to be used in the equation, for example, to halve the value of the numerical node, enter 0.5 as a constant.            

    
	            
    Drag a new Arithmetic node from the items list to the construction view. From the drop down list choose the type of mathematical operation. Options are Add, Subtract, Multiply, Maximum and Minimum.            

    
	            
    Wire the numerical or constant node to the first input of the arithmetic node            

    
	            
    Wire the remaining parameter node to the second input of the arithmetic node.            

                [image: images/download/attachments/10092644/-545150952.png]
        

    

    

    
        Interface

    
        Numeric

            
    Creates a new Numeric parameter that can be entered outside the style editor by the user. Similar to the spline node, the value for this is determined in the Parameters rollout of the 3DS Max Plugin.            

                
    This number can be animated            

        
        Type

            
    Defines the type of number to be used            

                
    Integer. Use for whole numbers
Float. Use for decimal numbers
Percentage. Use for percentages (Usually with scale values)
Scene units. Use for measurements in scene units
Booleans: Use for true/false logic operations            

        

    
        Limits

            
    Use this to constrain the input range between two values.            

        

    

    
        Constant

            
    Creates a new constant value that can only be changed from within the style editor. Unlike the Numeric node, this property cannot be animated.            

        
        Type

            
    Defines the type of number to be used            

                
    Integer. Use for whole numbers
Float. Use for decimal numbers
Percentage. Use for percentages (Usually with scale values)
Scene units. Use for measurements in scene units            

        

    
        Value

            
    Set the value of the parameter            

                
                

        

    

    

        

    


    
        
            Operators

        


        

        
            
                

        
        Overview

            
    Operators are used to transform or modify the behaviour of nodes in the Style Editor. There are currently three types of operator, those that work on segments, those that only work on other operators, and those that work with parameters. Click on the name of the operator for more detailed information.            

        

    
        Operators that require Segments as inputs (will also work with composite operators like sequence and compose)

            
                

                [image: images/download/attachments/10092642/1791778410.png]
            
        Material

    
        Overview

            
    The Material operator uses a designated Material ID from the input segment and replaces it with a new value identified in the From/To range. If the From and To value are identical, the ID is simply swapped for a single value. If the From/To values form a range, then the operator can either replace the IDs in a looping sequence or pick values at random.            

                [image: images/download/attachments/10092642/-1853323715.png]
                    
    Material IDs reassigned in sequence            

                
                [image: images/download/attachments/10092642/-1583805291.png]
                    

                
    Material IDs reassigned at random            

                
                

        
        
            
    This operator is only compatible with V-Ray. To use with other renderers it is necessary to disable Display > Use Instancing Engine. See Best Rendering Practices for more information about the rendering modes.            

        

    
            
                

        

    
        Usage

            
    A single Material Operator is used to reassign a material ID from the input Segment.            

                
                [image: images/download/attachments/10092642/-1325837367.png]
                    

                
    If you would like to reassign multiple IDs in the same segment, several material operators can be wired in series, each controlling a different input ID.            

                
                [image: images/download/attachments/10092642/-1325837366.png]
                    

        

    
        Interface

            
    Random. Selects a value at random between the From/To ID range.
Sequence. Cycles through the From/To Id range values, looping when it reaches the end.
From/To. Defines the start and end values of a range for the Material IDs.            

                
                

                
                

                
                [image: images/download/attachments/10092642/-1626686861.png]
                    

        

    

    
        Selector

    
        Overview

            
    The selector operator allows you to choose from a list of segments using a numerical index. This operator allows a segment to be selected manually from the operators properties, wired to a numerical node for easy manipulation without opening the style editor (as illustrated below), or derived from the material ID assigned to a spline segment.            

                
                [image: images/download/attachments/10092642/1191572447.gif]
                    

                
    Segments controlled by a numerical node accessed from the parameters rollout of the Max plugin.            

        

    
        Usage

            
                [image: images/www.itoosoft.com/img/railclone2/ref/-500446398.png]
                    

    	            
    Wire segments to the Selector operators inputs. The order is important - the index numbering is built from the top of the list with an origin of 1.            

    
	            
    If you need to change the order, use the up and down arrows that appear when you select the segment name on the Selector node.            

    
	            
    Choose a method to control selection. To use the index spinner to switch between segments, go to Properties>Selector and ensure it is set to Index. If the segments will be selected automatically by the material ID of a spline segment, change the Properties>Selector setting to Mat ID.            

                [image: images/download/attachments/10092642/-500257670.png]
        

            
    It is useful to export the Index parameter to make changes without opening the style editor            

    	            
    Right click on the Selector node and choose Export>Index
            [image: images/download/attachments/10092642/748648037.png]
    
            

    
	            
    Create a new Numerical node and wire it to the Index input.            

    
	            
    You can now control the selection from the Parameters rollout of the plugin without opening the style editor.            

                [image: images/download/attachments/10092642/152094406.png]
        

            
    To change a splines material ID            

    	            
    Go to the Base Splines segment sub object level            

    
	            
    Select the segments you wish to change and go to the Surface Properties rollout. Enter a new Material ID in the Set ID field.            

    

    

    
        Interface

    
        Selector

            
    Pick between two modes:            

                
    Index mode. Chooses a segment from the array using the number displayed in the Index spinner
Spline Mat ID mode. Chooses a segment from the array using the material ID of the base splines segments.            

        

    
        Index

            
    Used with Index mode to control the segment chosen from the array. Can be exported.            

                
                

                
                

                
                [image: images/download/attachments/10092642/1046075842.png]
                    

        

    

    

    
        Mirror

    
        Overview

            
    Makes a mirror copy of a segment's geometry using a combination of the XYZ axes as a mirror plane.            

                
                [image: images/download/attachments/10092642/-1891408962.png]
                    

                
    The first half of the spline uses standard segment, the second half uses segment attached to mirror operator.            

        

    
        Usage

            
                [image: images/download/attachments/10092642/1835030111.png]
                    

    	            
    Attach the segment to be mirrored to the input slot of the Mirror node and select the axis for the mirror operation.            

    

    

    
        Interface

    
        Axis

            
    Chooses the axis to be used as a mirror plane, multiple axes can be selected.            

                
    X. Mirrors the segment on the X Axis
Y. Mirrors the segment on the Y Axis
Z. Mirrors the segment on the Z Axis            

                
                

                
                

                
                [image: images/download/attachments/10092642/-1798108978.png]
                    

        

    

    

    
        Randomize

    
        Overview.

            
    Returns a random Segment from the list of inputs. Each segment has a presence value that determines the probability of it being selected. These values are normalised so there is no need to ensure they add up to 100%            

                
                [image: images/download/attachments/10092642/-1872091117.png]
                    

                
    Random selection from 4 segments            

        

    
        Usage

	            
    Connect a number of segments to the input slots of a Randomize node.            

    
	            
    Set the presence of each segment to control probability. If you would like an equal chance of each segment being selected, leave the values at their default 100%.            

    
	            
    This example will randomly select between the 3 attached segments with the Middle segment having a 35% chance of being selected.            

                [image: images/download/attachments/10092642/2094717567.png]
        

    

    
        Interface

            
    Presence (%). A normalised value that determines the probability of an individual segment being selected            

                
                

                
                

                
                [image: images/download/attachments/10092642/-1452707580.png]
                    

        

    

    
        Sequence

    
        Overview

            
    Creates sequences of the segments used as inputs, starting at the top of the list and working downward. Each segment can be repeated using a simple counter, when the counter reaches its limit, RailClone moves on to the next item in the list. When the sequence reaches the end of the list, it starts again from the beginning.            

                
                [image: images/download/attachments/10092642/406504277.png]
                    

                
    Repeating sequence of 3 segments            

                
    The sequence can be reset at either the start of each spline or the start of a new section. The latter is defined as a length of path found between two segments of the Start, End, Corner, or Evenly type.            

        

    
        Usage

            
                [image: images/download/attachments/10092642/-1340671907.png]
                    

    	            
    Attach Segments to the input slots of a Sequence node            

    
	            
    To change the order, use the up and down arrow tools that appear when you select the segment name on the Sequence node            

    
	            
    From the Properties view, adjust the counters for any segments you wish to repeat            

    
	            
    When using a 2D array, choose the axis            

    

            
    you wish to use to create the sequence.            

    	            
    Set the Sequence Reset to either Spline or Segment start            

    

    

    
        Interface

            
    Increment at X/Y. When using a 2D array, chooses the axis used to create the sequence.            

                
    Reset at Spline Start/Spline Section. Determines when the sequence starts again.            

                
    Counter. A numerical value that allows you to repeat segments without having to attach them to the Sequence node multiple times.            

                
                

                
                

                
                [image: images/download/attachments/10092642/-2049391633.png]
                    

        

    

    
        Compose

    
        Overview

            
    The compose node allows you to build a new geometry object by combining several segments together. When attached they will array along the path one after the other (similar to the sequence node, above). However when used in conjunction with a Segment's padding and transform settings, segments can be moved rotated and scaled on any axis to make a complex composite object.            

                
                [image: images/download/attachments/10092642/1535906972.png]
                    

                
    4 segments combined using a compose node (marked with a white outline).            

        

    
        Usage

            
                [image: images/download/attachments/10092642/-1083326382.png]
                    

    	            
    Attach segments to the input slots of a Compose Node            

    
	            
    Adjust the order using the up and down arrow tools that appear when you select the segment name on the Compose Nose            

    
	            
    Adjust the location of each Segment using its Padding and transform settings.            

    

    

    
        Tips on moving segments.

            
    To move an object to the left, adjust the preceding segment's right padding            

                
    To move an object up or down adjust the segment's Transform>Fixed>Translation>Z value            

                
    To control the spacing between the Compose object and the next item of geometry, adjust the right padding of the final Segment node used in the Compose node inputs.            

                
    To rotate a segment use the Segment>Transform>Rotation values.            

                
                

                
                

                
                [image: images/download/attachments/10092642/492403299.png]
                    

                
                

                
                

        

    

    
        Conditional

    
        Overview

            
    Accepts two Segments as input, returning one of them (true or false), depending on whether certain conditions have been met. These can be nested to create a complex decision tree.            

        

    
        Usage

            
                [image: images/download/attachments/10092642/803271262.png]
                    

                
    This node will be configured according to the condition you wish to test for, based on the following options.            

        
        Spline

            
                [image: images/download/attachments/10092642/76756061.gif]
                    

                
    Checks if the length of the underlying spline is greater or less than a specified value. The condition can be checked over the full length of the spline, or only for the current section. A section is the path between two segments of the type Start, End, Corner or Evenly.            

        

    
        Position

            
                [image: images/download/attachments/10092642/76756062.png]
                    

                
    Displays 1 unless segment location is greater than 60% of total spline length, in which case 2 is displayed.            

                
    Checks if the position of the segment along the spline is greater or less than a certain value (defined in length percentage of the full path / section).            

        

    
        Type

            
                [image: images/download/attachments/10092642/76756063.png]
                    

                
    Displays 1 on curved segments, 2 on line segments            

                
    Checks if the current spline segment is either a line or curve.            

                
                

        
        
            
                [image: images/download/attachments/10092642/549216154.png]
                    

                
    Right click to set the segment type of a spline    Setting spline segment types.

            

                
    To set the spline segment type property on a spline used as a base object, go to the segmentsub objects of an editable spline, choose a segment, right click to set as either a Line or Curve.            

        

    
            
                

        

    
        Material ID

            
    Checks the current segment's material ID. Returns a true or false value if this value is equal to, not, greater than, less than or a multiple of the ID identified in the material ID value of the conditional node.            

        

    
        Vertex

            
                [image: images/download/attachments/10092642/76756064.png]
                    

                
    Example displays 2 on spline vertices unless it is a corner, in which case 3 is displayed, or smooth when 4 is displayed.            

                
    Returns true if the vertex just below the segment is of a certain type: Corner, Bezier, Bezier-Corner or Smooth. The Angle condition checks the angle formed by the spline at this vertex.            

                
    Usually this conditional is used together the Corner construction rule, to create different types of corners but it can also be used with the default input in which case the conditional node tests for the vertex at the beginning of the current spline segment.            

        

    
        Segment

            
                [image: images/download/attachments/10092642/76756065.png]
                    

                
    Example displays 1 unless segment count = 3, when it displays 3, or segment count is a multiple of 5 when it displays 2.            

                
    Counts the number of segments placed on the path, before the current position. Returns true or false if the values entered in this node meets certain conditions, i.e.Equal, Not equal, Greater than, Lessthan, or a Multiple of the value.            

        
        
            
    This operator can be used to create sequences of segments a certain intervals. It is possible to check the X and Y counters independently (for array generators).            

        

    
    

    

    
        Interface

            
    Spline Length. Activate to test for spline length
Full Spline/Current Section. Measures either the length of the entire spline or the curent segment
Greater/Less. Return true if spline or segment is greater or less than this value
Position. Activate to test for the position along the spline, measured as a percentage.
On Spline/On Section. Measures position of either the entire spline or the current section
Greater/less. Return true if position is greater or less that this value.            

                
    Vertex. Activate to test for vertex type.
Corner/bezier/smooth/bezier/corner/not corner/not bezier/not smooth/not bezier - corner. Type of vertex that returns a true value
Angle. Activate to test for vertex angle
Greater/less. Return true if the angle is greater or less than this angle.
Chck wider angles (>180). When on, checks angles in the range 0 to 360 degrees, according to the path's direction. If disabled, angle checking is limited to 0-180 degrees.            

                
                [image: images/download/attachments/10092642/-307309215.png]
                    

                
    Segment. Activate to test for segment count.
X counter/Y Counter. Counts segment on either/and the x and y axis of an array
Equal/not equal/greater/less/multiple of. Returns true if the current segment is equal, greater, lesser, or a multiple of this value            

                
                

                
                

                
                [image: images/download/attachments/10092642/1517339634.png]
                    

        

    

    
        Transform

    
        Overview

            
    Used to adjust the padding, alignment, and transform settings of a segment. This can be useful where you wish to reuse a segment multiple times but with different properties.            

                
    It is also necessary to use the Transform operator when dynamically controlling a segments properties using arithmetic expressions. Due to limitations in the current workflow, connecting a arithmetic node containing an expression directly to a Segment object is not possible. In this case connect the Arithmetic node to a transform as shown in the node diagram shown below.            

                
                

        

    
        Usage

            
                [image: images/download/attachments/10092642/1329043354.png]
                    

                
    To adjust the padding, alignment or transform settings of a segment:            

    	            
    Wire the segment to the transform nodes input.            

    
	            
    In the Transform nodes properties, activate any settings you wish to use by clicking on the appropriate tick-box. This will override the values set in the Segments properties.            

    
	            
    If necessary, expose settings so that they can be controlled by numeric, constant, or arithmetic operators by right clicking on the Transform node and selecting Export>[properties]            

    
	            
    Connect the Transform nodes output to the generator or another operators input.            

    

    

    
        Interface

            
    Padding. Controls the distance between adjacent segments with separate controls for left, right, top and bottom.
Fixed Size. Controls the size of the segment. If Scale Mode is off the values are used only for calculating the position of adjacent segments.
Alignment. Selects the pivot point position used to calculate the location of the segment on the X, Y, and Z axies
Transform Fixed. Allow you to adjust the translation, rotation and scale of a segment.
Transform Random. Allows you to randomise the translation, rotation and scale of a segment by picking values from a range defined by a minimum and maximum value.            

                
    For detailed explanations of padding, alignment, transforms and randomisation please see the Segment reference.            
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        UVW XForm

    
        Overview

            
    The UVW XForm operator allows you to manipulate the mapping coordinates already applied to a segment. These coordinates could be from the segment's original geometry, or they could have been created using RailClone's Automatic Box Mapping tools. There are two modes available: Fixed mode enables you to adjust the tiling, offset and rotation of UVW coordinates, in this case all segment's will have the same results; Random mode allows you to randomise within a range the tiling, offset and rotation of UVW coordinate to create unlimited variation.            

        
            Compatibility

        
            
    V-Ray is required to maintain instancing when using this operator. Other renderers are supported by disabling instancing. To do this, turn off     
Display->Use Instancing Engine. To see a full list of which features are supported by your renderer, see the compatibility list.     
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    The texture used in the following examples.            

                
                [image: images/download/attachments/10092642/-500152373.gif]
                    

                
    In fixed mode, the UVW coordinates are adjusted for all segments            

                
                [image: images/download/attachments/10092642/-1337287892.gif]
                    

                
    In random mode, offset, rotation and tiling can be varied per segment within a range            

                
                [image: images/download/attachments/10092642/-856359760.gif]
                    

                
    In random mode with stepped offsets, the random values increment using a set value             

                
    
            

                
    
            

                
    
            

        

    
        Usage

            
                [image: images/download/attachments/10092642/-1624359268.png]
                    

        
        To adjust UVWs

	            
    Wire segment(s) to the UVW XForm operators input.            

    
	            
    Go the the UVW XForm operator's properties and change the Map Channel value to select the channel you wish to edit. To affect all channels turn on Apply to All Channels.            

    
	            
    Edit the Tile, Offset and Rotation values for the U,V and W axes.            

    

    

    
        To randomise UVWs within a range

	            
    Wire segment(s) to the UVW XForm operators input.            

    
	            
    Go the the UVW XForm operator's properties and change the Map Channel value to select the channel you wish to edit. To affect all channels turn on Apply to All Channels.            

    
	            
    Make any adjustments required to the mapping in the Fixed tab of the properties panel as described above.            

    
	            
    Click on the Random tab in the Properties panel            

    
	            
    Add a Start and an End value to define the range for each of the attributes you wish to randomise.            

    

    

    
        To randomise UVWs using stepped increments

	            
    Wire segment(s) to the UVW XForm operators input.            

    
	            
    Go the the UVW XForm operator's properties and change the Map Channel value to select the channel you wish to edit. To affect all channels turn on Apply to All Channels.            

    
	            
    Make any adjustments required to the mapping in the Fixed tab of the properties panel as described above.            

    
	            
    Click on the Random tab in the Properties panel            

    
	            
    Add a Start and an End value to define the range for each of the attributes you wish to randomise.            

    
	            
    Enter a Step Increment value. The random values returned by the operator will be multiples of this figure.            

    

    
        
            
    All the UVW XForm operator's parameters can be exported by right clicking on the node. This can be useful if you wish to enter a value in scene units for the Step Increment parameter. Below is a graph that will automatically set up the UVW XForm operator in the event that you have a texture that contains multiple tiles (equal number, equally spaced on the U and V axes) and you wish to randomise them with stepped increments. This is often a faster alternative to creating a complex multi-sub object material and randomising the material IDs.            
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    The graph            

                
                [image: images/download/attachments/10092642/-736885438.png]
                    

                
    The output, on a tile segment            

        

    
            
                

        

    

    
        Interface

    
        Fixed

            
    Use this tab to adjust the existing UVW mapping on the attached segments.            

                
    Map Channel Chooses the UVW Map channel to affected by the operator. Multiple operators can be use to assign map different map channels unique settings
Apply to all channels When on, all UVW map channels are affected by the operator.
U/V/W Tile Adjust the tiling with individual controls for UVW coordinates
U/V/W Offset Adjust the offset with individual controls for UVW offsets. 
Rotation  Adjust the W Rotation.            

        

    
        Random

            
    Use this tab to randomise the existing UVW mapping on the attached segments.            

                
    Tile U/V/W Start/End Define the start and end of a range from which random tiling values are returned.
Offset U/V/W Start/End Define the start and end of a range from which random offset values are returned.
Rotate Start/End Define the start and end of a range from which random rotation values are returned.
Step Increment If greater than 0, random values are derived from multiples of this number found within the range.            

        

    

    

    

    
        Operators that require other operators as inputs
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        Reverse

    
        Overview

            
    Reverses the order of elements in a Compose operator. If "Mirror Segments on X" is enabled, creates a mirror copy of each segment on the X axis.            

                
                [image: images/download/attachments/10092642/1196552524.png]
                    

                
    Top Row: Standard Compose Node. Bottom Row: with reverse added. Note that unlike the mirror operator, segments are not flipped.            

        

    
        Usage
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    Attach a Compose node to the Reverse node's input slot            

    
	            
    If you would like each segment to be mirrored on its X axis, select Mirror Segment on X from the properties editor.            

    

    

    
        Interface

            
    Mirror Segments on X. When this is enabled each segment is individually flipped on its X axis.            
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    Sequence reversed and flipped on the X axis.            

                
                

        

    

    

    
        Operators that require Parameters as inputs or generate values
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        Random

    
        Overview

            
    Used to generate random numbers that can be used in conjunction with exported properties and the arithmetic operator.            

        

    
        Usage
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    From the Type list, choose either, integer, float, percentage, or scene units            

    
	            
    In the Range>Min and Max properties, define that start and end values of the range from which a random number will be generated.            

    
	            
    From the Generate On list, choose the condition that will cause a new random value to be generated.            

    
	            
    Wire the Random parameters output to any node that accepts a numerical input.            

    

    

    
        Interface

            
    Type. Defines the type of number to be generated. Choices are integer, float, percentage, or scene units.
Range. Sets the extents of the range from which a random value will be derived.
Seed. If enabled, uses the seed value specified. If disabled using the global seed value defined in the General rollout.
Generate On. The condition in which a new random value will be generated. Choices are:            

    	            
    Start - Generates a new random number once for each instance of the RailClone object.            

    
	            
    Segment - Generates a new random number for each individual segment.            

    
	            
    X Spline Start - Generates a new random number for each spline sub-object found in the X Spline input of the Generator.            

    
	            
    X Spline Section - Generates a new random number for each spline segment. For the purposes of this calculation a segment is the section of spline between two Corners or Evenly segments.            

    
	            
    Array Y Row - Generates a random number at the start of each new Row. Only works in conjunction with the 2D arrays - Generator A2S            
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conditional operator
                

                
                

        

    

    
        Arithmetic

    
        Overview

            
    Used to perform common mathematical operations on two or more Parameter Nodes, useful for creating complex parameterized objects using Parameter nodes wired to multiple inputs.            

        

    
        Usage
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    Attach 2 or more parameter nodes to the Arithmetic node's input slots            

    
	            
    Select the equation type from the drop down list            

    
	            
    Expose the target node property by right clicking, select export and pick the value you wish to parameterise.            

    
	            
    Wire the Arithmetic output to this new slot.            

    

    

    
        Interface

            
    Several operations are available:            

                
    Add. Returns the sum of an addition operation
Subtract. Returns the difference of a subtract operation
Multiply. Returns the product of a multiplication operation
Divide. Returns the quotient of a division operation
Maximum. Returns the larger of the input values
Minimum. Returns the less of the input values
Expression. Create equations using common functions and variables.            

        

    
        Expressions Editor

            
    To add an expression, select Operation>Expression and press Edit Expression to open the Expression Editor            

                
                [image: images/lonelymonk.com/forum_images/-892416901.jpg]
                

                
    To create complex parametric relationships, the Expressions Editor uses a straightforward mathematical syntax comprising operators (+, -, *, /, etc.), constants (pi, e, etc.), RailClone's built-in variables, numerical inputs, and functions (including standard, trigonometric, vector, rounding, and conditional functions that take one or more arguments and return a result). To find out which built in functions, operators and constants are available, a full list is included in the Expressions Pane on the left hand side of the window. To see an explanation for each function, single click on it and a description and example syntax will display in the Expressions Help Pane at the bottom of the interface.            

        

    
        Interface

            
    Expressions pane. Found on the left, lists all usable variables and functions. Double click a list item to add it to the edit window or single click to display help.
Edit Window. Used to create and edit the expression, to see the effects of an expression press Update. To construct a variable you can either type it in manually or add variables and functions by double clicking them from the expressions list.
Expressions Help. This window provides information about the currently selected variable or function.            

                
                

        
        
    Using expressions to control a segment's transform properties

            
    When using expressions to control a segments transform properties it is necessary to use aTransform operator. The current workflow will not allow you to connect an expression directly to a segment node.  RailClone will detect an incompatible connection and display a warning.            
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            Path Base Objects

        


        

        
            
        [bookmark: 10092646_PathBaseObjects-top]
            

        
        Overview
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    The Base Objects rollout lists all the inputs that must be selected from the scene to generate the current style. For example a single L1S generator will require a single spline, a single A2S generator takes two splines, and both can optionally use an additional spline as a clipping path.            

                
    RailClone use objects from the Max scene as reference, in the example above a spline determines that path of a cornice. These objects are added in Style Editor, but their properties are defined in the Base Objects. This lets you to easily adjust the reference objects, without the need to open the Style Editor each time.            

                
    The list is updated automatically when adding, deleting or renaming base objects in the Style Editor.            

        

    
        Procedures

    
        To create a new base object

	            
    Open the Style Editor from the Styles Rollout            

    
	            
    Drag a new Spline node from the items list to the construction View. The Base Objects list will be updated to show the new spline.            
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    Change the name of the spline input from the Properties Editor. The name will also update in the Base Objects list to reflect the changes.            
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    To pick a spline from the scene to use as a base object, click the name of the input you wish to use from list in the Base Objects rollout, got to Properties>Spline and pick a spline from the scene. Alternatively, you can assign the spline from the node's properties, in the Style Editor.            

    

    

    
        To rename an existing base object

	            
    Open the Style Editor from the Styles Rollout            

    
	            
    Select the Spline node you wish to rename.            

    
	            
    Go to the Properties Editor>Name and enter the new name for the spline.            
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        To control the starting point and length of the Railclone object along a spline

            
                [image: images/download/attachments/10092646/-748956495.png]
                    

                
    If full length is switched off, the area of spline to be used can be controlled with the start and length values.            

    	            
    From the Base Objects rollout select the spline you wish to change            

    
	            
    Turn off Full Length. The length of the spline to be used by the generator is now governed by the start and length controls            

    
	            
    Adjust the Start property either by entering the value manually or selecting the Pick button to the right of the Start value and selecting a start point by clicking in the scene. The geometry will move along the path the designated amount in scene units from the first vertex.            

    
	            
    Adjust the Length, this is measured from the start point in scene units, or alternatively select a point from the scene using the Pick button to right of the Length spinner.            

    

    

    
        To add a tooltip to a base object
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    If you are sharing RailClone objects with other users it is helpful to provide tooltips to explain how to use the different base objects used in the style. To create your own tooltips, follow these steps.            

    	            
    Open the style editor and click a spline node you wish to provide help for.            

    
	            
    From the Properties editor, enter the tooltip text in the Description field.            

    
	            
    To see this guidance in 3DS Max, select the item from the Base Object lists and click or hover over the help icon            

                [image: images/download/attachments/10092646/1131920160.png]
                    
    to read how to use it.            

    

    

    
        To move the Railclone geometry so that it lines up with the spline:

	            
    Go to the Base Objects rollout and click Realign to move the Railclone geometry back into its original aligment with the spline.            

    

    

    

    
        Interface
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        Currently RailClone only supports the use of splines as base objects, however other types of elements will be added in the future.            

        
        Move up/down selected item

            
    Changes the display order of the currently selected base object.            

        

    
        Spline

            
    Assigns the spline object by picking it from the Max scene.            

        

    
        Realign

            
    Lets you to realign the RailClone object with the selected spline. Use this option if you accidentaly move the object from its original position.            

        

    
        Full Length

            
    Defines whether to use the full length of the spline, or only a portion of it. If Use Full Length is turned off, use the Start/Length parameters to define the spline's extension, or the pick button to define the Start/End positions visually by clicking on the scene.            

        

    

        

    


    
        
            Surface Base Objects

        


        

        
    
        Overview
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    L1S and A2S generators allow you to conform segments to a surface by projecting them along the RailClone object's Z Axis. In the example above the Fence uses the spline marked in red to determine the position on the X and Y axis but the surface to position the segment's on the Z Axis. In Adaptive and Vertical mode the segment will also deform to follow the curvature of the surface.            

                
    As well as deforming along the Z axis, when using an L1S generator segments can also conform to the surface on the Y Axis. This is enabled individually for each Segment and can be found in Properties > Deform > Deform > Align Y with Surface.            
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    Left: Align Y with Surface = Off | Right: Align Y with Surface = on            

        
            Surface Normals

        
	            
    RailClone uses the surface's normals to determine the face's orientation. If the surface is not working, ensure that the normals are not inverted.            

    
	            
    To work correctly the RailClone object should be entirely enclosed by the boundaries of the surface. If the RailClone object overlaps a boundary, unwanted deformation can occur.            
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        Procedures

    
        To add a surface to an L1S Array:

	            
    Drag a new Surface object to the construction View            

    
	            
    Wire the Surfaces output to the Surface input of an L1S Generator.            
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    From the Base Objects rollout, select the surface from the list then click the surface picker button and select a mesh object from the scene.            
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        To add a surface to an A2S Array:

	            
    Drag a new Surface object to the construction View            

    
	            
    Wire the Surfaces output to the Surface input of an A2S Generator.            
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    From the Base Objects rollout, select the surface from the list then click the surface picker button and select a mesh object from the scene.            
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        Interface

    
        Base Objects rollout

    
        Surface

            
    use this button select a surface from the scene. Any mesh based object is valid.            

        

    
        Clear

            
    Click to remove the geometry from the selected surface.            

        

    
        Update

            
    Click to force an update to the surface,            

                
                

                
                

                
                

                
                

        

    

    
        Segment Settings
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    Settings related to the deformation of the geometry can be found in the Segment node's properties. This can be toggled on/off on for each segment, making it possible to use multiple segments that react differently to the surface in the same style.            

        
        Align Y with Surface

            
    Active only when used with an L1S Generator. If on, the segment will conform the the surface on the Y Axis. When off, Y deformation remains unaffected            

        

    

    

        

    


    
        
            Display Settings

        


        

        
            
        [bookmark: 10092651_DisplaySettings-top]
            

        
        Overview

            
    The display menu contains options to control the way geometry appears in the viewports and how segments are generated at render time.            

        

    
        Procedures

    
        To display full resolution geometry in the viewports

            
    Occasionally it is useful to display the full mesh in the viewports, this is most common when creating a new style where the final result needs to be easy to see without constant re-rendering, but also for some engines that don't support proxy displays.            

                
    If you are working on a small section of geometry for the purposes of creating or editing a style, adaptive display is often the best option. In this mode the full geometry is displayed unless the face-count exceeds the specified value. When this value is exceeded each segment is replaced by a simple box.            

    	            
    Go to Display>Viewport and turn on Adaptive.            

    
	            
    Adjust the face count, remember that increasing the face count too much may slow down the viewports, depending on your system resources.            

    
	            
    Alternatively if you need full mesh display irrespective on face count, go to Display>Viewport and turn on Mesh.            

    

    

    
        To display geometry as a point cloud

            
                [image: images/download/attachments/10092651/-696419042.png]
                    

                
    Balustrade using Points-cloud mode            

                
    Point Cloud mode is an efficient way of displaying a good representation of the geometry while maintaining excellent viewport performance.            

    	            
    Go to Display>Viewport and turn on Points-Cloud            

    
	            
    Adjust the Local Density percentage value to control the number of points for the selected RailClone object. It is also possible to control the relative density of all the RailClone objects in the scene using the Global Density value.            

    
	            
    Adjust the Shade slider to adjust the strength of the 3D shading effect. This is a global value and will affect all RailClone objects in the scene.            
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    The image on the left shows the scene with no point-cloud shading, the right hand image shows the same scene with this feature turned on.            

    

	            
    Turn on Use Object Colour to tint the points using the colour set from 3DS Max's Object Color dialog. If unselected the points are coloured using the diffuse colour of the object's material.            

    

            
                

        
        
            
    By default, Points-cloud mode uses DirectX to speed up display performance. If you experience problems in the viewports when using Points-Clouds, turn off the Use DirextX Acceleration parameter.            

        

    
            
        
 
    
            

        

    
        To manually update RailClone objects

	            
    Go to Display and turn off the Auto tick box.            

    
	            
    Every time you wish to update the RailClone object, press Build.            

    

    

    
        To enable/disable the Instancing Engine

            
    When enabled, RailClone uses all the capabilities of the renderer to get the best results for complex scenes, automatically creating render instances and proxies according to the needs of the generated geometry. To enable/disable:            

    	            
    Go to Display>Render and toggle on/off Use Instancing Engine.            

    
	            
    Be aware that some functionality is reduced when using these shaders, see the Rendering Best Practice section for more information.            

    

    

    
        To increase or decrease the maximum number of segments created by the Plugin

	            
    Go to Display>Limits            

    
	            
    Adjust the Segments value to increase or decrease the maximum number of segments created by the plugin            

    
	            
    Adjust the Faces value to increase or decrease the maximum triangle count created by the plugin.            

    

    

    
        To debug a RailClone object when using V-Ray
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    Instanced segments are shown in blue color            

    	            
    Go to Display>Debug Mode and turn on Show Up Instances            

    
	            
    The default material ID is set to 100, leave this as it is or if you prefer, set to another number.            

    
	            
    Apply a multi-sub material that includes a material set to the ID specified in the previous step.            

    
	            
    All instanced geometry will be allocated the ID specified above and will render with the associated material.            

    

            
                

        

    

    
        Interface

    
        Viewport

            
    Defines the mode how RailClone draws the object on viewport:            

    	            
    Mesh. Displays full resolution geometry in the viewports            

    
	            
    Boxes. Displays a simple bounding box around each segment            

    
	            
    Adaptive. A combination of the previous two modes. If the face count is below the value specified the full geometry is displayed. If the face count exceeds the value specified, bounding boxes are used.            

    
	            
    Points-Cloud. An ultra-fast view mode which lets you to see a 3D preview of the geometry in the viewport.            

    	            
    Global Density. Adjust the point density for all RailClone objects in the scene.            

    
	            
    Local Density. Adjusts to point density for only the selected RailClone object.            

    
	            
    Shade. This slider controls the strength of the 3D shading effect used on the points, move the shader to the left to reduce contrast and create a flat colour and to the right to increase the contrast.            

    
	            
    Use Color Object. Color by object or from the material applied to the object (specifically from the diffuse color slot).            

    
	            
    Use DirectX Acceleration. Turns on and off ability to use DirectX to speed up point cloud displat. This is on by default, but can be turned off if you encounter viewport errors such as random points.            

    



    

    
        Build

            
    Set the update mode of RailClone to automatic or manual            

    	            
    Auto. Turns on/off auto update mode            

    
	            
    Build. If automatic mode is off, this button rebuilds the RailClone object.            

    
	            
    Disable Object. Turns off the RailClone object so that it neither renders nor appears in the viewport.            

    

    

    
        Render

	            
    Mesh.Render segments as full geometry            

    
	            
    Boxes. Render segments as simple bounding boxes            

    
	            
    Use Instancing Engine.This parameter defines the behaviour of RailClone when it creates the elements for rendering. When enabled automatically creates instances and proxies when using V-Ray or Mental Ray. If disabled creates a single mesh containing all the geometry. See Best Rendering Practices for more information about this mode and how to use it efficiently in your scenes.            

    

    

    
        Limits

            
    Limits the maximum number of segments or mesh's faces created by the plugin. When this limit is reached, the plugin shows a warning message.            

    	            
    Segments. The maximum number of segments that can be created by RailClone. Default value is 50,000.            

    
	            
    Faces. The maximum number of faces that can be created by RailClone. Default value is 5 million            

    

            
                

                
                

        
        
            
    The size of the instances and proxies when "Use Geometry Shader" in on, is not taken into account when calculating the maximum number of faces.            

        

    
            
                

        

    
        Debug

            
    Lets you to identify visually on the render what pieces are created as instances. See Best Rendering Practices for more information about geometric shaders and instancing. Currenly the debug mode works only with VRay.            

    	            
    Show Up Instances. When enabled, the Material ID of the instanced segments is changed to the specified value.            

    
	            
    V-Ray Mat.Id. Used to specify the material ID applied to instanced geometry.            

    

    

    

        

    


    
        
            RailClone Tools

        


        

        
            
        [bookmark: 10092653_RailCloneTools-top]
            

        
        Overview

            
    RailClone Tools, an Utility plugin, is used to access some tasks that cannot be done directly from the Modify panel of RailClone. Using RailClone tools you can create and organise instances from RailClone objects. This is useful if you need to use renderers not natively supported by the plugin or provide a file that can be used without the need for RailClone to be installed.            

        
        
            
    This tool is available only in RailClone Pro.            

        

    
    

    
        Procedures

    
        To install RailClone tools:

            
    RailClone tools can be found by going to Utilities and clicking More... alternatively to add it to your button sets, follow these steps:            

    	            
    Go to Utilities and click on the Configure Button Sets icon (            
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    ).            

    
	            
    From the resulting dialog, choose the set you wish to add the tool to from the drop down list.            

    
	            
    To replace an existing utility with RailClone Tools simply drag it onto an occupied button slot.            

    
	            
    To add a new button, increase the Total Buttons value and drag RailClone Tools to the newly created blank slot.            
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        Creating instances from a RailClone object:

	            
    Select a RailClone Object            

    
	            
    Go to Utilities and open the RailClone Tools            

    
	            
    Choose how to organise the new objects from the following options:
Individual objects. Creates new instances as standalone objects on the default layer.
Create Group. Groups all new instances in a group object. Should be used with caution, 3DS may be very slow handling a huge number of objects in a group, most of times it is better to create them as non-grouped objects on a separate layer (next option).
Move To Layer. Creates a new layer containing the new instances. Activate Freeze to prevent accidental selection or changing of the resultant geometry and Boxes to display each instance as a wireframe box (same as right clicking and selecting Object>Properties>Display As Box.)            

    
	            
    To hide the source RailClone object once instances have been generated, activate Disable at End            

    
	            
    Press Insanciate, your new instances will be created with the above settings, replacing the original RailClone object.            

    

            
                

        
            Octane Render

        
            
    When using Octane Render, instancing objects with Railclone Tools will automatically set their Octane Properties>Movable Proxyparameter to On. No further action is necessary.            

        

    
            
                

        

    
        Updating existing instances

            
    If you wish to update a RailClone object you have already instanced, follow these steps.            

    	            
    Select the original RailClone object. The geometry will be hidden but the icon will still be visible in the viewports.            

    
	            
    Open the RailClone Tools from the Utilities panel.            

    
	            
    Press Objects>Delete to remove the existing instances            

    
	            
    Press RailClone Geometry>Enable to turn back on the original geometry.            

    
	            
    Make changes to the RailClone object and Instanciate as described above.            

    

            
    Alternatively if you do not need to see the changes to your original RailClone object before creating new instances:            

    	            
    Select the RailClone object and make changes. You will not be able to see these in the viewport            

    
	            
    Open the RailClone Tools from the Utilities panel.            

    
	            
    Ensure Auto Delete Old Items is enabled            

    
	            
    Press Instantiate, the old instances will be deleted and replaced.            

    

    

    

    
        Interface

    
        Instanciate

            
    Convert the geomety of the selected RailClone objects to stand-alone objects, automatically creating meshes and instances where needed. Usually this is much more efficient than converting RailClone to an editable mesh.            

        

    
        Objects

	            
    Individual objects. Create instances as stand-alone objects.            

    
	            
    Create group. Group all new instances in a group object.            

    
	            
    Move to layer. Create a new layer and move the new instances to it.            

    	            
    Freeze. New instances interactivity set to "Freeze"            

    
	            
    Boxes. New instances display properties set to "Display as Box"            

    


	            
    Auto delete old items When activated, RailClone Tools searches and deletes old instances before creating new objects.            

    
	            
    Delete. Removes existing instances manually. This only works if the objects have not been renamed (including the original RailClone object).            

    

    

    
        RailClone Geometry

	            
    Disable at end. This option disables the RailClone objects after creating the instances. It turns on the Display-> Disable object checkbox on each RailClone object.            

    
	            
    Enable. Turns off the Display>Disable object parameter of the selected RailClone objects.            

    

    

    

        

    


    
        
            Parameters

        


        

        
            
        [bookmark: 10092649_Parameters-top]
            

        
        Overview

            
    Lists the adjustable parameters as defined by the current style. In order for a parameter to appear here, there must be an equivalent Numeric node present in the style editor. This list is updated automatically when adding, deleting or renaming Parameters in the Style Editor.            

        

    
        Procedures

    
        To change a value

	            
    Select the Parameter's name from the list            

    
	            
    Set a new value, note that parameters can be restricted to a min/max range, configured in the associated Numeric node.            

                [image: images/download/attachments/10092649/1232906000.png]
        

    

    
        To animate a value

            
    Unlike values accessed in the style editor, parameters that have been exposed using the Numeric node can be animated.            

    	            
    Turn on Autokey or Set Key mode            

    
	            
    Move the Time Slider to the appropriate keyframe            

    
	            
    From the Parameter rollout enter a new value.            

    
	            
    If you are in Set Key mode, press the Set Keys button to commit the change.            

    

    

    
        To add a tooltip to a Parameter

            
    If you are sharing RailClone objects with other users it is helpful to provide tooltips to explain how to use the different parameters used in the style. To create your own tooltips, follow these steps            

    	            
    Open the style editor and click a parameter node you wish to provide help for.            

    
	            
    From the Properties editor, enter the tooltip text in the Description field.            

    
	            
    To see this guidance in 3DS Max, select the item from the Parameters lists and click on the help icon            

                [image: images/download/attachments/10092649/1131920160.png]
                    
    to read how to use it.            
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        To modify a parameters from Maxscript

            
    Parameters are stored in the following RailClone properties, editable from Maxscript. These properties are arrays, with one element for each one of the parameters:            

    	            
    paid (string array): Unique identifiers.            

    
	            
    patype (int array): Type, 0 = Integer, 1 = Float, 2 = Percentage, 3 = Worlds Unit.            

    
	            
    paname (string array): Parameter's name.            

    
	            
    padesc (string array): Description for tooltip.            

    
	            
    paintval (int array): value for parameters of type Integer.            

    
	            
    pafloatval (float array): value for Float and Percentage parameters.            

    
	            
    paunitval (worldUnits array): value for parameters of type Units.            

    

            
    To modify a parameter, follow these steps            

    	            
    Locate the index of the parameter by it's name. For example Y Offset is the second element in the arrays:
$.paname
#("Distance", "Y Offset")            

    
	            
    Check it's type:
$.patype
#(3, 3)            

    
	            
    In this case, both parameters are of type Worlds Unit (3). So, to set Y Offset = 10, you must modify the second value in the paunitval array:
$.paunitval[2] = 10            

    

    

    

    
        Interface

            
                [image: images/download/attachments/10092649/-1659422498.png]
        Parameter List. This menu lists all the Numeric nodes used in the current style. The names visible here mirror the names allocated to the equivalent parameter node in the style editor.            

                
    Move up/down selected item: Changes the display order of the currently selected base object.            

                
    Parameter Value: Used to input the value of the selected parameter.            

        

        

    


    
        
            RailClone Lite and Pro
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        RailClone Pro

            
    Fully functional version with all features and an extended library of models. Visit our Online Store for more information about prices and license options.            

        

    
        RailClone Lite

            
    This version is free for personal and commercial use. It has the following limitations.            

    	            
    Limited to three Segments and one 1D arrays - Generator L1S or 2D arrays - Generator A2S.            

    
	            
    Adaptative height features are disabled. Only can be used with flat splines (on Z axis).            

    
	            
    Cannot be collapsed to Editable Mesh.            

    
	            
    RailClone Tools is not available.            

    
	            
    Library includes a limited set of models.            

    
	            
    Library customization is disabled.            

    

            
    You can get RailClone Lite from the download page.            

        

        

    


    
        
            Migrating from 1.x

        


        

        
    
        Introduction

            
    If you have used RailClone before, you will find significant differences between versions 1.x and 2.x. This guide will help you to migrate to the new release.            

        

    
        Creating a new RailClone Object

            
    To create a new RailClone object in version 1.x you would simply select a spline path first then choose or create a style. Version 2.x has the ability to use multiple splines within a single style, because of this we must first create a new empty RailClone object, and then assign splines from the Base Objects rollout. To create a new RailClone object in version 2.x, follow this procedure:            

    	            
    Create a new RailClone object by going to the Create Panel>Geometry>iToo Software and selecting RailClone. Click and drag in the viewport, a "RC" icon will appear to denote a new blank RailClone object.            

    
	            
    Either select an existing style from the Library or create one from scratch using the Style Editor.            

    
	            
    Assign splines from the scene in the Base Objectsrollout.            

    

    

    
        Converting objects

            
    Due to the large number of changes introduced, objects created with RailClone 1.x cannot be edited directly in 2.x.            

                
    By default, to maintain compatibility with previous scenes, objects are built and rendered using the construction rules of RailClone 1.x. In this way, a scene made in version 1.x, should generate exactly the same result when opened in 2.x.            

                
    However, If you want to edit a RailClone 1.x in 2.x it will have to be converted to the new format:            

    	            
    Open the RailClone object as usual or load from the Library            

    
	            
    Go to Styles and select the Open Style Editor button (            
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    ). A dialog will appear warning you that you need convert the style before you can edit.            
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    Just click the Convert button to translate it to the new format.            

    

            
    In most of cases, it won't be necessary to make additional changes. If fixes are required, use the Style Editor to modify the objects parameters. In this section you will find guidaance for the most significant changes introduced in RailClone 2.x.            

        

    
        Segment alignment

            
                [image: images/download/attachments/10092659/863947133.png]
                    

                
    Version 1.x includes a grid of 9 buttons to define the alignment of a Segment. In RC 2.x, this has been replaced with three independent selectors, one for each axis, with the following options: Automatic, Pivot,Left, Center and Right (Y/Z axis use Top and Bottom instead of Left and Right).            

                
    This behaviour is much more flexible. Also the new Automatic option lets RailClone decide the best alignment option, depending of a Segment's position (eg. Left for Start pieces, or Right for End segments).            

                
    Other important change is related to the Local Transform properties: In 1.x the segment is aligned before applying the local transformations. Instead, in RC 2.x, the alignment options are applied after transforming the Segment. This is a more natural behaviour.            

        

    
        Material ID

            
                [image: images/download/attachments/10092659/-114752326.png]
                    

                
    The Randomness->Offset Material ID feature of version 1.x has been moved to the new Operator->Material. These parameters are not converted in the translation process, you must apply the operator manually.            

                
                

        

        

    


    
        
            Rendering Best Practices

        


        

        
    
        Introduction

            
    RailClone includes native shaders the renderers listed below, making it possible to render high-poly objects over splines as long as kilometers:            

    	            
    Mental Ray            

    
	            
    V-Ray            

    
	            
    V-Ray RT            

    
	            
    Thea Render            

    
	            
    Corona Renderer            

    
	            
    Moskito Render            

    

            
    Usually these techniques push a rendering engine to its limits. The following notes include technical information that can help you to optimize your renderings.            

        

    
        Feature Compatibility

            
    Due to technical limitations, feature support varies between renderers. The table below illustrates the compatibility of RailClone's key features with each render engine.            

        
        
            
    Fully compatible features are marked with a ✓ and highlighted in green            

        

    
    
        
            
    Partially supported features are marked with a  ✗* and highlighted in yellow. These can be enabled by turning off the instancing engine.            

        

    
    
        
            
    Unsupported features are marked with a ✗ and highlighted in red            

        

    
            
                

                
                

        
        
                
            	
                
                	
        
Standard    
            
                	
        
V-Ray    
            
                	
        
V-Ray RT    
            
                	
        
Mental Ray    
            
                	
        
Corona    
            
                	
        
Thea    
            
                	
        
Octane    
            
                	
        
Maxwell    
            
                	
        
Moskito    
            
                	
        
Arion    
            
        

    
            	
    Native Instancing            
                	
    ✗            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✗            
                	
    ✗            
                	
    ✓            
                	
    ✗            
        

    
            	
    Create Instances using RailClone Tools            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
        

    
            	
    Automatic UVW Mapping            
                	
    ✗*            
                	
    ✓            
                	
    ✗*            
                	
    ✗*            
                	
    ✗*            
                	
    ✗*            
                	
    ✗*            
                	
    ✗*            
                	
    ✗*            
                	
    ✗*            
        

    
            	
    Debug Mode            
                	
    ✗            
                	
    ✓            
                	
    ✗            
                	
    ✗            
                	
    ✗            
                	
    ✗            
                	
    ✗            
                	
    ✗            
                	
    ✗            
                	
    ✗            
        

    
            	
    Generators            
                	
                
        

    
            	
    L1S            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
        

    
            	
    A2S            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
        

    
            	
    Base Objects            
                	
                
        

    
            	
    Segment            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
        

    
            	
    Spline            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
        

    
            	
    Surface            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
        

    
            	
    Parameters            
                	
                
        

    
            	
    Numeric            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
        

    
            	
    Constant            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
        

    
            	
    Random            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
        

    
            	
    Operators            
                	
                
        

    
            	
    Material            
                	
    ✗*            
                	
    ✓            
                	
    ✗*            
                	
    ✗*            
                	
    ✗*            
                	
    ✗*            
                	
    ✗*            
                	
    ✗*            
                	
    ✗*            
                	
    ✗*            
        

    
            	
    Conditional            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
        

    
            	
    Randomise            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
        

    
            	
    Sequence            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
        

    
            	
    Selector            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
        

    
            	
    Compose            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
        

    
            	
    Reverse            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
        

    
            	
    Transform            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
        

    
            	
    Mirror            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
        

    
            	
    Arithmetic            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
                	
    ✓            
        

    
            	
    UVW XForm            
                	
    ✗*            
                	
    ✓            
                	
    ✗*            
                	
    ✗*            
                	
    ✗*            
                	
    ✗*            
                	
    ✗*            
                	
    ✗*            
                	
    ✗*            
                	
    ✗*            
        

        

            

    

    
        Common Tips

            
    RailClone is able to create complex parametric structures by cloning and adapting mesh objects (called Segments) along one or more reference objects (such as spline). According to the spline's direction, elevation or other parameters, some Segments must be deformed and other simply cloned.            

                
    In the supported engines, it's possible to render thousands of instances of the same object using minimal resources. RailClone uses this feature, identifying which Segments may be cloned, and creating native render instances of them. This process is automatic and invisible to the user, but you can optimize your renderings by paying attention to the following rules:            

    	            
    If you are certain that a type of Segment should never be deformed (such as pillars or joints), turn off 'Bend' in the Segments parameters. The same is applicable for 'Slice'.            

    
	            
    It is possible to use meshes or proxies as Segments, but it is not necessary to convert high-poly objects to proxies to get better performance. The plugin converts all objects to native render instances internally, so there are no significant differences (on render time and memory used) between using meshes or proxies.            

    
	            
    Proxies cannot be deformed, so RailClone always creates instances from them, but obviously they cannot be bent or sliced.            

    

            
    Some features are not available when using the native render mode:            

    	            
    Vertex welding is disabled.            

    
	            
    Operator->Material and Segment->Deform->Mapping work only with V-Ray.            

    
	            
    RailClone objects cannot have any modifier applied.            

    

            
    You can switch to the standard render mode turning by off Display->Render->Use Geometry Shader. When this is used the plugin creates a single mesh containing all the geometry.            

                
    In any case, you can use RailClone Tools to generate the instanced geometry manually. This procedure is compatible with all render engines.            

        

    
        V-Ray Tips

            
    RailClone offers some unique features using this render engine:            

    	            
    Improved performance and reduced memory footprint for very large objects, generating the geometry dynamically inside the camera frustrum.            

    
	            
    We have included a debug mode, to identify visually from the render what segments are instanced. How to use it:            

    	            
    Go to Display>Debug Mode and turn on Show Up Instances            

    
	            
    The default material ID is set to 100, leave this as it is or if you prefer, set to another number.            

    
	            
    Apply a multi-sub material that includes a material set to the ID specified in the previous step.            

    
	            
    All instanced geometry will be allocated the ID specified above and will render with the associated material.            
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    Instanced segments are shown in blue color            

        

        

    


    
        
            Installation and Files

        


        

        
            
    This guide describes the files used by RailClone and how to customize it. We will use a default RailClone Pro installation, in RailClone Lite some files may be different.            

                
    If <railclonedir> is the folder where you installed the software (C:\Program Files (x86)\Itoo Software\RailClone Pro by default) , and <maxdir> is your main Max directory, the setup program creates the folder structure shown below:            

        
        
                
            	
    Folder            
                	
    Path            
        

    
            	
    Maps            
                	
    <railclonedir>\maps            
        

    
            	
    Library            
                	
    <railclonedir>\lib            
        

        

            

            
        [bookmark: 10092663_files]
The plugin and shaders for VRay and Mental Ray are copied here:            

        
        
                
            	
    Folder            
                	
    Path            
        

    
            	
    Max plugin            
                	
    <maxdir>\plugins\RailClonePro.dlo            
        

    
            	
    VRay shaders            
                	
    <maxdir>\RailcloneVRay150sp3.dll, RailcloneVRay20.dll and RailcloneVRay30.dll
Note: some files may not exist depending of the Max and the VRay version            
        

    
            	
    MR shader library            
                	
    Max 2010 and before: <maxdir>\mentalray\shaders_autoload\shaders\RCShader.dll
Max 2011 and 2012: <maxdir>\mentalimages\shaders_autoload\mentalray\shaders\RCShader.dll
Max 2013 and newer: <maxdir>\nvidia\shaders_autoload\mentalray\shaders\RCShader.dll            
        

    
            	
    MR shader descriptor            
                	
    Max 2010 and before: <maxdir>\mentalray\shaders_autoload\include\RCShader.mi
Max 2011 and 2012: <maxdir>\mentalimages\shaders_autoload\mentalray\include\RCShader.mi
Max 2011 and newer: <maxdir>\nvidia\shaders_autoload\mentalray\include\RCShader.mi            
        

        

            

            
    The following entries are created in the Windows Registry:            

        
        
                
            	
    HKEY_LOCAL_MACHINE\SOFTWARE\Itoo Software\RailClone Pro            
        

    
            	
    MainDir = C:\Program Files (x86)\Itoo Software\RailClone Pro            
                	
    <railclonedir> is defined here            
        

    
            	
    UseLicServer = 0            
                	
    0 to use Stand-alone license, 1 for Network license            
        

    
            	
    StyleEditorPath = C:\Program Files (x86)\Itoo Software\RailClone Pro            
                	
    Location of the Style Editor (RCEdit.exe)            
        

    
            	
    LibraryDir (key)            
                	
    One entry for each library path. By default C:\Program Files (x86)\Itoo Software\RailClone Pro\lib\default1            
        

    
            	
    TexturePaths (key)            
                	
    Texture paths            
        

        

            

            
    All commercial Itoo Software products also use additional keys for licensing management:            

        
        
                
            	
    HKEY_LOCAL_MACHINE\SOFTWARE\Itoo Software\Licenses            
        

    
            	
    LicenseDir = C:\ProgramData\Itoo Software\Licenses            
                	
    The licenses are stored here            
        

    
            	
    HKEY_LOCAL_MACHINE\SOFTWARE\Itoo Software\Licenses\Products            
        

    
            	
    RailClone Pro = 21            
                	
    One entry for each Itoo Software product            
        

        

            

            
    Please note: If you use a Windows 64 bit version, these registry keys are duplicated in HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node            

        
        Unattended Installation

            
    The setup program supports unattended installations using the following parameters:            

    	            
    /? - See available parameters            

    
	            
    /S - Enable silent installation            

    
	            
    /MAXVER=[max9-32, max9-64, max2008-32, max2008-64, max2009-32, max2009-64, max2010-32, max2010-64, max2011-32, max2011-64, max2012-32, max2012-64, max2013-32, max2013-64, max2014-64, max2015-64]            

    
	            
    /MAXDIR=<3dmax installation path>            

    
	            
    /LICMODE=[rendernode, network, stand-alone]            

    
	            
    /LICHOST=<License server host>            

    
	            
    /LICPORT=<License server TCP port>            

    

            
    From RailClone 2.4 and above, /MAXDIR and /MAXVER are optional. If not specified, the software is installed for all Max versions available in the computer.            

        
        
                
            	
    Example of silent installation for Max 2013            
        

    
            	
    RailClonePro.exe /S /MAXVER=max2013-64            
        

        

            

    

    
        

    

    
        Network Rendering

            
    You can install RailClone on your render farm computers using the setup program, or by copying the files manually. In RailClone Pro select "Render slave node", in the Lite version use default nstalling options.

For a manual installation, you only need to:            

    	            
    Copy the files listed on the plugin and shaders table to the slave computers. You may get the files from your main workstation where you have installed the software.            

    
	            
    Make the map files visible to the render nodes, copying them to any shared texture folder.            

    

    

    
        Customizing the Library

            
    In RailClone Pro you can customize the Library using the included editor, or editing the XML description files. See here for details.            

                
    Note: The library of RailClone Lite cannot be modified. You can get unexpected results if you try to edit the XML files to customize it.            

        

        

    


    
        
            Customizing the Library

        


        

        
            
        [bookmark: 10092773_CustomizingtheLibrary-top]
            

        
        Overview

            
    RailClone includes an extensive library of presets, but often you will need to modify the built in styles or create your own. Creating a new library is a quick and easy way to reuse and share Railclone objects in your projects. In this section you will learn the procedures to create your own libraries in RailClone. The library browser allows you to easily organise and edit your libraries and create new preset styles. In this section you will find instructions for common procedures and a reference guide to the interface.            

                
    All libraries are stored in disk as XML files and can also be edited with a text editor or XML editor.            

        

    
        Procedures

    
        Adding and Modifying Library Locations

            
    RailClone can access styles from a number of different libraries. These are located automatically from a list of folder paths defined in the preferences. Folders can be stored locally or in a shared network location.            

                
    The RailClone libraries are divided into several types, the standard libraries included with the plugin and third-party packages and user generated Libraries. These are stored by default in "My Documents\RailClone."            

        
        
            
    the libraries included with RailClone cannot be modified. If you want to edit them, make a copy of the files to your own user folder. See below for a reference of the libraries' file structure.            

        

    
    
        To add locations follow these simple steps:

	            
    With the library editor open go to File>Preferences or click the preferences button from the top toolbar.            

    
	            
    The Library Paths rollout shows a list of all the locations currently being used. To add a new location click on the Add button and navigate to the folder for your libraries.            

                [image: images/download/attachments/10092773/1872884044.gif]
        
	            
    In the Label field enter a location name to display in the tree navigator.            

    
	            
    Click Use Path to add the location to the library and return to the preferences.            
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    Click OK and you should now see all the sub folders and libraries displayed in the tree navigator on the left hand side of library browser.            

    

    

    
        Alternatively to modify or update an existing location:

	            
    With the library editor open go to File>Preferences or click the preferences button from the top toolbar.            
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    To modify a location select it from the library paths list and click Modify.            

    
	            
    Navigate to the root folder of the new location and select Use Path.            

    

    

    

    
        Organising and Creating New Libraries.

            
    Each library location path (set from the preferences - see above) can be further organised into sub folders. RailClone will scan these subfolders and replicate the directory in the tree navigator found on the left hand side of the library browser window. From this panel folders and libraries can be created and deleted using the procedures outline below, and the directory structure easily reorganised using drag and drop.
            [image: images/download/attachments/10092773/-477455697.png]
                    

        
        To create a subfolder:

	            
    With the Library Browser open, in the tree navigator on the left hand side, right click on a user library and select Create Folder.            

    
	            
    A new folder has been created. The name will be highlighted, type in a new name for the folder.            

    

    

    
        Alternatively to create the subfolders directly in Windows Explorer:

	            
    Navigate to the library location in Windows Explorer or locate it automatically using the Library Browser by right clicking its name from the tree navigator and selecting Open in Shell            

    
	            
    Create your directory structure in the usual way using Windows Explorer            

    
	            
    When you are done, update the view in the Library Browser to reflect the new directory tree by clicking on the Refresh button (            
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    )from the top toolbar or select from the View menu.            

    

    

    
        To create a new library:

            
    When you create a library RailClone generates a new folder that includes an XML file and sub folders for thumbnails. This and any other sub folders found in the library location will not be displayed. This allows you to add additional directories for models, maps and materials used by the library without them cluttering up the tree navigator.            

    	            
    In the tree navigator, right click on the folder where you would like to save your new library and select Create Library...            

    
	            
    The library name will be highlighted, enter a title and press return            

    
	            
    If you need to rename your library at a later date, simply right click on it and select Rename.            

    

    

    
        To delete a library or folder

	            
    To delete a folder or library, simply right click and select Delete.            

    

    

    

    
        Adding a new Style to a Library

            
    Styles can be added to any library saved in a user location (represented in the tree navigator as a green folder). Style are created from existing RailClone objects, stored in .max files located anywhere on your computer or network. However sharing is simplified if the files and any material libraries and bitmaps use relative paths and are located in the library folder. If images with the same name as the object are placed in the thumbnails folder, these will be used automatically.            

        
        To add a new Style:

	            
    From the navigator on the left, select a user's library.            

    
	            
    Right click in the browser and select Create Item>RailClone Object            

    
	            
    A new blank Style will be created in the item browser. To edit, right click on the item and select Properties            

    
	            
    Fill in the Name, Family and Description values. Note that the Name field is the text displayed by default in the library browser, other values can be left blank if not required            

                [image: images/download/attachments/10092773/726578850.png]
        
	            
    Click on the folder item next to the Max File field to select the .max scene file that contains the new Style.            

    
	            
    A list will open containing the objects in the scene, pick the RailClone object you wish to add to the library.            

    
	            
    If the object had a material applied this will be also be used in RailClone. It is also possible to override the material from an external material library. In order to do this enable the Override Material tick box.            

    
	            
    Select the material library by clicking the folder icon next to the Mat. Library field. Find the library and click Open            

    
	            
    Next click the Select Material button, this brings up a list of the contents of the material library. Highlight the material to be used and click OK.            

    
	            
    Add a thumbnail by clicking the image file button below the thumbnail preview window. Select an image file and click OK.            

    
	            
    Click OK to accept the changes            

    
	            
    Save the library by going to File>Save or selecting the save library button from the top toolbar.            

                [image: images/download/attachments/10092773/79195824.gif]
        

    

    

    
        Adding a Macro to Assign a Material According to Renderer

            
    When creating libraries it is possible to use macros to add variables to an item's property fields. This is very useful for creating flexible libraries that can dynamically respond to individual installations or changeable 3DS Max settings. One common usage is the creation of library items that automatically load appropriate materials based on the active renderer.            

        
        Prerequisites:

	            
    Items are created in the usual way but materials are taken from a separate material library. In this example we assume three libraries, one for each of the three supported renderers: Mental Ray, V-Ray, and scanline.            

    
	            
    Each material library's name should have two sections, one part that will be identical for all three files and a second part that matches the variable names assigned by RailClone''s macro. [libraryName][macroValue].mat            

    
	            
    RailClone uses "mental", "vray", and "standard" as values for the renderer macro. The following three file names demonstrate appropriate file names.

MaterialLibraryName-mental.mat
MaterialLibraryName-vray.mat
MaterialLibraryName-standard.mat            

    
	            
    The actual materials contained in each library should have identical names irrespective of the render. This allows you to dynamically switch between materials by automatically loading a different library for each renderer.            

    

    

    
        Auto-loading a material library by renderer:

	            
    Either create a new object as described above, or right click and select Properties to edit an existing item.            

    
	            
    Turn on Override Material, this allows you to use a separate material library to texture the object. In this example it will automatically select a different material library according to the current renderer.            

    
	            
    In the Max File field type the parts of your material library name that is common to all files. In the examples given above you would type MaterialLibraryName-.mat            

    
	            
    Position the cursor where you want to add the renderer variable, in this case it would after MaterialLibraryName- and before .mat            

    
	            
    Click on Macros and select hdfreerenderer from the subsequent list. Click OK to add the variable to the filename. The material filename should now read MaterialLibraryName-$(HDFREERENDERER).mat.            

                [image: images/download/attachments/10092773/-1548197481.gif]
        
	            
    Select an appropriate material by clicking the select material button and picking one from the list. If the materials are identically named in each library, this macro will change the material depending on the currently selected renderer.            

    

    

    

    

    
        Interface

    
        Library Browser Preferences

            
    To access the Library Browers go to File>Preferences... or click the preferences button from the toolbar             [image: images/download/attachments/10092773/1923329866.gif]
                    

                
                [image: images/download/attachments/10092773/1712267636.gif]
                    

        
        
                
            	
    Name            
                	
    Description            
        

    
            	
    Use scene material            
                	
    When selected in the event of a a duplicate material the version already in the scene will be used            
        

    
            	
    Replace material from library            
                	
    When selected in the event of a a duplicate material the version in the library will be used            
        

    
            	
    Ask user            
                	
    When selected in the event of a a duplicate material the which of the two options above should be used            
        

    
            	
    Add...            
                	
    Adds a new library location.            
        

    
            	
    Modify...            
                	
    Modifies the location of an existing library.            
        

    
            	
    Delete            
                	
    Deletes a library location.            
        

    
            	
    Evaluate            
                	
    Shows the currect values for all macros.            
        

        

            

    

    
        Library Addition

            
    Use the context menu accessible by right clicking in the tree navigator to create new sub folders and libraries, and reorganise your directory using the mouse to drag and drop folders and libraries.            

                
                [image: images/download/attachments/10092773/1856691986.gif]
                    

                
    Commands available in the tree context menu:            

        
        
                
            	
    Name            
                	
    Description            
        

    
            	
    Create Library            
                	
    Creates a folder and a new "index.xml" file.            
        

    
            	
    Create Folder            
                	
    Creates an empty folder on the disk, to organize folders or libraries.            
        

    
            	
    Rename            
                	
    Renames a Folder or Library, this commands changes the name of the folder on the disk.            
        

    
            	
    Delete            
                	
    Deletes a Folder or Library with all its contents. Use with caution!            
        

        

            

    

    
        Item Editing

            
    To access the commands to edit a library's content, right click anywhere in the item grid. Note that changes are only stored in the system memory until the library is saved to disk.            

                
    Commands available in the item context menu :            

                
                [image: images/download/attachments/10092773/1204269798.png]
                    

                
    Commands available in the item context menu:            

        
        
                
            	
    Name            
                	
    Description            
        

    
            	
    Create Item            
                	
    Creates a new empty item in the current library.            
        

    
            	
    Properties            
                	
    Shows the Item Settings dialog box.            
        

    
            	
    Delete            
                	
    Deletes the selected item.            
        

        

            

            
    To commit your changes to disk, click the Save Changes button in the toolbar.            

        

    
        Style Properties

            
    This window is used to set the properties for a library style. The RailClone plugin uses these settings to construct an object based on the properties of a reference object in a .max file.            

                
                [image: images/download/attachments/10092773/1399050840.png]
                    

                
    Settings available for Styles:            

        
        
                
            	
    Name            
                	
    Description            
        

    
            	
    Name            
                	
    Style name.            
        

    
            	
    Family            
                	
    Family or catrgory.            
        

    
            	
    Description            
                	
    Textual description of the style.            
        

    
            	
    Max File            
                	
    3DSMax scene where the reference object is stored.            
        

    
            	
    Object            
                	
    Name of the reference object. Choose one of the scene contents in the reference scene.            
        

    
            	
    Override Material            
                	
    Override the reference object material, and apply a supplied one.            
        

    
            	
    Material Lib.            
                	
    3DSMax material library containing the material.            
        

    
            	
    Material            
                	
    Name of the override material, choose one from the selected library.            
        

    
            	
    Thumbnail            
                	
    Preview image of object.            
        

    
            	
    Thumbnail Selector button            
                	
    Press this button to change the thumbnail image.            
        

        

            

    

    
        File Structure

            
                [image: images/download/attachments/10092773/84937825.png]
        A library is a special folder on the disk which contains an index.xml file, where the items are listed. This file points to the files necesary to define a library item. The browser stops to scan directories when an index.xml file is found, so a library folder can't contain other libraries and all subfolders are hidden in the interface, this permits to you to organize the data in several subfolders.            

                
    Each library item points to a single template object in a .max file or to a material in a .mat file. Each time you select a library item, all settings in the template object are loaded and applied to the current RailClone object. You can group several objects in a single file, or have separate files for each one. You can also use macro substituion (see section below) to use conditions or complex structures.            

                
    Each library item also has an associated image file, typically stored in the thumbnails folder. This image is used to show the image preview in the library and you should have one image for each library item. If you name the files using the same name of the object, the image is automatically selected in the editor.            

                
    Additionally, you can have materials libraries to override the object's default material. This way you can have several library items with the same geometric base, but with different materials and textures.            

        

    
        Macros

            
    In some fields, such as filenames and object or material names, you can use macro sustituions to add more flexibility to your library structures. These macros represent the library root location, current folder, or 3dsmax state values. The macros are instanced using the $(NAME) format.            

                
    To open the Insert Macro window, press the Macros... button in the properties window, select a macro and click OK, the selected macro will be inserted in the current field of the property            

                
                [image: images/download/attachments/10092773/1953052142.png]
                    

        

    

        

    


    
        
            Licensing Guide

        


        

        
    
        Overview

            
    Software License Management is available in two models, Stand-alone and Floating/Network licenses. Under a stand-alone license, any given product is constrained to a certain host. A license is needed for each computer that the software will be installed on. In floating license mode, a pool of licenses is available on the server, for use in any computer on the network. You only need to have licenses for the maximum number of simultaneous users expected, not for each computer where the software will be installed.            

                
    Depending on the size of your business and expected use of the software, one of the two models is usually preferred. In small sites with few computers, the Stand-alone licenses is fast and easy to deploy, the licensing process is part of the software installation, leaving the software ready to use in one step. For larger sites, the floating network licensing is preferred because it provides more flexible use of licenses, you only pay for simultaneous users and not for nodes, while the centralized management tool simplifies control of all your licenses.            

        
        Stand-alone License

            
    The Stand-alone license ties a single software application to a single computer. This method of licensing requires a machine's unique identifier (SID) to be incorporated in the license activation process. After buying the product, an generic license code is sent to you, the license is installed and activated. In the activation process the license is linked to the computer and can be used only for that computer.            

        

    
        Floating Network Licenses

            
    Network licenses (also known as floating licenses) allow multiple users to share a limited pool of licenses in a local network. After installing the License Server on a server machine, the server will handle requests for licenses from the users computers. If you have a team of 20 people and 10 licenses for a product, the entire team will share access to the 10 licenses, while no more than 10 people can use the software at the same time.            

                
    While Stand-alone licenses use a license file installed and activated for each computer, and can be used only in that machine, the network licenses are installed and activated only one time in a server. When a license request arrives, the server determines whether the proper license for a requested product is available. If an appropriate license is present and not in use, the server will allow access to the software.            

                
    As the licenses are stored on a server, you cannot use the software if you are not connected to the network. Although the server software does not require a powerful system, it is mandatory that the computer hosting the license server be running and available while there are computers using the licensed software.            

        

    

    
        License Activation

            
    When you acquire a license from Itoo Software, a generic license code is sent to you. Before using the software, this license must be linked to your hardware, this process is called activation. You can activate the license during the software installation (only for Stand-alone mode), or from the License Manager once the software is installed.            

                
    During the activation of a license, you can choose two different methods, Automatic or Manual. With Automatic activation you must be connected to the Internet, the software will connect with our activation server through a secure connection, and the activation codes will be sent and installed automatically. No personal information is sent during the process.            

                
    If you experience difficulties with on-line activation, or the computer where you are using the license does not have Internet access, you can use Manual activation instead. In this case, the software gives to you the necessary codes and a link to our secure activation page. In this web page, you enter the codes and the activation key is generated. Write or print out this code, and provide it when the Activation Wizard runs, then the license will be activated and ready to use.            

                
    For security reasons, our activation server allows you to activate a license only a certain number of times (5 by default). If you exhaust the maximum number of activations, please send us an email at activate@itoosoft.com, we will increment the activation counter associated with your license. In the authorization process, the server informs you of the number of activations remaining.            

                
    In either case, if you have trouble during the activation, please contact us at activate@itoosoft.com.            

        

    
        Network rendering licenses

            
    Our commercial plugins require a license for each computer, to open or edit the scenes, but NOT for network rendering nodes. The installation for slave nodes is much simpler, and does not requiring licenses or activations.            

        

        

    


    
        
            Stand-alone

        


        

        
            
    The Stand-alone licenses tie a given software application to a single machine. This method of licensing requires a machine's unique identifier (SID) to be incorporated in the license activation process. After buying the product, a generic license is sent to you. This license must be installed and activated before you can use the software. In the activation process the license is linked to the hardware.            

        
        License Installation

            
    As soon as your order is authorized, we will send to you an e-mail with the license code and links to download the software. On this page, we explain how to install and activate a Stand-alone license.            

                
    To install a Stand-alone license, you must:            

    	            
    Obtain the License Code from the registration e-mail.            

    
	            
    Install the license during the software installation, or later using the License Manager tool.            

    
	            
    Activate your license.            

    

            
    Installation of the Stand-alone license            

                
    In the e-mail sent after purchasing the product you will find the license code, in the form of a block of letters and numbers. When you are asked for this code, copy and paste it in the window. Please make sure that you do not include any other text besides the code itself:            

                
                [image: images/download/attachments/10092667/-1688652457.gif]
                    

                
    If the entered code is valid, press Ok. The license is installed on your computer and you can continue with the installation process. You can also review and activate the license later, using the License Manager tool.            

        

    
        License Activation

            
    When a new license is installed, you're asked to activate it. In this process the license is linked to your hardware. You can choose two different methods:            

                
    Online activation            

                
    If you have an Internet connection, you can activate your software online. The License Manager will connect with our activation server through a secure connection, and the activation codes are sent and installed in one step.            

                
                [image: images/download/attachments/10092667/-1995534515.gif]
                    

    	            
    Select "Activate Online" as the activation method.            

    
	            
    Check that the license data is correct and press "Proceed" to start the activation process.            

    
	            
    The software connects to our Activation Server through a secure connection (no personal information is sent during the process). After few seconds your license will be activated, and your software will be ready to use.            

    

            
    Manual activation            

                
    If you have trouble with the on-line activation, or the computer where your are using the license does not have Internet access, you can use Manual activation.            

    	            
    Select "Activate Manually" as the activation method.            

    
	            
    Open a link to our Activation Web page and enter the codes given by the dialog.            

    
	            
    Following the steps indicated in the page, you'll be given an Activation Code, enter this code in the dialog box when requested to activate your license.            

    

            
    In either case, if you have trouble during the activation, you may contact us at activate@itoosoft.com.            

        

    
        License Manager

            
    When you install any Itoo Software commercial product, the installer also includes the Itoo Software License Manager. This tool is used to manage the licenses of your purchased software.            

                
    To open the License Manager, select "License Manager" in the "Itoo Software" group of the Start menu. The are four tabs in this tool, two of them are only visible if your computer acts as a license server (not applied for Stand-alone method, see Floating/Network licenses):            

                
    When opened, the License Manager displays the installed licenses. You can retrieve license details, check its status, add new licenses or activate them as show below:            

                
                [image: images/cdn.itoosoft.com/img/licenses/-770314189.jpg]
            
License Panel
                

                
    Licenses can be in different states, depending of the type of license and its activation status:            

    	            
                [image: images/download/attachments/10092667/106079.gif]
     Activated Stand-alone licenses: Shown in black text, these licenses are ready to be used.            

    
	            
                [image: images/download/attachments/10092667/92899676.gif]
     Un activated licenses: Red text with a warning icon, these licenses are valid but have not yet been activated. You must activate them before using.            

    
	            
                [image: images/download/attachments/10092667/-1380616235.gif]
     Broken licenses: Red text with an error icon . These licenses have corrupted data and can't be used in any form. You must reinstall them.            

    

            
    For more information about a license, you can click on the "Details..." button, where you can see the data stored in the license.            

                
    Installation of new licenses            

                
    If you have not installed a license with the software installation process, use the "Add.." button in the licenses tab. The installation process is the same as the one described above for the installer.            

                
    Activation of the selected License    
     
            

                
    When a new license is installed, you're asked to activate it. In this process the license is linked to your hardware. The activation process is the same as the one described above for the installer.            

        

        

    


    
        
            Floating/Network

        


        

        
    
        Introduction

            
    Network licenses (also known as floating licenses) allow multiple users to share a limited pool of licenses in a local network. After installing the License Server on the computer being used as a server, the server will handle requests for licenses from users computers. If you have a team of 20 people and 10 licenses for a product, the entire team will share access to the 10 licenses, while no more than 10 people can use the software at the same time.            

                
    While Stand-alone licenses use a license file installed and activated for each computer, and can be used only in that machine, network licenses are installed and activated only one time on your server. When a license request arrives, the server determines whether the proper license for a requested product is available. If an appropriate license is present and not in use, the server will allow access to the software.            

                
    As the licenses are stored on a server, you cannot use the software if you are not connected to the network. Although the server software does not require a powerful system, it is mandatory that the computer hosting the license server be running and available while there are computers using the licensed software.            

                
    In order to deploy Network Licenses you must:            

    	            
    Install the License Server on the server computer.            

    
	            
    Install and activate one or more Network Licenses on the server using the License Manager.            

    
	            
    Configure each client to retrieve the licenses from the license server.            

    

    

    
        License Server Installation

            
    To be able to use network licenses, a computer in the network must be designated as the license server. Once you have selected it:            

    	            
    First make sure that your have administrative rights on the target computer.            

    
	            
    Download the License Server software from the links you received after purchasing the software (in the registration email).            

    
	            
    Run the setup program and follow the steps.            

    

            
    The License Server will be installed as a system service named "Itoo Software License Server". A shortcut to the License Manager is also created on the start menu.            

        

    
        License Manager

            
    You must use this tool to manage the licenses of all products purchased. It's the same one used to manage the Stand-alone licenses.            

                
    To use it, select the License Manager in the Itoo Software/ License Server group of the Start menu. There are four tabs in this tool, two of them are only available if you have a license server installed:            

    	            
    Licenses: On this page the licenses are listed and managed            

    
	            
    Computers (only with License Server installed): Here you can see which computers are connected and manage them.            

    
	            
    License Server: (only with License Server installed) On this page, the system administrator controls the License Server. You can check the status of the service, start and stop it.            

    
	            
    About: Here you can find information version and contact information.            

    

    
        Licenses

            
    When opened, the License Manager displays the installed licenses. You can retrieve license details, check its status, activate it, or add new licenses as shown below:            

                
                [image: images/download/attachments/10092669/-1724314078.jpg]
                    

                
                

                
    Licenses can appear in different states, depending on the type of license and its activation status:            

    	            
                [image: images/download/attachments/10092669/106079.gif]
     Activated Stand-alone licenses: Shown in black text, these licenses are not used by the License Server (see Stand-alone license).            

    
	            
                [image: images/download/attachments/10092669/108957.gif]
     Activated Network Licenses: Shown in blue text, these licenses are activated are ready to be shared on the network.            

    
	            
                [image: images/download/attachments/10092669/92899676.gif]
     Un-activated licenses: Red text with an warning icon, theses licenses are valid but have not yet been activated. You must activate them before using.            

    
	            
                [image: images/download/attachments/10092669/-1380616235.gif]
     Broken licenses: Red text with an error icon . These licenses have corrupted data and can't be used in any form. They must be reinstalled.            

    

            
    To obtain more information about a license, use the Details... button, here you can see the data stored on it.            

        
        Installation of new network licenses

            
    Unlike Stand-alone licenses, that are authorized for use only on a single workstation (the computer on which its installed), a network license allows for concurrent usage for a specific number of workstations. This number is shown in the license's details as "Licensed for x users". For instance, if you purchase 5 network licenses, you won't receive 5 separate license codes, you will only receive one code that once installed creates a license for 5 users in the License Manager. Later, if you purchase licenses for 3 additional workstations, you will receive a new license code for 3 users, that must be added in the License Manager.            

                
    When you acquire licenses from Itoo Software, in the e-mail you get the license code, as a block of letters and numbers. To install it, use the "Add.." button on the Licenses tab. Copy and paste the code in the window. Please be sure that you do not include any text other than the code itself:            

                
                [image: images/download/attachments/10092669/-1688652457.gif]
                    

                
    If the entered code is valid, press Ok. The license is installed on your computer and ready to be activated.            

                
    License activation            

                
    The activation process is identical for Network as for Stand-alone licenses. The difference is that the network licenses are activated and linked to the hardware of the License Server.            

                
    After an new license is installed, you'll be asked to start the activation wizard. You can activate manually using the "Activate" button as well. Please, see the activation process in Stand-alone licenses for instructions on how to do this.            

        

    

    
        Computers

            
    In the "Computers" panel, you can see all clients that are connected to the server, what licenses are being used and how long each computer has been connected.            

                
                [image: images/download/attachments/10092669/-844237577.jpg]
                    

                
    Each time that a workstation uses a network license, it connects to the License Server and starts a lease of the license for a limited time period. Before that period expires (by default ten minutes), the license must be refreshed or the lease will be lost and the license can be requested by another user.            

                
    Using the "Disconnect" button you can force the server to disconnect a computer before the lease time expires. The typical use of this control is when a workstation has locked up, and it's license is locked to that computer. In this case, you can unlock the license by manually forcing a disconnection. If a workstation doesn't reply after the lease time period, it is disconnected automatically by the server.            

        

    
        License Server

            
    On the "License Server" page, you can check the status of the service, start and stop it. A detailed log of the server activity is also available, to diagnose any problems.            

                
                [image: images/download/attachments/10092669/1184079716.jpg]
                    

                
    The top panel shows information about the windows service, whether it's installed correctly and if the service is started. Using the "Start/Stop Server" button you can stop the service and restart it at any time, please note that if you stop the service, all connected clients will lose their leased licenses and will try to reconnect.            

                
    The bottom panels gives you more detailed information about the service, such as the server version, TCP ports used and the total number of connected users. This data is updated each time you enter this tab, or by clicking the "Refresh" button.            

        

    

    
        Configure Clients

            
    A network license can be used from any computer that can connect to the License Server over the network. The license server or network licenses should not be installed on the client computer. To configure your software for using network licenses, please follow the procedure below:            

                
    From the Start menu, search for the application group and select "Change License Mode". You will get the license configuration window:            

                
                [image: images/download/attachments/10092669/-1301198913.gif]
                    

                
                

                
    In this window, you select with type of license the software will use. The first option uses a locally installed Stand-alone license. Selecting the second option, the software will use network licenses. You will be asked how to connect to the license server in this dialog box:            

                
                [image: images/download/attachments/10092669/-1301198912.gif]
                    

                
    The first method is the recommended procedure, the client will search for an active server over the local network using a broadcast query. The server will be located each time that a license is needed by the software. If the server is accessed through a router, and the automatic method doesn't work, you must use the manual configuration and enter the IP address used to retrieve the license.            

                
    Please note: If you have installed multiple commercial Itoo Software products, each one has its own license configuration. You can use one product with a Stand-alone license, and another with a corporate network license. Please make sure that each product is configured to use its license correctly.            

        

    
        Accessing the License Server through a Firewall

            
    The License Server installer checks for the Windows Firewall and adds the necessary rules if it is present. If you use another firewall software, or a physical firewall between the server and the client computers, the following ports must be opened:            

    	            
    TCP Port 16720            

    
	            
    UDP Port 16720            
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le Description

Thi sty uses Material IDs o assign different types of kerb.

Use ID 1 to assign a normal kerb.
Use ID 2 to assign  drop kerb.

1 addition this style may 1or more of the folowing Parameters:

Use Pavement Depth to controlthe width o the pavement.
Use Tree Basin Type to choose from 10f 3 different types of tree basin and use.
Distance Between Trees to control the spacing between the.

Use Z Offset to adiust the positon of the pavement inrelaton to the base spine.
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Avithmetic operators using Expressions may not work correctly when
used to modify Segment parameters.

Instead,insert a Transform operator between Arthmetic and Segment nodes.
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